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1  About gPCRsoft Software

Described software
version

Supported devices

New file formats

The gPCRsoft software can be used to create and perform PCR and Real-Time PCR
experiments. This section describes the basic setup and the layout of the operating
elements of the software.

The short instructions also offer a quick entrance on the operation of gPCRsoft in the
section "Appendix A - Short instruction" p. 148.

This description is based on the version qPCRsoft V. 4.1.

The program supports the device control and data analysis of the following devices:
®  TOptical / TOptical G

= gqTOWER 2.0 / qTOWER 2.2

= qTOWER3/ qTOWER? G

Functions that are only available for certain devices or that are not available are marked
in the text.

Starting with qPCRsoft 4.0, new file formats for projects, templates and multi-gene
analyses with the extensions "*.rtpx", "*.rtsx" or "™.mgax" are used. The software is
backwards compatible, i. e. the files of type "™.rtp", "*.rts" and "*.mga" can be opened and
edited. However, the new data formats cannot read by older versions of gPCRsoft. When
saving, you can select in which format the files are tob e saved. To ensure the further
use of the data, we recommend that you also save files from previous software versions

in the new format.

1.1 How to use this manual

The following symbols and conventions are used to facilitate orientation in the manual:
- Cross reference to other sections and/or figures.

Formatting In the description of the operating procedures, menu commands, dialog
boxes, buttons, options, etc. are highlighted in small capitals.

Menu commands of a command sequence are separated by "', e.g. File
» Open project.

Buttons are additionally written in square brackets, e.g. [Save].

1.2  Installation of gPCRsoft

System requirements for

installing gPCRsoft

Administrator rights on the operating system are required for installing the program.

For using qPCRsoft to control the Real-Time PCR device, your PC must fulfill the
following minimum requirements:

Operating system Windows 10



Installation procedure

Set up administrator

About gPCRsoft Software

Processor Min. Intel Core i3
RAM 2GB

Available hard disk space Min. 300 MB
Interfaces Min. USB 2.0

gPCRsoft is delivered on CD-Rom.

1. Insertthe CD in the CD-Rom drive. Normally, the installation's start window opens
automatically.
If this is not the case, start the "setup.exe” file on the CD.
A selection dialog window for installing the device driver or the user management or
for viewing the PDF files of the manuals appears.

2. Activate your language version.
3. Select the device type.

4. Click on [Install].
The installation routine begins.

5. Follow the further instructions of the installation program.
6. Switch on the device at the power switch. Start gPCRsoft.

Note:

The software will only be installed correctly if it has been started once with
administrator rights. A password for the program administrator must be entered during
this first start.

After the software installation, an administrator password must be assigned and an
administrator must be specified.

1. Start gPCRsoft.
2. Enter and confirm the password for the adminstrator in the window Login.

3. Set up the user profiles (— section "User management" p. 136).
If the user mangement is not necessary, disable the user management via Extras »
Options / Usermanagement.

1.3  Starting and exiting gPCRsoft

Starting gPCRsoft

1. To start qPCRsoft, click on the [Start] button on the Windows desktop. Then go to
the Programs folder and search for gPCRsoft. Click on gPCRsoft there.

2. Alternatively, you may click on the gPCRsoft icon on the Windows desktop.
gPCRsoft is started.

If the user management has been installed, you will be prompted to enter username and
password. The gPCRsoft workspace will only become accessible if the entry of this data
was successful.

Note:
An administrator and password must be defined during the first program start. Only the
administrator can set up further user accounts or disable the user management.
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Exiting qPCRsoft

Note:

At the first start of the software the color modules installed in the device must be
defined in the software (— section "Editing color modules" p. 133). Instructions can be
found in chapter 8.4. of this manual. A table of all cur-rently available color modules can
be found on the website of Analytik Jena AG https://www.analytik-jena.com and this
manual (— section "Appendix E - Available Color Modules and Dyes to be detected" p.
168).

1. To exit the gPCRsoft application, activate the File » Exit menu command.

2. The program will display a message if any projects that have not yet been saved are
still open at this point.

3. If you want to save these projects, click on [Yes]. Save the projects in the Save as
standard window

4. Then call up the File » Exit menu command again to exit qPCRsoft.

1.4  The main window in qPCRsoft

i gPCRs0ft 2.0 =10l ]

1) Edt Wiew Extras ‘Windaw Help
M- HE-H 2| )
|

& General =

I8 Thermal Cycler

Scan

E3 Samples

Ef Absolute quantification
%= Relative quantification
5 ddCt guantification

& Melting curve

& Genotyping

41 i o

Keine ¥erbindung mit "TCOptical' |Administratur 4

Main window of the qPCRsoft software

After starting the qPCRsoft software the main window opens. It has the following
sections:

Menu bar The menu bar contains the menu commands for, e.g., opening, editing and
(1) saving projects, managing user profiles, setting basic software options and a
help function.

O
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Toolbar (2) Commands for editing projects are arranged in the toolbar. The commands
offered in the toolbar may change according to context.

Project In the project explorer a drop-down menu provides a quick overview of the
explorer (3) most important information on the current open project.

Project The project interface is used to process projects. As soon as a new project is
interface (4)  created or an existing project is loaded, a window opens in which all relevant
settings for the respective project can be made.

1.4.1 Menu commands overview

The menu bar is context-sensitive and is automatically adapted to the program tasks.
Menu items that are not necessary for the current work interface are automatically
hidden. The following menu commands are available in the gPCRsoft software:

Menu Function Description

File New Opens a new project.
Open template Opens a template.
Open project Opens a project.

Open autom. saved  Opens an automatically saved project.

project

Save template Saves a template file in the gPCRsoft standard folder.

Save template as Saves a template file in any user-selected folder.

Save project Saves a project file in the gPCRsoft standard folder.

Save project as Saves a project file in any user-selected folder.

Import analyses Opens an analysis file.

Export analyses Saves an analysis file.

Import LIMS Imports a transfer file, with which the software of
another program can be configured, e. g. LIMS.

MultiGene Starts the Multi Gene analysis for analyzing
experiments that comprise multiple PCR plates and
multiple genes.

Close Closes a template or a project.

Close all Closes all open projects or templates.

Print Prints a project.

Exit Closes the software.

Edit Undo Reverses the last text modification (up to 10 steps).
Redo Restores the last deleted text item (up to 10 steps).
Cut Cuts a marked text area.

Copy Copies an active and/or marked text area.
Paste Pastes atext area copied to the clipboard.
Delete Deletes an active and/or marked text area.
Mark all Marks a complete text area.

10
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User management

Opens the window for creating user profiles and
changing the password. (Only available if the user
management function is activated)

View Project explorer Switches the project explorer view in the main
window on or off.
Toolbar Switches the toolbar view in the main window on or
off.
Scan Set color Opens the window for creating files for spectral color
compensation compensation.
Extras Device initialization ~ Resets the connected device to the initial state.
Device identifcation  Activates the connected device
Edit color modules Opens the window for configuring the system with
color filter modules.
Transport lock Prepares the device for transport (not for gTOWER).
Options Opens the window for general basic software
settings.
Window Tile horz Arranges project windows horizontally.
Tile vert Arranges project windows vertically.
Cascade Arranges project windows in a cascaded fashion.
Help Content Opens the table of contents of the help function.
Info Displays software information.
Cycler Add empty step Adds a new step.
Delete step Deletes a step.
Cut step Cuts a step and copies it to the clipboard.
Copy step Copies the parameters in one step into the clipboard.
Paste step Inserts a copied step.
Scan Edit color Opens the window for creating files for spectral color
compensation compensation.
Samples Edit layout Edit sample table.
Copy layout Copy the area of the sample table.
Paste layout Insert the copied area of the sample table.
Preview layout Detailed view of the plate assignment
Monitoring Start qPCR run Start the PCR run.
Stop qPCR run Stop the PCR run.
Pause qPCR run Pause the PCR run.

Display options

Display options for the product accumulation curves

QBase Export

Exports measured values as a CSV or an XLS file in
gBase format (available after Ct calculations)

11
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AbsQuant Add abs. Create new evaluation.
quantification
Delte abs. Delete evaluation.
quantification
Optionsabs. Opens a window for basic evaluation settings.
quantificationg
Automa. Threshold  Automatic determination of the fluorescence
threshold for detecting Ct values.
Import Standard Import a saved standard curve.
curve
Qbase export Exports measured values as a CSV or an XLS file in
qBase format.
RelQuant Add rel. Create new evaluation.
quantification
Delte rel. Delete evaluation.
quantification
Optionsrel. Opens a window for basic evaluation settings.
quantificationg
Automa. Automatic determination of the fluorescence
Threshold/Cut off threshold for detecting Ct values.
Import Standard Import a saved standard curve.
curve
DeltaDeltaCt  Add AACt Create new evaluation.
quantification
Delte AACt. Delete evaluation.
quantification
OptionsAACt. Opens a window for basic evaluation settings.
quantificationg
Automa. Threshold  Automatic determination of the fluorescence
threshold for detecting Ct values.
Melting Add melting curve Create new evaluation.
Curve
Delte melting curve  Delete evaluation.
Optionsmelting Opens a window for basic evaluation settings.
curve
Automa. Threshold Determine threshold automatically.
Genotyping Add Genotyping Create new evaluation.
Delete Genotyping Delete evaluation.
Options Genotyping  Opens a window for basic evaluation settings.
Autom. Automatic determination of the fluorescence
Threshold\Cut off threshold for detecting Ct values.
Endpoint Add Endpoint Create new evaluation.

Delete Endpoint

Delete evaluation.
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Options Endpoint Opens a window for basic evaluation settings.

Auto Threshold\Cut  Automatic determination of the cut-off fluorescence
off value for decision POS/NEG

MIQE Import MIQE Imports MIQE information from other project.
Documentation

1.4.2 Overview of the tools in the toolbar

The buttons in the toolbar are mostly context-sensitive. The program automatically
adjusts the toolbar to the window content and adds buttons provided that this is
required and useful for the current project window view. Buttons not accessible for the
current contents of the workspace are hidden.

You can display or hide the toolbar via the View » Toolbar menu command.

Button Command Function

General

D New Opens a new project.

@ - Opentemplate Opens a template.

H Save template Saves a template.

@ - Open project Opens a project.

H Save project Saves a project.

@ Print project Prints a project.

n Undo Reverses the last modification.

(’ Redo Restores the last deleted modification.

% Cut Cuts a marked area.

Copy Copies an active and/or marked area.

E Paste Pastes an area copied into the clipboard.

x Delete Deletes an active and/or marked area.

M MultiGene Startet die MultiGene- und Multi-Platten-Analyse.
[ Englisch Schaltet zur englischen Sprachversion der Software um.
PCR protocol

Eii Add empty step Adds a new step.

E—E Delete step Deletes a step.

Activate melting curve  Adds a step for melting curve determination.

[«

13
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compensation

% Cut step Cuts a step and copies it to the clipboard.

% Copy step Copies the parameters in one step into the clipboard.
@ Paste step Pastes a copied step.

Color

@ Edit color Opens the window for creating files for spectral color

compensation.

Edit layout

Assigns changes that were made to the sample table.

Copy layout

Copies an area in the sample table.

=
'"__EE Paste layout

Pastes a copied area from the sample table.

Preview layout

Displays a complete view of the plate assignment.

Import MIQE Imports MIQE information from other project.
Documentation
Monitoring
Start PCR protocol Starts the PCR run.
Stop PCR protocol Ends the PCR run.

Pause PCR protocol

Breaks the PCR run.

Options

Display options of the product accumulation curves.

gqBase Export

vE =

Exports measured values as a CSV or an XLS file in
gBase format.

Evaluation/absolute quantification

New Creates a new evaluation
Delete Deletes an evaluation
Options Opens a window for basic evaluation settings.

Automatic threshold

Automatic determination of the fluorescence threshold
value for Ct value determination.

Import standard curve

Imports a saved standard curve.

qBase Export

R RERR

Exports measured values as a CSV or an XLS file in
qBase format.

Evaluation/relative quantification

% New

Creates a new evaluation.

% Delete

Deletes an evaluation.




About gPCRsoft Software

1.4.3

o

Options

Opens a window for basic evaluation settings.

%=

Automatic threshold

Automatic determination of the fluorescence threshold

value for Ct value determination.

B

Import standard curve

Imports a saved standard curve.

Evaluation/AACt analysis

ddCt

New Creates a new evaluation.
Delete Deletes an evaluation.
Options Opens a window for basic evaluation settings.

o
ddCt

Automatic threshold

Automatic determination of the fluorescence threshold

value for Ct value determination

Evaluation/melting curve

Automatic threshold

Iﬁ New Creates a new evaluation.
E Delete Deletes the current evaluation.
&%’ Options Opens a window for basic settings for the evaluation.

Automatically determines the threshold.

Evaluation/Genotyping

jﬁ New Creates a new evaluation.

.:FE Delete Deletes the current evaluation.

{E@ Options Opens a window for basic settings for the evaluation.
':Pﬂ Auto threshold/cut off ~ Automatically determines the threshold.

Evaluation/Endpoint

f__"’_T_f] New Creates a new evaluation.

BA Delete Deletes the current evaluation.

{EQ Options Opens a window for basic settings for the evaluation.
Auto threshold/Cut off ~ Automatic determination of the cut-off fluorescence

value for decision POS/NEG

Project explorer components

Different menus (2) in the project explorer offer a quick overview of the currently
processed project. Individual projects can be selected via a selection list (1). The

information on the individual menus can be displayed or hidden via the [+] and [-] (3)

buttons.

15
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Organization of the project explorer

Menu

Information

General

Project title, user, date, timeand device

Thermocycler

Graphic display of the history of the PCR program in the active project

Scan

Overview of the colors and areas of the PCR plate that are being scanned

Samples

Displays a short info text on the plate layout.

Used for activation or deactivation of samples during measurement and
evaluation (— sections "Display options for monitoring" p. 57 and
"Activating/deactivating samples for evaluation" p. 67).

The edit mode for the plate layout displays detailed information on the
selected well.

Absolute
quantification

Graphic display Ct against log concentration

Relative
quantification

Graphic display Ct against log concentration

AACt Graphical display dCt(V) compared to log concentration

Melting Curve Graphical display of melting curve compared to temperature

GenoTyping Graphical display of dRn Genotype 1 compared to dRn Genotype 2 as a
scatter plot or bar graph

Endpoint Graphical display of endpoint fluorescences as a bar chart for the GOl and

the IPC

You can display or hide the project explorer via the View » Project explorer menu

command.
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1.4.4 Project interface with project window

The project interface is initially empty when starting the program. Only when a new
project is created or a saved project and/or a template is loaded the project window

opens.

Real time pcr template - Salmonella.rtsx EI@
i Settings |\ Monitoring 4 Analysis [E Documentation 4 b
[7] General " [[| Thermal Cycler & Scan [ samples 4 b

Title:

|Salm0nella |

Operator:

|User |

Start: End:

Comment:

optional notes about the experiment]

View of a project window

In the project window all parameters, measuring data and evaluations for one PCR plate
are combined. The basic functions are arranged on the four main tabs on the top:

Tab Function

Settings Contains all functions required for defining Real-Time PCR runs.
Monitoring Contains different tools for monitoring Real-Time PCR runs.
Evaluation Includes the evaluation algorithms implemented in the software for

analyzing acquired data.

Documentation  Opens the input mask for MIQE compliant documentation of Real-Time
PCR experiments.

These four tabs are always visible. The view of the project window changes depending
on the selection of a function tab. To indicate the tab the descriptions refer to, the tabs
and list sheets are listed in the order in which they were activated and divided by a slash,
e.g. Settings / Thermocycler / Table.

1.4.5 Help function

You can get help on the operation of gPCRsoft via the menu command Help » Content.

While working with project windows, you can activate context-sensitive help by pressing
function key [F1].

The program pops up brief information (tool tips) on buttons of toolbar while you move
the mouse pointer across the button.

17
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1.4.6 Version number of the software

By means of the Help » Info menu command, you open the window with information on
the version number of the software program.

18
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2  Managing projects and templates

The gPCRsoft software saves all experiments in the project files. A project contains
different information required to perform a Real-Time PCR experiment:

m  Description of the experiment

= PCR protocol

®  Scan settings of the optical system

= Plate assignment with detailed information on each sample

®  Measuring results and the corresponding evaluation after the experiment has been
performed

All basic information required for performing an experiment that is stored in the project
window on the Settings tab, such as the description of the experiment, the PCR
protocol, scan settings of the optical system and the plate assignment, can be saved as a
template.

Following file extensions are used in the software:

Extension  File type Description

*.rtp real time project file Project file with settings of the PCR run, analysis and

measurement results

* rtpx real time project file File format for projects from qPCRsoft V 4.0
*.rts real time settings file Templates with settings of the PCR run and the
analysis
* rtsx real time settings file File format for templates from qPCRsoft V 4.0
*.mga real time multigen Multigene/Multiplate analysis
analysis file
*.mgax real time multigen File format for Multigene/Multiplate analysis from
analysis file qPCRsoft V 4.0
* rta real time analysis file Export/import file format for analysis parameters of a
project

The new data formats cannot read by older versions of the gPCRsoft. When saving, you
can select in which format the files are tob e saved. To ensure the further use of the
data, we recommend that you also save files from previous software versions in the new
format.

2.1 Creating a new project or opening a project

A project is always indicated in a project window in a section of the project interface of
the main window.

Creating a new project
To create a new project, click on _loraall up the File » New menu command.

A new project with standard presets is created in the project window.

19



Creating a new project
based on a template

Opening a saved project

Opening an automatically
saved project

Viewing the projects

20

Managing projects and templates

A new project can be opened with saved presets (template):

1. Clickon T or call up the File » Open template menu command.

2. Inthe standard window, select the desired template to open files and confirm the
selection with [OK].

A new project with the parameter settings of the template is created in the project
window.

1. Clickon P - or call up the File » Open project menu command.

2. Inthe standard window, select the desired project to open files and confirm the
selection with [OK].

The project with the parameter settings, measurement results and evaluations is created
in the project window.

The gPCRsoft programs enables you to automatically save the last completed Real-Time
PCR run to a folder of your choice and thus prevents data loss due to unexpected
terminations of a PCR run.

1. Recovere the terminated measurement with the File » Open autom. saved project
menu command.

2. Save the file under a different name as a project file.

To change the storage location of the file, proceed as follows:

1. Select Extras » Options to open the window of the same name.
2. Open the General tab.

3. (lick [...] and select a storage location.

The autom. save option enables you to switch the automatic save function on and off.

You can open several projects at a time. Each project is displayed in its own project
window. With the commands from the Window menu, the project windows can be
arranged:

Command Description

Tile horz In the horizontal layout the project windows are shown below each other.
Dependent on their number they are additionally arranged in two columns next
to each other for more than 4 project windows.

Tile vert In the vertical layout the project windows are shown next to each other. For
more than 4 project windows they are additionally divided into two columns.

Cascade In the cascading layout the project windows are placed on top of each other with
an offset.

Changes can only be made in the respective active window.
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2.2  Saving a template

All basic information required for performing an experiment that is stored in the project
window on the Settings tab, such as the description of the experiment, the PCR

protocol, scan settings of the optical system and the plate assignment, can be saved as a
template.

1. Call up the File » Save template as command.

2. To save files enter the name of the template in the standard window and save the
template with [OK].

The changes in a template can be saved with the File » Save template menu command.

Optionally, you can click on the H symbol in the toolbar.

2.3  Saving a project

You can save the project with all parameters of the PCR run, the fluorescence curves and
evaluations.

1. Call up the File » Save project as command.

2. To save files enter the name of the template in the standard window and save the
template with [OK].

The changes in a project can be saved with the File » Save project menu command.

Optionally, you can click on the H symbol in the toolbar.

In the window Options / general (menu command Extras » Options) you can define
how the file will be saved and how the file name is to be assigned:

= Automatically by date or name and an index number:
The results of the PCR run are saved without user interaction. The file name consists
of the date or the selected name and a three-digit index.

®  Manually when stating the PCR run:
The user is promted to enter the file name of the project when starting the project.

= Manually at the end of the PCR run (default):
After the PCR run, the user is prompted to enter a file name of the project.

2.4  Importing/exporting analyses

Settings for the data evaluations of a project can be saved (exported) and later
transferred (imported) to an open project. The evaluations are applied to the open
project when they are imported.

1. Select the File » Export analyses menu command.
2. To save files enter the name of the analysis and save the files with [OK].
Analyses are saved with the extension "*.rta".

1. Select the File » Import analyses menu command.
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2. Select the name of the analysis in the default window for opening files and import
the analysis into the current project by clicking [OK].

Creating a project template from a transfer file

With the File » Import LIMS menu command, a project template is created from a
transfer file and a PCR run can be started (— section "Appendix C - Creating a project
template from the transfer file (LIMS)"S. 155).

Performing a Multigene-/Multiplate-Analysis

The File » MultiGene menu command allows the analysis of experiments that required
multiple PCR runs and that comprise multiple genes (— section "Multigene-/Multiplate-
Analysis" p. 116).

Closing project windows

The File » close menu command closes the active project window. To close all project
windows, select the File P close all menu command. If any unsaved changes have been
made in project windows, a confirmation prompt appears.

Printing

You can specify the desired contents for printing a project in a selection list:
1. Select the File » Print menu command.

2. Manage the print output using the displayed lists. Select the desired information in

=
the list on the left and click \_/ to transfer it to the print list on the right. To

remove undesired information from the print list, click
3. Click [Print] to start the printout.

Select [Options] to configure the printout, or [Preview] to display a page view of the
print image.
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Print ] u

4 & Print [ Thermal Cyder
A Efl Settings @ Scan

-] General i
5
[ Thermal Cycler amples

@ Scan || Amplification
[ samples

4 -fg Monitoring
FE. l; Raw data
1= Amplification |
PR k| Melting curve
4 -fd Analysis

----- |54 Abs. Quant.
----- 2 Rel. Quant.
----- 4% DeltaDeltaCt
----- 7 Melt. curve

..... % Genotyping

5]

Options ” Preview “ Print ” Close

Print window

The individual print modules are sorted into the Settings, Monitoring and Analysis
subgroups in the Print window.
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3  Settings for a Real-Time PCR experiment

If you want to start a new project, create a new project or open a template:
m  (reate an empty project with a click on __linthe toolbar.

m  QOptionally, open a template with T to use the previously stored parameters for
the new project or to modify them.

All functions necessary to create a new project are combined under the Settings tab.
Additional tabs on the second level are assigned to the Settings tab:

Tab page Function
General Allows you to enter general information and remarks

Thermocycler  Used for programming PCR protocols

Scan Definition of the colors to be measured and settings for the measuring
parameters
Samples Opens the sample table in which detailed information on each sample can be

saved and groups of experiments defined

3.1 Entering general information on the project

You can save general information on each project. The entries can be made on the

General tab:

Real time pcr template - Salmonella.rtsx EI@
i/ Settings ix  Monitoring % Analysis |j Documentation 4 b
[7] General " [[| Thermal Cycler & Scan [ samples 4 b

Title:

|Salm0nella |

Operator:

|User |

Start: End:

Comment:

optional notes about the experiment]

Real-time PCR run - General information

Command  Description
Title Analysis title

Operator User

If you are using a user management option, the user name you signed in with
will be entered automatically.

24



Settings for a Real-Time PCR experiment

Start / Start and end of the gPCR run. Remains empty in a template.
End

Comment Comment input

Note:

For text inputs on the tab General being able to use the usual commands for copying,
cut out and insert of texts. These commands are arranged in the menu Edit.

3.2 Creating a PCR protocol

A PCR protocol must be programmed for each Real-Time PCR experiment. All necessary
functions are combined in the Settings / Thermocycler project window. The screen is
divided in three sections: graphical program preview (1), program header (2) and
program table (3).

B Real time pcr template - SyGreen-Assay.rts384 o[
Ly Settings & Monitoring 4 Analysis :; Documentation 4 b
[ General 4] Thermal Cycler | € Scan Samples 4 b
©,
100 1
g
a
-
0 T T T T T T
0 1000 2000 3000 4000 5000 6000
Time (s)
éable( A Step:10f5)
d temp. °C: E? [Mpreheatlid Device: v
4 steps | scan °C m:s | goto [ loops || AT(°C) | At(s) | ~(°C/s)
1 95,0 02:00 = == =F === 4,0
95,0 00:05 = — = — 4,0
40x[ 58,0 00:05 = — == = 2,0
& 72,0 00:15 2 39 == = 4,0

€ [Melting curve 60 to 95 °C, 15 s with AT 1 °C

(o)
w
N
W (o |N (o w4 [w]n

-
o

Table | Graph | Melting curve

Program table for creating PCR protocols

The program preview illustrates the history of the PCR protocol. The program header
defines the general conditions for the PCR protocol, such as the programmed lid
temperature, the lid-heating mode and the thermocycler's block type. The programming
table offers a clear representation of the individual steps of the program.

The Thermocycler tab contains three list sheets. The tabs for switching between the list
sheets are located at the bottom of the window.
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List sheet Function
Table Contains a table for programming PCR programs.
Graph Offers the option for graphical programming of PCR programs.

Melting curve  |s used to enter parameters for measuring a melting curve.

Editing a PCR protocol Programs can be edited in the tabular or graphical representation.

You can switch between the two alternative representations via the Table and Graph
screens. To edit one step (the current active step is highlighted light red) you can use
the corresponding function from the Cycler menu in the menu bar or the corresponding
symbol from the toolbar:

Symbol  (Cycler/...) menu command Description

|'__é|}= Add empty step Inserts a new step behind the active step
= Delete ste Deletes the active ste
%1 P P
.& Cut step Cuts the active step
REE Copy step Copies the active step
= Paste step Inserts a copied step behind the active step

3.2.1 Entering information in the program header

The program header contains several general, device specific program settings:
®  QOptions for lid heating
®  Temperature control method

®  Stand-by mode activation after the PCR is complete

Table ( ¥_Step:1of5)

Lid temp. °C: |100 [2] [F]Preheatlid Device: v
Program header of the PCR program (example for qTower settings)

Option/List  Description

Lid temp. Sets the lid temperature.

The temperature of the heating lid should generally be slightly above the
maximum block temperature to prevent liquids from evaporating from the
reaction mixture and condensing at the walls or lid of the reaction cups.
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(for
TOptical)

Device
selection

Settings for a Real-Time PCR experiment

If activated, this option preheats the lid to the set Lid temperature before the
actual PCR program starts.

This is the recommended standard setting to ensure the formation of a
homogeneously tempered air cushion between the sample containers. This
leads to an improved temperature uniformity between the samples. While the
lid is being heated, the block is kept at a constant 25°C.

If the option is deactivated, the PCR program starts while the lid is still being
heated.

Adjustable lid temperature: 30 - 110 °C

Note:
After the heating lid has reached the target temperature, this is followed by a
40-second equilibration before the program is started.

The installed block module is automatically detected by the TOptical
thermocycler during device initialization (with/without gradient function).
When creating a new program this module is accepted as default. However, it
is possible to create a program for a different block format than that currently
installed (for example, a program with a temperature gradient although no
block capable of a gradient has currently been inserted). The desired block type
can be selected from the list.

The installed gTOWER (with /without gradient function) is automatically
detected during initialization. When creating a new program this type is
accepted as default. However, it is possible to create a program for a different
device type than that currently installed (for example, a program with a
temperature gradient although no block capable of a gradient has currently
been inserted).

To do so, select the type from the devices list.

3.2.2 Overview about the PCR protocol

The PCR program is entered into the program table of the Table list sheet. One row of
the table contains the parameters of a temperature step.

You can navigate in the program table by using the mouse or the four arrow keys ([ €]
[=] [] [¥]) on the keyboard. Each entry is confirmed with the [Enter] key or the [>]
arrow key. The cursor jumps into the corresponding field in the adjoining column. If the
cursor is in the last row, an additional temperature step is inserted with [\/]. Click in the
next empty row for inserting an additional temperature step.

4 steps | scan °C m:s | goto | loops || AT(°C) | &t(s) [ A~(°C/s)

1 95,0 02:00 = == 3,0

2 95,0 00:05 | - 3,0
4Dx[ 3 58,0 00:05 = 3= 2,0

4 3 72,0 00:15 | 2 39 = 3,0

5 @ | Melting curve 60 to 95 ®C, 15 s with AT 1 °C

6

7

8

9

10

Program table for a PCR run

The following values are entered into the table or calculated from the default values:

Value

Description
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Scan Measures the sample fluorescence during this step, if marked

Steps Number of the step in the temperature program

Is automatically numbered consecutively

°C Enter the target temperature of the step in °C

m:s Enter the hold time of the target temperature

goto / Define the loop with the number of repetitions for a cycle

loop

AT(°C) Enter the increment or decrement of the target temperature within the PCR run
At(s) Enter the increment or decrement of the hold time within the PCR run

A(°C/s) Enter the heating or cooling rate to reach the target temperature in the

temperature step

Inserting a new temperature step / deleting a temperature step

®  You can insert an additional temperature step to the program table with one of

following functions:

®  Set the cursor in the last row of the temperature program and press the [\V/]
arrow key.

®  Select the menu command Cycler » Add empty step.

H
= Clickon L2,
®  (lick with the mous on the next row under the program.
The total number of steps and the current processed step are displayed in the
protocol header.
eon i
To delete a program step move the cursor to the program row and click on =)

Optionally, select the Cycler » Delete step menu command.

3.2.4 Entering the target temperature, hold time and heating/cooling rates

28

Enter the target temperature of the temperature step into the °C column.

Into the m:s column, enter the hold time in the format "minutes:seconds" (e.g. hold
time of a duration of 1 min 20 s: 1:20).

For special applications or the transfer of protocols from other devices it may be
required to adjust the heating and cooling rates.

Enter the average heating and cooling rate for each individual step in the Z(°C/s)
column.

Note:

The value in the Z(°C/s) column defines the speed at which the target temperature is
reached. If the temperature is be heated (or cooled) at a speed of 3°C per second
between step 2 and step 3 the value 3.0 must be entered for step 3.

Note:
If the speed is to be reduced for the whole program the heating or cooling rates of all
steps must be adjusted. The settings are only valid for that one program.
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4 steps | scan °C m:s | goto | loops || AT(®C) [ &t(s) | ~(°C/s)

1 G| - [~ - [~ [&EAD

2 95,0 00:05 | — | — 4,0
4UX[ 3 58,0 00:05 = = = 2,0

4 » 72,0 00:15 2 39 =< 4,0

5 # | Melting curve 60 to 95 °C, 15 s with AT 1 °C

6

7

8

9

10

Entering the target temperature, hold time and heating/cooling rates in the PCR table

3.2.5 Defining loops

Program sequences that are repeated reqularly can be summarized in loops. Generally, a
loop is then defined by a target step for the return ("goto" and the number or repetitions

("loops").
4 steps | scan °C m:s | goto | loops || AT(®C) [ &t(s) | ~(°C/s)
1 95,0 02:00 | - | — — 4,0
2 95,0 00:05 | — | — 4,0
4Dx[ 3 58,0 00:05 | - | — 2,0
4 » 72,0 00:15 2 30 b —- 4,0
5 # | Melting curve 60 to 95 °C, 15 s with AT 1 °C
6
7
8
9
10

Programming a loop in the PCR table

1. Place the cursor on the last step of the future loop (step 4 in the example above).

2. Enter the number of the target step into the goto column ("2"in the example above).
3. In the loops column enter the number of repetitions ("39"in the example above).

After entering the target step and the repetitions the programmed loop is displayed as a
bracket on the left side of the table.

Note:

The total number of loops displayed in the bracket is determined from the number of
programmed repetitions plus 1, as the corresponding sequence of steps prior to reaching
the loop has already cycled once.

3.2.6 Entering increments/decrements for temperature and hold time
By programming increments/decrements the temperature or hold time can be

modified by a specific amount from one cycle to the other within a loop.This technology
is for instance used for the "Touch Down" PCR.
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3 steps | scan °C m:s | goto |loops || AT(2C) | &t(s) | ~(°C/s)
1 95,0 02:00 = — === — 3,0
a0 2 95,0 00:05 | — [ — || e d o | 3.0
3 68,0 00:15 X 39 f -1, 5 0 30
4 | ® |Melting curve 60 to 95 °C, 15 swith AT 1 °C___
3
A

Entering increments for temperature and hold time

®  Enter the desired changes for the temperature step the values of which you wish to
modify within the loop. Use the (-) sign to specify a decrement, i.e. temperature or
hold time are reduced from cycle to cycle by the specified amount. No sign or (+)
mark a decrement with the result that the parameter increases by the specified
amount from cycle to cycle.

= To modify the target temperature in steps, enter the changes in the AT(°C) column.
= To modify the hold temperature in steps, enter the changes in the At(s) column.

Note:
The modified step must be within a loop. Otherwise, the entries in the columns AT(°C)
and At(s) have no effect.

Note:

The extension of the hold time of one step affects the total run time of a protocol. A
program with many cycles and significant hold time increases takes substantially longer
than a comparable program without a programmed extension.

3.2.7 Arranging a fluorescence measurement
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®  To define the measurement of the sample fluorescence in a temperature step of the
PCR protocol, click on the Scan column of the temperature step. A green diamond
(®) indicates that the measurements is active.

4 steps | scan °C m:s | goto [ loops | AT(®C) | &t(s) | ~(°C/s)

1 95,0 02:00 | — 4,0

2 95,0 00:05 = — =< 4,0
40)([ 3 58,0 00:05 - -— == 2,0

4 [Ce] 720 00:15 | 2 | 39 4,0

5 # | Melting curve 60 to 95 °C, 15 s with AT 1 °C

6

7

8

9

10

Defining a fluorescence measurement in the PCR run

Define the parameters for the fluorescence measurement on the Scan tab (— section
"Defining the parameters for the fluorescence measurement'p. 34).

Note:

If a step for melting curve determination is added, the scanning process is automatically
activated for this step. For all other steps of the PCR protocol the allocation must be
made manually.
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3.2.8 Adding a melting curve

For experiments with intercalating dyes we recommend to check the specificity of the
products by measuring a melting curve. The device can be programmed to add the
corresponding step in the PCR protocol. Activate the option active on the Melting curve

tab.
4 steps | scan °C m:s | goto | loops || AT(®C) [ &t(s) | ~(°C/s)
1 95,0 02:00 | - | — —- — 4,0
2 95,0 00:05 | — | — 4,0
4Dx[ 3 58,0 00:05 | - | — 2,0
4 » 72,0 00:15 2 39 =< 4,0
1 ® |Meltingcurve 60t095°C, 1Sswith AT1°C
6
7
8
9
10

PCR protocol with a step for determining the melting curve

= A melting curve can be added to the program table by activating the option active on
Melting curve tab.

The melting curve is added to the last temperature step in the table.

= To remove a melting curve from the program table deactivate the option active on
melting curve tab.

®  Set the individual parameters of the melting curve step on the Meltingcurve tab:

Melting curve ( ¥_Step: 4 of 5)
Start temp. (5C): Increment A T:
End temp. (°C}: Heating rate (°C/s):

Equilibration (s):

active

Table | Graph |Melting curve

DNA melting curve screen

The following parameters can be modified:

Parameter Description

Start temp. (°C) Start temperature of the melting curve

End temp. (°C) End temperature of the melting curve

Equilibration (s) Time for equilibration of the sample in a temperature before a

measurement is performed

Increment AT Difference between two adjoining temperature steps in °C
Heating rate Heating rate of the block

(°C/s)

active Add a melting curve on the end of the PCR protocol.
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The fluorescence measurement is automatically defined when the melting curve is
recorded.

Note:

If you want to record a melting curve without previous amplification you must add a
separate step prior the melting step in the cycler program. This step must bring the
block temperature to the start temperature of the melting curve and a fluorescence
measurement must be performed. Recording a melting curve without at least one
previous temperature step is not possible.

3.2.9 Programming the temperature gradient (for devices with gradient function only)

Temperature gradient
with margin rows

32

The gradient function is for following devices available:
= TOptical 96 Gradient

= gTOWER 2.2

= gqTOWER3 G

Gradients can be programmed over the whole temperature range of the thermoblock
between 3.0 “Cand 99 °C. The gradient range can be max. 40 °C.

®  Gradients are defined in the program table by entering two temperature values
separated by a dash. The first value entered corresponds to the temperature in
column 01 (left block side), the second value to the temperature in column 12 (right
block side).

3 steps | scan e mis | goto | loops || AT{C) | Atls) [ A0CHE
1 95,0 0500 - - == - =,0
anx| 2 00:30 | - | - -- | — | 50
3 * (54,2-73.2 [)00:30 2 39 == -—= 5,0
4 I

Entering the temperature gradient

The progression of the temperature gradient can be reviewed on the Gradient tab. The
temperatures in the individual columns of the block are summarized in a table below the
bar graph.

Gradient { ¥ Step: 1 of 4)

Temp. Row 01: oC Temp. Row 12: oC

-

°c |e4,8]65,0]656]665[675]68,5]69,5]705]71,5]724]73,0]73,2
row| 1 | 2 1 3] 415 6 7 8 9 |10 |11 [ 12|

Table | Graph |Gradient | Melting curve

Gradient tab with Margin gradient function
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®  Adjust the gradient progression by entering temperature values for the first (Temp.
Row 01) and last (Temp. Row 12) column of the block.

The values displayed in the table are then updated.

= Alternatively you can click on the top end of column 1 or column 12 and change the
height of the column with the left mouse button depressed. Moving the columns
changes the respective temperature value accordingly.

In addition to the option of defining a gradient by entering temperature values for
columns 1 and 12, the gradient can also be programmed starting with an annealing
temperature in the center of the block using fixed temperature increments.

= On the Gradient tab, select the Linear option from the View list.

®  Enter the temperature for column 6 in the Annealing temp.field and the desired
temperature change from column to column in the Increment field.

The values displayed in the table are updated after the values have been entered.

= Another option for adjusting the gradient is to click on the top end of column 6 and
change the height of the column with the left mouse button depressed. Moving the
column the changes the annealing temperature accordingly.

Gradient { ¥ Step: 1 of4)

View: Linear i

Annealing temp.: °C

Increment: iR °C

oc [64,3]64,5]65.1|66,0]67.0]68,0]69.0]70.0]710|71,8]725]72,7

rRow| 1 | 2 | 3 4 | 5 [5 7 8 9 J 1o J 11 [ 12 ]

Table | Graph |Gradient | Melting curve

Programming a linear gradient

3.2.10 Graphical display and programming the PCR protocols

In the Settings / Thermocycler project window, the history of a programmed PCR
protocol is displayed graphically in the Table and Graph screens. It represents the
temperature curve of the block (blue line) and the heating lid (red line) over time. The
green diamond symbolizes steps during which the fluorescence is measured.

100

504

Temp. (°C)

1} S00 1000 1500 2000 2300

Time (s)

Graphical representation of a PCR protocol
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Programs are generally created in the table view, which allows new steps to be
programmed quickly and provides a summarized overall survey of the protocol structure.
Some programming options are only available in the table view. The graphical
programming mode additionally offers a schematic representation of the temperature
profile and the option to adjust protocols quickly. In the Settings / Thermocycler project
window you can switch between the table view and the graphical mode via the Table or
Graph sheets.

Graph { ¥ Step: 1 of 5)

95,0 95.0 Melt
. . 80,0
01:00 00:02 220 I
£5.0
570 | oozo | T
00:10
00:02
o1 0z 60x|03 04 & |05 ® 27x

, Table }\Graph ln{DN.ﬁ. melting /

Graphical programming mode

The graphical programming is generally performed in the same way as in the
programming table.

® By selecting a step (clicking on it) it becomes active and is highlighted light red.

= The bottom part of the display shows the number of the corresponding protocol step.
Next to it, the number of repetitions in loops (right) and scanning processes (middle)
can be programmed in this field.
The number of repetitions is indicated as a figure (e.g. 40x ) and can be edited by
clicking on it with the left mouse button.
Planned measurements are displayed by means of a green diamond in the middle of
the field and can also be selected or deselected with the left mouse button.

®  Temperatures and hold times are indicated as numerical values above or below the
blue line that displays the corresponding temperature level at the individual steps.
The values can be modified by clicking with the left mouse button. Melting curve
steps are marked with the addition Melt. Additionally, a symbol of an arrow pointing
upwards is displayed with the melting curve steps (/).

Note:
The number of repetitions in melting curve steps cannot be modified.

®  The temperature value at each step can be modified using the mouse. For this
purpose, press and hold the left mouse button to move the blue line of the
temperature curve up or down.

3.3  Defining the parameters for the fluorescence measurement

The product accumulation is measured by means of the increase in fluorescence in the
Real-Time PCR. The following measurement parameters must be defined for that
purpose:
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= Dyes to be measured
®  Temperature step of the PCR protocol during which a measurement is to take place
® The area on the PCR plate that is to be scanned

The colors to be measured are defined in the Settings / Scan project window:

Real time pcr project - ddCt_With5tandards.rtpx EI@
i/ Settings ix  Monitoring % Analysis |j Documentation 4 b
[ General [ Thermal Cyder & Scan | [ Samples 4 b
Pos. Channel Dye Gain Measurement  Pass. Ref,
1 Blue FAM 5 *
2 Green JOE 5
3 Yellow TAMRA 5
4 Qrange RO 5
5 Red Cy5 5
] MNIR1 Cy5.5 5
Meas. repeats: 3 Color compensation: off ~
Scan region according layout
Define scan region manually

Project window with settings for the fluorescence measurement

Up to six color channels with different excitation and detection wavelengths can be used
for the fluorescence measurement. The parameters of the fluorescence measurement
apply for all layout samples on which a measurement is to be performed.

The Scan tab contains a table with different parameters for defining the scan properties:

Table parameters Description

Pos. Color module position in the device

Channel Color channel description

Dye Define the dye to be measured for the corresponding channel in the

table by means of a selection list

Gain Requlation of signal intensity

The signal intensity can be adjusted in steps between 0 and 10. The
higher the value, the higher the fluorescence signal in the
corresponding channel.

Standard value: 5

Measurement Activates dye measurement

An active measurement is indicated with a green diamond (@)

Pass. Ref. The LED technology of the device does not require a passive
reference. If you wish to measure a reference dye anyway, place a
checkmark in this column.

The information on position, channel and the selection list of the available dyes cannot
be modified in this table. Modifications of these general settings can only be made in
the Edit color modules window (— section "Editing color modules" p.133).

Following lists and options are available on Scan tab:
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Option Descritption
Meas. repeats Enter the number of repetitions of the fluorescence measurement

Possible values: 1to 16

Color compensation Activate spectral compensation (— section "Color compensation" p.
37).

Scan region according ~ Sample measurement according to the layout of the samples on the

layout Samplestab (— section "Editing the sample table" p. 39).

Define scan region Sample measurement according to manual settings (— section

manually "Manually defining the scan region" p. 36).

Set the following parameters for each channel you wish to make a measurement for:

1. Select the dye to be measured in the Dye column. Click in the cell and mark the dye
in the list that opens up.

Note:
The number of measured dyes does not have an influence on the scan time.

2. Set the signal quality in the Gain column.
The standard setting is "3".

3. Activate the fluorescence measurement in the channel in the "Measurement" column
by placing a green diamond (®).
Channels that are not marked with a diamond will not be measured.

4. If necessary, activate the reference dye measurement by placing a (v') in the Pass.
Ref. column.

5. Enter the number of repetitions for the fluorescence measurements in the Meas.
repeats field.

Note:

An increased number of repeat measurements reduces the measurement value
distribution but also creates longer scanning times and thus longer protocolling
times.

6. Select one of the options for the scan region (manuallyor according to layout).

Manually defining the scan region

The scan region can be defined according to the plate layout in the sample table (—
section "Editing the sample table" p. 39) or manually. The scan region for the
thermocycler is always defined per column. It must always consist of connected columns.

1. For a manual sample selection, select the Define scan region manually option on
the Settings / Scantab.

2. Agraphical representation of the sample block is opened.

3. Enter the first and last column of the region to be scanned into the From column
andTo column fields.

Optionally, you can use the mouse to select the columns. To select an individual
column click directly into that column. If you wish to select several columns, press
and hold the left mouse button and move the cursor over the corresponding area.

Active columns are highlighted blue in the diagram.
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() Scan region according layout
@ Define scan region manually

Scan region; from column: to column:

Manual adjustment of the scan region

3.3.2 Color compensation

Color compensation: Off

Color compensation:
Standard

Color compensation:
Selection

If you are using several dyes per reaction mixture the result may be a fluorescence
crosstalk. This means that a second dye is excited and measured next to the desired dye
at the same time. To subtract the fluorescence quotient of the second dye, you can use
the color compensation function on the Settings / Scan project tab.

gPCRsoft offers two different variants for color compensation on measurement data:

®  Using the standard color compensation Standard1 or Standard 2
Test which of the two compensations gives the best result. If the standard
compensations do not give a satisfactory result, you will need to record a custom
color compensation.

®  Recording und selection of a customer-specific color compensation Selection

The standard setting for the color compensation is Off. This is due to the fact that color
compensation is not required for the most common applications (only one active
measuring channel or dyes that are spectrally widely spaced, such as FAM and ROX).

Bei der Standard-Farbkompensation wird eine Kompensationsmatrix auf die Messdaten
angewendet, die bei der Gain-Einstellung "5"in allen Farben eine ausreichende
Kompensation des Ubersprechens erméglicht.

Using the standard color compensation, a compensation matrix is applied to the
measurement data whichpermits a sufficient compensation of the crosstalk in all colors
in the case of the gain setting "5".

Select Standard from the Color compensation list for using the standard color
compensation.

A better compensation is attained when a compensating matrix is recorded with the
used dyes (— "Spectral calibration" below).

Select Select from the Color compensation list for using this color compensation. A
window appears, in which color compensations that have already been recorded can be
opened and used again. In the window only those compensation data are printed in
black color which meet the settings on the card Scan. Invalid compensation data appear
in red color and cannot be selected.
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Spectral calibration

38

1 Real time por praoject - Estatp ..IJ.E.IEI
Ti@ Monkoring | B9 Analysis | 40
[ Genersl l/p;ﬂ Thasmal Cyeler | 6 Scan l/E Sainphes | 4 b
Pos. Channel Dye Gan Measurement  Pass, Ref,
1 Bl FAM 5 *
2 Green JOE 5
3 reliow TAMBRR 3
4 Orange ROX H
5 Red Cy5 K]
& NR1 Cy5.5 5

Maas, rapesks: |3- I'I Color coempendation: IM vI
T it color Compensation S|

" Dwefine scan rey
Jminimnmd |

CCB1 TamraTr
COB3_1bis4

| o I Cancel

Window for selection of color compensation data

Select a color compensation for the current project with the left mouse button and press
[OK] to activate that compensation.

With the @ symbol or the menu command Scan » Edit color compensation, you can
create a new color compensation by measurement. This process is called spectral
calibration. A new window opens, in which all the required settings can be made. The
window is divided in a selection list for dyesand a plate diagram.

Color Compensation *
Color module Iz 1 2 3 4 5 3 7 5 3 w oo o1
1 FAM ™Y
2 vIC » 2
3 TAMRA 3
4 ROX Y
3 cys ® c FAM vIC ROX ys
6 Cy5.5 o FAM VIC ROX Cy5
Blanks »
Delete ® E FAM vIC ROX ys
E
]
Mame: Temp.:
[4colorcc_so°C | [eo H
[ Start Measurement Ok

Color compensation for spectral calibration window
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To record the calibration data the dyes required for a color compensation must be
available individually in solution. You could for example use the sensors for the
calibration measurement that are to be used in the later PCR experiment. The dye
concentration for the calibration measurement should be approx. 0.1 pmol/I.

In the displayed plate diagram the wells that contain the calibration samples are now
marked individually for each dye and the dye in each of the samples is assigned to the
marked well by clicking on the blue arrow. The dyes offered for selection are those that
were selected in the Settings / Scan project tab.

For an exact calibration measurement we recommend that each dye be created at least
as a triple replicate. It is also recommended to use blanks, i.e. samples which do not
contain dyes. Blanks can be either your NTC samples or wells filled with buffer solution.
In addition, the temperature at which the calibration measurement should be performed
can be set. This should be the same temperature at which the fluorescence
measurements are performed during the PCR run.

The calibration measurement is started by clicking on [Start measurement].

Note:
The selection of available dyes cannot be modified in this table. Modifications can only
be made on Scan tab.

The new color compensation needs to be assigned a description in the name field. It is
included in the selection list after pressing [OK] and will be displayed in the
corresponding window. Templates that are no longer in use can be deleted with
[Delete].

3.4  Editing the sample table

The sample table defines which sample is in which position of the block. These details
are required for using the evaluation functions of qPCRsoft. Here, a sample can be
described by means of its properties, such as name, gene, type, concentration and dye.
Furthermore, samples from different experimental approaches can be combined in
groups.

The necessary entries can be made on the Samples tab after pressing the [Edit layout]
button. The corresponding window is divided into different sections:
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Real time per project - gTOWER2 Demo_AbsQuantl_1.rtp =N =R
ﬁ""; Settings V& Monitoring }/E Analysis }/D Documentation ] 4 F
[ ceneral ]/ﬁ Thermal Cyder ]/G Scan J/ Samplﬁ] 4 P

I Edit layout Create groups |

1|z|3|4|5|s|?|3|9|10|11|12|53mp‘em'e’
o Sample name;
@’_ Target:
i e e e Dye IGene IConc. I
<0000 0000000 [
1000000000000
0006
F 6060
© 000
H Unit: ng
well EI Sample nameI Sample type |Comment IGroup name I » |Gene ISEndard concerl -
cz2 Patient1 Unknown Group 1
Cc3 . Patient1 . Unknown Group 1
c4 . Patient2 . Unknown Group 1
C5 . Patient2 . Unknown Group 1

(2? . Patient2 . Unknown Group 1 ( (3
7 . Patient3 . Unknown Group 1 @

ca . Patient3 . Unknown Group 1
ca . Patient3 . Unknown Group 1
Cc10 Patient4 . Unknown Group 1
ci1 Patient4 . Unknaown Group 1
c12 Patient4 . Unknown Group 1
D1 . Patients . Unknown Group 1
D2 . Patients . Unknown Group 1
D3 . Patients . Unknown Group 1
D4 . Patients . Unknown Group 1 i il
_— . . .- .. . - -

Window for editing the sample table

Range Function

Layout view (1) Graphical display of the well assignment on the microplate

Edit area (3) Edit area for the sample properties:
= Sample name
= Sample type
= Concentration of standard samples

= Allocation of the dye and the analyzed gene

Sample table (2)  Summary of the information on each sample

Dyes (4) Dyes and assigned genes for each sample

Note:
The sample table can also be edited after the Real-Time PCR run has been completed.
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3.4.1 Entering sample properties in the layout

You can define the properties for the samples in the wells on the Settings / Samples
project tab in the layout view and the edit area next to it.

Edit layout Create groups
1 ‘2 ‘ 3 ‘4 ‘ 5 ‘6 |?|8 |g |10|11|12‘Sampletype: Standard -

Sample name: st

e e Target:
|

Dye |Gene |Conc.
FAM c-myc j

Layout view for the sample type
Note

The color code of the inner circle that defines the different sample types and the color
code of the outer ring that defines replicates can be modified in menu Extras » Options
» colors.

The following sample types can be defined:

Sample type Symbol  Definition
Empty Describes an empty position on the PCR plate
Unknown u Sample of unknown concentration or dilution

(measuring sample)

Standard S Sample of known concentration or dilution

Calibrator K Sample the target gene expression level of which is set
tol

No template control N Complete reaction mixture but without template strand

(NTC)

Positive control + Positive control assay for which a reaction product can

be expected

Negative control - Negative control assay for which no reaction product is
to be expected

Samples with identical sample properties (sample name, sample type, same gene-dye-
assignments) are viewed as replicates. For a better overview replicates are indicated by
the same color code of the outer ring.The individual values of these samples are
averaged and their mean value is used for the remaining calculations.

With a singleplex assay, samples can have the same sample name and sample type but
differ as far as the gene-dye-assignment is concerned. These samples are identified as
associated samples due to the same name. The evaluation, however, is performed
individually.

= Mark the sample position to be edited by clicking into the layout. To select adjacent
positions press the left mouse button and define an area. To select non-adjacent

41



Settings for a Real-Time PCR experiment

positions press the Ctrl key on the keyboard plus the left mouse button at each
position.

To mark rows or columns, click on the corresponding row or column name [A-H] or
[1-12].

You can mark all sample positions in the layout by clicking on the gray button in the
top left of the layout (between 1 and Al).

Button for marking the complete layout

= Enter the following sample parameters in the adjacent edit area:

Parameter Description

Sample name  Sample description

Sample type Selection of the sample type (see top of table)
Target table

Gene column In the dye row, enter the gene to be analyzed

Conc. column For standards

Enter the concentration of the gene to be analyzed.

= You can assign sample properties to the marked positions by clicking on @ or by
pressing ENTER.
For emptying on ore more wells, press the DEL key.

Note:
The entries for the selected area will only be applied by the program after they have
been assigned. Entries or modifications that are not assigned will be lost.

®  To display defined sample properties in the edit area, double-click on a well.

You can edit the information and assign them to the well again by clicking @ or by
pressing ENTER.

To assign these sample properties to other wells, mark the desired wells and then

click @ or press ENTER.

® By using the context menu it is possible to assign gene names to the selected wells
afterwards without changing the other properties which had already been assigned.
The context menu can also be used to assign and to remove sample wells which do
not contain an internal positive control (IPC-). The context menu is displayed by right
clicking the PCR plate scheme.
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Assign [PC-
Delete IPC-

Assign genes

Context menu for assigning gennames and ICP- samples

The entry of a sample layout is described by means of an example for a singleplex assay
and a multiplex assay (— sections "Entering a sample layout for a singleplex assay" p. 46
and "Entering a sample layout for a multiplex assay" p. 44).

3.4.2 Entering sample properties into the sample table

Selecting the table view

You can also make entries in the sample table itself.

®  Select the desired position in the layout view or a field directly in the sample table.
The corresponding row is then highlighted yellow.

®  Enter descriptions and/or values directly in the designated cells.

The sample table is edited cell by cell. Multiple selections and the associated
assignment of parameters to several cells or rows at a time are not possible.

el B I Sample namI Sample tvpﬂComment IGroup namal;l Gene IStandard concq;l
ai0 iStdS Standard Graup 1 GAPDH 100
atr stz B tandara roup 1 GAPDH 100
ciz stz B tandard Group 1 GAPDH 100
H1 Empty Group 1
Hz2 Ernpky Group 1
H3 Empty Group 1
H4 Ernpky Group 1
HS Empty Group 1
H& Ernpky Group 1
H? Empty Group 1
Ha Ernpty aroup 1
HS Empty Group 1
H10 Ernplty Group 1
Hi1 Empty Group 1
Hiz Ernplty Group 1
£ =
FaM

Sample table for entering sample properties

The genes and, in the case of standard samples, their concentration are summarized
separately by dye in the second part of the sample table. A list sheet is assigned to each
dye. It is thus possible to use different standard concentrations for each gene. The
number of displayed sheets depends on which dyes have been activated on the Settings
/ Scan project tab for this measurement.

®  Enter for each gene the desired standard concentration.

Depending on the selected window size and the number of dyes to be measured, two
buttons with left and right arrows appear. They can be used to move between the
different tabs.

The number of columns that are displayed in the sample table can be user-defined:

®  Right-click on a column header to display and mark the desired columns in the
context menu.
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®  The order of the columns can be changed by clicking on the table header and
dragging with the mouse.

Well

Well color
Marme
Type color
Type

Comment

LS RN ESES N NS

Group name

Selection field for defining the columns displayed in the sample table

Note: The general color settings can be made in the Options / Color window (Extras »
Options menu command). This is where the colors for wells, replicates and sample types
are determined.

In the graphic representation, the amplification curve is highlighted in the color shown
in the 2nd column of the sample table. You can change the color individually:

= Double-click on the color cell to be changed in the sample table and select the
desired color in the Color window.

= |n order to reset the color of a well, press the Shift key () and double-click on the
color cell at the same time. The color is reset to the default setting in the Options /
Color window.

®  To allocate the same color to multiple wells, press the Ctrl key and double-click on
the color cell of a well.
Mark the applicable wells in the plate layout in the Edit colors window and select the
shared color. Click [Accept] to assign the color to the wells. Click [Reset] to reset the
color changes in the marked wells to the default settings in the Options / Color
window.

Moving the mouse pointer over a well on the Sample project tab in the layout view will
display the properties of the well in the Samples menu item in the project explorer.

-

Position: B3

Group: 1

MName: Std2

Type: Standard

Genel: Conc.: 100ng
Dyel: EAM

Project explorer Samples window showing the well properties

3.4.3 Entering a sample layout for a multiplex assay
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The following example shows the definition of four samples and standards with three
repeat measurements each in the layout. The GAPDH gene is analyzed with the FAM
dye and the c-myc gene with the VIC dye. The two dyes are selected on the Settings /
Scan project tab and activated for measurement. The indicated sample names and
standard concentrations serve as examples only.

1. Activate the [Edit layout] button.
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Emptying sample layout 2. Empty the plate layout to make sure that no unintentional entries remain:

= Mark the complete plate by clicking on the gray button in the top left of the
layout.

= |n the Sample type list select the option Empty.

= (lickon or press ENTER.

Defining samples 3. Mark the three wells A1 - A3.
4. Make the following settings:
Parameter Entered value

Sample name  Sample 1

Sample type Unknown

FAM GAPDH
VIC c-myc
Note:

The genes are allocated to the corresponding dye by entering the name of the gene or
by selecting it from the displayed list in the Target table.

5. Clickon or press ENTER, to assign the sample properties to the three wells.

6. Repeat steps (3) - (5) for the other samples.
Use the following parameters:

Wells Sample name  Sample type FAM VIC

A4 -A6  Sample 2 Unknown GAPDH  c-myc

B1-B3 Sample 3 Unknown GAPDH  c-myc

B4-B6  Sample 4 Unknown GAPDH  c-myc
Defining the standard 7. Mark the three wells C1 - C3.

samples 8. Make the following settings:

Parameter Entered value
Sample name  Std 1

Sample type Standard

9. Make the following entries in the Target table:

Dye Gene Conc.
FAM  GAPDH 100
VIC c-myc 50

Note:
The Conc. column in the Target table is only available for the Standard sample type.
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10. From the Unitlist, choose a concentration or mass unit. You can select from the
following units:ng, ng/pl, ng/ml, pg/ul, copies, copies/pl, copies/ml, mg/ml, IU/pl,
IU/ml or %.

11.Click on or press ENTER, to assign the sample properties to the three wells.

12.Repeat steps (7) - (10) for the other three standards.
Use the following parameters:

Wells Sample name  Conc.

FAM VIC
C4-C6 Std2 50 5
D1-D3 Std3 10 1
D4-D6 Std4 0.1 0.05

= Assample type, select the Standard option.
®  Assign the genes to the dyes as described in step (6).

v" The plate layout for a multiplex assay is complete.

3.4.4 Entering a sample layout for a singleplex assay

The following example shows the definition of four samples and four standards with
three repeat measurements each in the layout. The GAPDH and c-myc genes are
analyzed with the FAM dye with the help of two sensors. The FAM dye was selected on
the Settings / Scan project tab and activated for the measurement. The indicated
sample names and standard concentrations serve as examples only.

1. Activate the [Edit layout] button.
Emptying sample layout 2. Empty the plate layout to make sure that no unintentional entries remain:

= Mark the complete plate by clicking on the gray button in the top left of the
layout.

= |n the Sample type list select the option Empty.

m (lickon or press ENTER.

Defining samples 3. Mark the three wells A1 - A3.
4. Make the following settings:
Parameter Entered value
Sample name  Sample 1

Sample type Unknown

FAM GAPDH

5. (Clickon or press ENTER, to assign the sample properties to the three wells.
6. Mark the three wells A4 - A6.
7. Make the following settings:

46



Defining the standard
samples

Settings for a Real-Time PCR experiment

Parameter Entered value
Sample name  Sample 1
Sample type Unknown

FAM c-myc

8. Clickon or press ENTER., to assign the sample properties to the three wells.

9. Repeat steps (3) - (8) for the other three samples.
Use the following parameters:

Wells Sample name Sample type  Gene /FAM

B1-B3  Sample 2 Unknown GAPDH
B4-B6  Sample 2 Unknown c-myc
C1-C3  Sample 3 Unknown GAPDH
C4-C6  Sample 3 Unknown c-myc
D1-D3  Sample 4 Unknown GAPDH
D4-D6  Sample 4 Unknown c-myc

10. Mark the three wells E1 - E3.

11. Make the following settings:

Parameter Entered value
Sample name  Stdl

Sample type Standard

12. Make the following entries in the Target table:

Dye  Gene Conc.

FAM  GAPDH 100

Note:
The Conc. column in the Target table is only available for the Standard sample type.

13. From the Unit list, choose a concentration or mass unit. You can select from the
following units:ng, ng/pl, ng/ml, pg/ul, copies, copies/pl, copies/ml, mg/ml, IU/pl,
IU/ml or %.

14.Click on or press ENTER, to assign the sample properties to the three wells.

15. Repeat steps (10) - (13) for the other standards.
Use the following parameters:

Wells Sample name  Gene Conc.
E4-E6 Std.1 c-myc 100
F1-F3 Std.2 GAPDH 75
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F4-Fp Std.2 cmyc 75
Gl-G3 Std.3 GAPDH 50
G4-G6 Std. 3 c-myc 50
H1-H3  Std. 4 GAPDH 10
H4-H6  Std. 4 c-myc 10

16.Click on or press ENTER, to assign the sample properties to the three values.

Note:
Connected samples must have the same sample name.

v The plate layout for a singleplex assay is complete.

3.4.5 Automatic generation of dilution series/replicates
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If in an experiment dilution series or replicates are measured, the layout creation can be
automated.

1. Mark the well at which the dilution series or the sample replicate sequence should
start (start at well) or mark an area on the PCR plate for the dilution series or
replicates.

If no area is preselected, the plate is always automatically filled to the rims.

2. Click on the button lﬂj on the Settings / Samples project tab in the layout view.

Sample type: |Empty

L]

Sample name:
Target:

Dye |Gene |Con-:. |
FAM

Button for automatic creation of dilution series or replicates

In the window Dilution series/replicates parameters for automatic dilution series and
replicates can be defined.



Creating a dilution series

Creating replicates
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r -
Dilution series/replicates @
Dilution series
Starting concentration Dilution factor Steps Replicates
10 10 3 3
Start at well
B3 @ by column ) by row
Name of standard FAM JOE TAMRA [FIROX  [C]cys Cy5.5
Std Genel « Gene2 - |Geneld Gened - IPC -
Set
I Replicates
I Start at well MNumber of samples Replicates
I B8 10 3
Sample name
I Unb @ by column ) by row
Sample type FAM JOE TAMRA [FlROX  [Ccys Cy5.5
Unknown ~+ Genel » Gene2 = |Genel Gened = IPC -
Set
| %

Window for creation of automatic dilution series/replicates

1. The starting concentration, the dilution factor and the number of dilution steps and
replicates.

2. Specify the start point (Start at well) and select whether the entry in the layout table
should be done line by line or column by column.

For determination of the start point, the software automatically takes over the
currently active position in the layout or the first position at the upper left from a
group of selected wells. Alternatively, the start point can also be defined by manual
entry in the corresponding field.

3. Enter a name for the standard sample (Name of standard) and assign dyes to be
measured (multiple selections are allowed). The standard name for each replicate is
added by one digit (GAPDH1, GAPDH2, etc.).

4. Activate the dyes for which dilution series should be created. Select the names genes
for the standards. A separate treatment of dyes (targets) is possible in such a way.

5. Click on [Set].

v The dilution series is created automatically by the software and the
corresponding data is displayed in the layout and the sample table.

1. Enter the start point (Start at well) and the Number of samples and the Number of
replicates.

For determination of the start point, the software automatically takes over the
currently active position in the layout or the first position at the upper left from a
group of selected wells. Alternatively, the start point can also be defined by manual
entry in the corresponding field.
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Enter a Sample name and select whether the entry in the layout table should be
done line by line or column by column. The sample name for each replicate is added
by one digit (Test1, Test2, etc.)

Specify the Sample type.

Activate the dyes for which replicates should be created. Select the names genes for
the samples. A separate treatment of dyes (targests) is possible in such a way.

Click on [Set].

v Replicates are created automatically by the software and the corresponding
data is displayed in the layout and the sample table.

Several experiments can be performed on one microplate at the same time. The samples
that are part of one experiment are combined in a group. A group contains a number of
reaction mixtures that will be evaluated together later on. You can define a maximum of
12 such groups.

The groups are defined in the Settings / Samples project window.

1.

In the Settings / Samples project window click on the [Create groups] button.

The Group list and the Group name field are activated.
In the layout, all samples are marked with the number 1. This means they have been
assigned to group 1.

In the layout, select the samples that are part of one experiment. To select adjacent
positions press the left mouse button and define an area. To select non-adjacent
positions press the Ctrl key on the keyboard plus the left mouse button at each
position

Select the next group from the Group list.

Enter the description for the experiment in the Group name field. You may select
any group name.

Click on or press ENTER, to assign the group properties to the samples.
The samples that belong together are marked with the group number in the layout.

The descriptions are displayed in the sample table in the Group name column.
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Real time per project - Unnamed EIE
i Settings ]/& Monitoring ]/E Analysis ] q b
[ General l/ﬁ Thermal Cyder I/Q Scan Samplﬁl 4k

Edit layout ” Create groups
1|2|3|4|5|s|?|8|9|10|11|12|‘3'°“|3’ @

A ooooooa oooo Group name:  Group 4
00000 -D0000
000000000000
000000000000
B:1:1:1:1:1- 000000
:1:1:1:1:1: /000000
B:1:1:1:1:1- 000000
B:1:1:1:1:1: /000000
well | |Sample nam{ Sample typeIComment IGroup narneI + |Gene Standard concl B
Al Unknown Analysis1
Az . . Unkrawri Analysis1
A3 . . Unknawn Analysis1
A4 . . Unkrawri Analysis1
AS . Unknown Analysis1
AR . Unkrawri Analysis1
A7 . Unknown Analysis 2
AB . . Unkrawri Analysis 2
AQ . . Unknown Analysis 2
AlD . . Unkrown Analysis 2
All . . Unknown Analysis 2
Al12 . Unknown Analysis 2
Bl . . Unknown Analysis1
B2 . . Unknown Analysis1
B3 . Unknown Analysis1
- [— PERPEIP s

Sample layout with four groups

3.4.7 Layout preview

The layout preview provides a complete overview of the layout of the PCR plate with
samples and the corresponding information that has been saved for the samples.

= QOpen the layout preview by clicking on the < symbol in the toolbar.
Optionally, call up the Samples » Preview layout menu command.

The layout preview is displayed in the View sample plate window.
The layout preview provides an overview of the following properties:
®  Position on the PCR plate
= Genes to be determined
= Sample type by means of color marking at the edge
= Underlined in color to indicate group affiliation

If you move the cursor to a specific position, all known settings for this position, such as
sample names, sample type and group and all genes and dyes to be measured for the
sample as well as the concentration in the case of standards are displayed in detail.
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3 | 4 | =]
Zellkultur 24h HZellkuItur zah [Jzelikuitur zah [zelkuitur 24h [lZellkultur 24h
FAM: GAPDH Far: GAPDH Posiktion: A2 AM: GAPDH
Zellkultur 24h HZellkuItur 24h  Gruppe: 1 ellkultur 24h
FAM: GAPDH FAM: GAPDH Marne: Zellkulbur 24h AM: GAPDH
Zellkultur Z4h HZEIIkuItur 24h  Tvm Standard ellkultur Z4h
Far: MCF-1 Far: MCF-1 AM: MCF-1
Zellkultur 24h HZEIIkuItur 24h  Genl: GAFDH  Komz.: 100ng ellkultur 24h
FaM: MCF-1 FaM: MCF-1 Farbstoff1: EaM AM: MCF-1

Section from the layout preview table

The table can be printed and used, for example, as a template for pipetting the samples
or for documenting the experiment.

®  Press the [Print] button in the View sample plate window to print the table.

3.4.8 Copying the layout

The layout view or parts of the layout can be copied and inserted into another project.

1. Use your mouse to mark the area in the layout view to be copied.

2. Transfer the information to the clipboard by clicking on the = symbol in the
toolbar.
Optionally, call up the Samples » Copy layout menu command.

3. Select the target project.

4. Paste the information using the = symbol.
Optionally, you can use the Samples / Paste layout menu command.

v' The copied areas become inserted at the same position in the target project like
their position in the source file.

The way described to edit the layout is related to the graphical presentation of the PCR
plate in the upper part of the project window. If the layout table shall be edited by copy,
cut and paste this can be done by using the right hand mouse button and keeping the
Ctr-button pressed. | this way, also areas within the same project can be copied.

1. Press the Ctr-button and hold it pressed during the whole operation.

2. Mark the lines to be copied or cut by left-klicking the mouse and drawing it up or
down.

3. Press the right mouse button and select the desired function

a1z Emply
g1 stz B standard
B2 Stdz [ standard
B3 stdz [ standard
B4 Emply
BS Emnpky
B Ernpky

The standard samples in the wells B1, B2 and B3 are copied to the clipboard

4. Select the line by left clicking the mouse from which the copied samples shall be
inserted. By right clicking the mouse the paste menu appears.
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v In the example the standard Std2 is now a six fold replicate by their identical
sample name.

a1z Ernpky
61 stz B standard
B2 Stdz B standard
B3 Stdz B standard
E4 Ernpky
BS Stdz B standard
g [tz B standard
B7 Stdz B standard
EZ Ernpky
B9 Ernpky

The selected standard samples including their properties are now copied to the wells B5, B6 and B7

3.4.9 Exporting or importing the layout in Excel
The layout can be exported or imported as an Excel file (*.xls). The exported data can be
edited in Excel and then reimported.
= Right-click on the sample table.

A context menu with the Import table from Excel file (*.xIs) and Export table to
Excel file (*.xIs) menu commands opens.

Select the desired menu command.

Sample name: |Std2
[-]100 600000000 —
arget:
E
J— o O o D IGene ICDnc. I
< FAM 100
D
E
F
G
H Unit: ng &~
Well B I Sample namI Sample tvaI Comment | Group namE{ﬂ GEne IStancIard concelﬂ
Al Skd2 Standard Group 1 100
a2 st B standard Group 1 10
T Eh B standard Group 1 1000
a4 —= ; = :
Import table From Excel-File ¢ )
AS . Std4 l Export table bo Excel-File {* . xls) | 1
a6 535 TITTRTTCRT EOOETT
-~ —_—— [N PR e 4
Excel export and import function for the sample layout
3.4.10 Functions for creating and editing a plate layout
Action Where Function
Left click a well PCR plate Selects this well
scheme
Double left click a PCR plate Shows the information assigned to this well in the
well scheme edit fields
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Left click and drag
Ctrl + left click

Ctrl + left click and
drag

Right click selected
wells

ENTER

DEL

Function button F5

Left click on the
table header, column
Well

Right click on the
table header

Right click and drag
on the table header

Left click on a line

Right click on a line

Ctrl + right click (+
drag) on a line of the
table

(holding Ctrl
pressed)

Symbol EI below

the target table

Double-click on the
color cell in the table
row

PCR plate
scheme

PCR plate
scheme

PCR plate
scheme

PCR plate
scheme

Keyboard

Keyboard

Keyboard /
edit field
lIGenell

Table

Table

Table

Table

Table

Ttable

Edit field

Table

Settings for a Real-Time PCR experiment

Selects consecutive wells
Selects this well additionally
Selects consecutive wells additionally

Opens context menu for:

= Assigning and deleting wells which do not
contain an internal positive control (IPC-, only
relevant to end point analysis)

= Assigning genes afterwards
(The gene names shown in the edit field will be
assigned to the selected wells.)

Complies with function assig

(symbol EI placed near the edit field Sample
name or in the toolbar)

Deletes the information assigned to the well and
changes sample type to "Empty"

Removes the selected gene from the displayed list
of genes

Changes sort sequence from "by line" to "by column"
or vice versa

Opens context menu for selection of the colums to
be displayed in the table

Changes the sequence of the colums

Highlights this line an allows for data input or
selection of sample types, directly in the table
Opens context menu for:

exporting the layout table to Excel

importing the layout table from Excel

Opens context menu to copy, cut, paste or delete
the contents of the selected table lines

Opens dialog for automatically creating dilution
series and replicates

Opens the Color window for selecting the color of
the amplification curve.
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Shift key and Table Resets the color setting of the amplification curve

double-click on color to the default setting in the Options / Color

cell window.

Ctrl + double-clickon  Table Opens the Edit color window. A selected color can
color cell be allocated to the amplification curves of multiple

wells at the same time.

WEditlayout ml ) 1 PChR plate
scheme
- 66666| s|7|s|e|w|u]e argerane: i1 [ 2 Edit fields
Target:
¢ o o o o o E]E] Dye IGEI"IE ICnnt:. I
< OO0000 FAM GOIl 100
0 QOO0 0O E 10E Gorz 100
00000 -
FOO0000
‘100000 [0
L00000 e @
I I
1 2

55



Monitoring

4 Monitoring

All functions required for starting and monitoring a Real-Time PCR run are combined on
the Monitoring project tab.

Note

After the PCR run is finished you have the choice to save the project or to continue
without saving. If you save the project you cannot change the settings anymore and, for
data integrity, it is not possible to start a new PCR run from that project. If you want to
start a new PCR run with the same settings you must first generate a template from the
project and then open it.

4.1  Starting the PCR protocol

The toolbar displays the icons for starting the PCR protocol defined in the Settings
project window.

Symbol  Monitoring / ... Description

menu command

b Start qPCR run Start the PCR run

Stop qPCR run The PCR run is interrupted and will not be continued.

The data recorded up to this point is saved and can be
evaluated.

ii Pause qPCR run The PCR run is interrupted. The symbol flashes during the
break. The PCR run can be continued by clicking ii
again.

‘L.ﬁ View options Defines default settings for the Monitoring view.
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4.2  Display options for monitoring

Monitoring

The Monitoring project window is divided into the following areas:

Real time pcr project - gTOWERZ_Demo_AbsQuantl_1.rtp

g";i Settings % Monitoring 24 Analysis

Measurement =

|j Documentation

view: | Amplification ~| ) [ caleulatect |

o5

4 b

é 20000

15000 —

10000

Intensity [1]

3000

Cycles [n]

( :i.\'-\ll colors | FAM

Lid: 25,0 °C 4 steps | scan °C m:s
1 95,0 02:00
2 95,0 00:05
41){[ 3 58,0 00:05
4 * 72,0 00:15
€ 25,0 °C 2
7
g
9
10

( :BTabIe Graph | T-Profile

Monitoring project window for monitoring PCR runs

Area Function

Measuring results  Displays the measured fluorescence data. The fluorescence intensity is
(1) plotted against the cycle.

Colors tabs (2) Switches between the fluorescence accumulation curves that were

measured for the individual dyes.

PCR protocol (3) Displays the PCR protocol. The active step is indicated by a green arrow.

Protocol view tabs  Switches between different views of the PCR protocol (tabular, graphic,

(4) temperature profile).

The fluorescence measurements are displayed in the top area. On the different list
sheets you can choose between the overlapping display of the measurement results of
all dyes or the display of the individual dyes.
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In the View list you can switch between the Amplification, Melting curve and Raw data
views. The Ct value can be calculated for the amplification and the melting temperature
Tm for the melting curve.

The current PCR protocol is displayed at the bottom of the table in the project window.
The active step is marked by means of a green arrow during the PCR run. On the
different sheets you can choose between a tabular or graphical view of the PCR protocol
or the temperature profile. The view of the PCR protocol is described in the section
"Monitoring the PCR run"p. 61.

Note: For each amplification curve a short information is displayed when the mouse
pointer is placed it (mouse-over function).

Default settings for the Monitoring view

For all views in the Monitoring project window it is generally possible to choose
between linear and logarithmic scaling for the graphical display of the data. The setting
for the baseline correction can also be changed.

)
= Select the Monitoring » Display options menu command or click ¥ in the toolbar.

F |
Display options . @

—h A . . )
Smoothing Scaling
none @ linear
@ |5 | Points logarithmic
I Baseline correction I
For &l samples
From cycle: To cydle:
3 = 15 =

@) Sample specific
Crop first cycles:

5 =

|

Display options window for changing the default settings of the Monitoring view

Parameter / Description

Option
Smoothing Setting the smoothing conditions for the measured data
Scaling Scaling options for the data (linear or logarithmic)
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Baseline There are two options for the baseline correction:
correction = Forall samples
If this option is selected, the baseline for every sample in the same range
is determined. The upper and lower range limit must be set in the From
cycle and To cycle fields.
= Sample specific
Select this option if the curves have significantly different Ct values. The
lower range limit for determining the baseline is set in the Crop first
cycles field for all samples. The upper range limit is determined separately
for each sample by an algorithm.
Note:

The type of baseline correction can only be set in this dialog. The range limits
for the correction can also be adjusted in the project window.

4.2.2 Adjusting the view in the Monitoring project window

In the Monitoring project window, you can adjust the preset parameters (Monitoring »
Display options menu command) for the display of the scaling as well as the range
limits for the baseline correction.

1. Click on the ﬂ button above the chart.

A selection field for setting the display options and entering the baseline parameters

opens.
Baseline correction: Baseline correction:
Min: 4 3 3 Pts: A 5 3

Max: 4 15 [k

Scaling: Scaling:
® inear " |inear
logarithmic logarithmic
For all samples baseline correction Sample specific baseline correction
parameter parameter

Parameter settings in the Monitoring project window

2. Change the baseline correction limits and activate the linear or logarithmic option
for the desired view of the fluorescence curves.

4.2.3 Displaying and hiding measurement results for individual wells

The sample view in the Monitoring project window is controlled via the Samples menu
item in the project explorer. Measurement results in the individual wells can be hidden
or shown.

Note:
The selection in the project explorer only influences the display of the fluorescence data
but not the measurement.
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090606 -
09060 -

iclelelelelelelelelolele]
@:00000

Project explorer Samples window

The color code for each sample type can be modified in menu Extras / Options » colors.

The marking of the sample assignment corresponds to the marking on the Samples

project tab:

Sample type Symbol  Definition

Empty E Describes an empty position on the PCR plate

Unknown u Sample of unknown concentration or dilution
(measuring sample)

Standard S Sample of known concentration or dilution

Calibrator K Sample whose gene of interest expression level is set as
1

No template control N Complete reaction preparation but without matrix strand

(NTC)

Positive control +

Positive control preparation for which a reaction product
is expected

Negative control -

Negative control preparation for which no reaction
product is expected

Active wells (i.e. displayed wells) are marked with their sample type symbol. For
deactivated wells the position is grey and the fluorescence data is hidden. Empty wells
are marked "E". By default measurement data for empty wells is not shown. For control

by activating empty wells the measu

rement data can be displayed.

= (lick with the mouse to switch. The activation changes with each click on a well.

= You can change adjacent wells by holding the mouse button and moving the cursor
over the wells. To select non-adjacent positions press the Ctrl key on the keyboard
plus the left mouse button at each position.

= Complete rows and columns can
the row [A-H] or column [1-12].

be inverted by clicking on the letter or number of

®  The activation status of the complete plate can be inverted by clicking on @ on the

top left between A and 1.

®  To activate all wells click on the @ symbol below the chart.
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®  To activate only samples of a specific type click on the corresponding symbol below
the chart. To activate multiple sample types at the same time keep the Ctrl key
pressed when clicking on the sample types.

4.2.4 Exporting fluorescence data

The data from the fluorescence measurement can be exported as ".csv" files. In addition,
the graphical display of the measurement results can be copied to the clipboard as a
hardcopy and is hereby made available for other programs.

= Right-click on the graph.
® A selection window for export and hardcopy appears.
= (lick on Copy chart to copy the chart to the clipboard.

m  Select the Save chart option to export the fluorescence data.
The Save as standard window opens.
Enter a file name and confirm with [OK].

Real time per project - qTOWER3_Demo_AbsQuant1_1.rtp EI@
i Settings ' Monitoring & Analysis [E] Documentation 4 b
View: Amplification ~ | | Calculate Ct

20000 W—-
= 15000+ et *
=z Copy chart /
£ 10000
= Save chart as CSV-File (*.csv)

5000

WA ot

T T T
5 10 15 20 25 30 35 40

Cycles [n]
| colors [ Fam

Lid: 25,0 °C 4 steps | scan oC m:s
1 85,0 02:00
2 85,0 00:05
41)([ 3 58,0 00:05
4 * 72,0 00:15

5

25,0 °C 5

7

8

9

10

Table | Graph | T-Profile

Context menu for exporting the fluorescence data in the Monitoring project window

4.3  Monitoring the PCR run

The running PCR protocol is shown in the bottom part of the Monitoring project tab. It
is generally possible to to choose between the three different views (list sheets) Graph,
Table and T-Profile via tabs.

In addition to the display on the list sheets a status bar shows further information on the
protocol, such as the plateau time, the calculated remaining time and, in programmed
loops, the step number and the number of loops.
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Table list sheet

Graph list sheet

T profile list sheet

62

% _schritt: 3 von 3, & Loop: 11 von 40, §s Plateauzeit: § s, £ Restzeit: 27 min

Status bar of the Monitoring project tab

Lid: 100.2 °C 3 Steps | scan °C m:s
1 05.0 00:02
10/40 [N 50.0 00:03
3 * 2.0 00:10
4
a 3
62.1 °C
]
7
=]
o)
10

Monitoring project window with PCR protocol table

Element Description

Lid Current lid temperature

Temperature display  Current block temperature

Steps Temperature steps in the PCR protocol

The active step is marked by a green arrow.

Target temperature of the step

m:s Hold time, format: min:s
v
Melt
55.0 g5.0 0.0
01:00 00:30 |, 72.0 E5.0
0.0 ——e !
00:30 o0:04
00:30 -
01 o2 40x(03 04 05 # 27

Monitoring project window with PCR protocol table

The Graph list sheet contains the same elements of the graphical representation of the
PCR protocol as the Settings / Thermocycler / Graph project window. Once again, the
active step is marked by a green arrow.

100

0 T T T T T
] Soo 1000 1500 2000 2500

Temp. {*C)

Zeit (s)
Monitoring project window with T profile

In the representation of the temperature profile a yellow progress bar indicates the step
that is currently being performed.
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The size of the area displayed for fluorescent curves and results table or standard curves
can be adjusted by the slider control that is located between the two areas.

GOI-FAM [ Mean Ct | Mean canc,

+ +
+ t

(el | |Sam|:-|e narne |Sample bype (a4 & |Mean Ct Conc. Std. ] *]

Slide control to adjust the size of the displayed areas

4.4  Displaying product accumulation curves and calculating Ct values

Displaying the product
accumulation curve

Calculating the Ct values

The product accumulation is documented by means of fluorescence measurements
during the PCR run in the project window Monitoring.

Select the Amplification or Raw data option from the View list to display
measurement curves for the product accumulation.

In the chart the fluorescence intensity [l] is plotted against the number of cycles in
relative units. The color of the curve that is being displayed corresponds to the color
assigned to each well in the sample table (Settings / Sample project window).

Selected the measurement results for the individual dyes via the corresponding list
sheets.

You have the option to display the measurement results of all dyes together (all
colors list sheet) or only the results of an individual dye.

The display options for the product accumulation curves are described in the section
'Display options for monitoring" p. 57.

After the PCR run, the Ct values can be calculated directly from the amplification curves,
without having to create an analysis such as Absolute quantification.

Select the Amplification or Raw data option from the View list and click [Calculate
Ct].

The amplification curves are normalized and displayed individually or together on
the list sheets for the dyes. The table below shows the Ct values of the individual
samples and the mean values of the replicates.

The threshold value for the individual dyes can be set on the applicable list sheet.
The parameters set in the Options / Analysis window are factored in.

After clicking on [Data], you return to the display of the fluorescence intensities.

4.5 Displaying melting curves and calculating the melting temperatures T,

Displaying melting curves

The course of the melting curve after the PCR can be monitored in the Monitoring
project window.

To display the melting curves, select the Melting curve option from the View list.
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temperature T,
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The display options for the product accumulation curves are described in the "Display
options for monitoring" p. 57.

For a PCR run with included melting curve, the melting temperatures can be calculated
in the Monitoring window without having to create a Melting curve analysis.

= |n the Monitoring project window, select the Melting curve option in the View list.
= (lick on [Calculate Tm].
m Select the gene to be examined in the Gene of Interest (GOI) list.

The melting temperature is calculated taking the parameters set in the Options /
Analysis window into account, and the diagram and the results table are displayed.

= As an option, a threshold value can be set on the Derivative tab, with which
significant peaks can be distinguished from insignificant ones.

= After clicking on [Data], you return to the display of the fluorescence intensities.

Real time pcr project - DemoProjektFuer ScreenshotsV3-2_Sybr+Melt.rtp EIIEI

i Setings | % Monitoring | 29 Analysis [£] Documentation 4 b
Messung (Tm) =
Gene of Interest (GOL): |SybrGreen ¢ Threshold: 1,31 E]

-

-

T,

=

[

=

-

Temp (°C)

Ableitung | GOL
+ +
+ +
wel 8 | Sample name  |Sample type |Tm |Mean Tm Std.Dev. ... | -
Al 1 Unknawn 79,6 79,46 0,2 |
. F Unknown 73,4 79,46 0,2
sz [l Unknown 79,3 79,46 0,2
B1 B Unknown 79,8 79,46 0,2
B6 B Unknown 79,4 79,46 0,2
sz Unknown 79,1 79,46 0,2
a Unknawn 79,6 79,96 0,2
ca B Unknown 79,4 79,46 0,2
cz  l: Unknown 79,2 79,46 0,2
D1 B Unknown 79,7 79,46 0,2
s [l Unknawn 79,4 79,4 0,2 -

Monitoring project window with calculation of the melting temperature
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Evaluation

Evaluation

On the Analysis tab of the project window the following methods are available for

evaluating Real-Time PCR experiments on four cards:
= Absolute quantification

m  Relative quantification

= AACt method

= Melting curve determination

= Genotyping

®m  POS/NEG analysis at the end point

E5i Real time pcr project - T-Optical_Demo_absoluteQuantitatio 3l x|

a;;i Settings ]/-\,, Monitaring | 54 Analysisl/ D Docurnentation 4 b

.!_.,: Absolute quantification l/-‘:i‘ Relative quantification ]/"“‘1'? ddCt quantification ]<1 3

Absolute Quantification: [lEeiEy3l -

Gene of interest (GO Group: Threshold:
FaM ¥| [T Include pass, reference IGrDup 1 j |1J34 +
100
754
5 i
& =]
254
o
T T T T T T T
5 10 15 20 25 30 B4 40
Cycle
GOI-FAM | Mean Ct | Mean canc.

4 4
t t
el I Sample name |Sample type ct & |Mean Ct Conc. Skd. Iﬂ

Ez Std1 Standard 17,23 17,31 10000

El | B Standard 17,27 17,31 10000

E3 | B Standard 17,41 17,31 10000

cz Sanmplel nknawn 19,78 19,93

C3 Samplel Unknown 19,99 19,93

C1 Samplel Unknowin 20,03 19,93 -

4] | »
Table | Standard curve |

Analysis project window

The individual evaluation methods can be accessed via the subordinated tabs. For each
selection method different evaluations can be created.

Toolbar and menu commands are adjusted to the requirements of the selected method

tab.
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General functions in the evaluation project window

Making basic settings

Presets can be made for some evaluation parameters.

i)
1. Clickon tﬁ in the toolbar.

2. Set up the following parameters.

Absolute quantification Dptio

—Smoothing caling
" none & linear
f+ |3 | Points £ logarithmic

rBaseline correction

* For all samples
From cycle: To cyele:

fz = =

" Sample specific
Crop first cycles:

g =

rAuto threshold
* Standard deviation of base lines

" Defined standards

Filker

Intensity: [~ Cancel noise

Imedium j

Ok, - Auta Thr, I Ok, - Fix Thr, | Cancel

Window for basic evaluation settings

Evaluation

Option Function

Smoothing Smoothing the fluorescence curves on the basis of the calculated moving
average over a range of 2 to 12 measuring points or representation without
smoothing

Scaling Linear or logarithmic representation of fluorescence curves

Baseline At the correction of the base line you can choose between two options:

correction = For all samples: At this correction the base line is determined for every

sample in the same area. The lower and upper area limit has to be edited

in the fields From cyncle and To cycle.

®  Sample specific: This correction should be chosen if the curves have very
different Ct values. The lower area limit for the determination of the base
line will adjusted in the field Crop first cycles for all samples. The upper

area limit is separately found out by an algorithm for each sample.

Note:

The manner of the base line correction can be selected only in this dialog. The

area limits can, however, be adapted for the correction in the project window.
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Autom. Calculation of the threshold as a deviation of x times of the standard deviation

threshold of the baselines (factor can be adjusted under Extras / Options / Analysis in
the main menu) or based on defined standards with the goal to get the
maximum value for the coefficient of determination R?

Filter Digital filter for smoothing the fluorescence curves. Adjustable in steps: slight,
medium and strong

Cancel noise  Curves with high background noise that are not interpreted as amplification
curves by the software are set to 0 and no Ct values are calculated.

Auto The threshold line is calculated new when changes to the basic settings are

Threshold made.

Fix The set threshold line is maintained when changes to the basic settings are

Threshold made.

More setting options may be available depending on the analysis method used. They are
explained separately in the respective sections. All items displayed on the Analysis
project tab can also be accessed quickly via the settings area of the baseline and
displayed as linear or logarithmic representations. For this purpose, a selection for
display options can be opened in the corresponding window via the right-arrow button

1

Baseline correction:
Min: 4 3 3
Max: 4 15 [k

Baseline correction:
Pts: A 5 3

Scaling: Scaling:
m linear B inear
logarithmic logarithmic

For all samples baseline correction
parameter

Sample specific baseline correction
parameter

Individual setting of the baseline correction and fluorescence curve scaling during the evaluation

5.1.2 Activating/deactivating samples for evaluation

Samples from individual wells can be activated or deactivated for evaluation in the
project explorer Samples menu item. This enables you, for example, not to include
excessive values when calculating mean values.

Note:
The selection in the project explorer only influences the analysis of the fluorescence
data. Measured data will not be deleted.

67



Evaluation

68

@ 1 2 3 4 5 & F & 9 1011 12
- 000000000000
: Q00000000000
900000000066
cPPOPPPOOOOOOO®
c000000000HKOO
FOOOPOPOOPOOOO
s@OOOOOOOOOO®

iclelelelelelelelelolele]

@:00000

Project explorer Samples window for (de-)activating the samples in the evaluation

The marking of the sample assignment corresponds to the marking on the Samples
project tab. The color code for each sample type can be modified in menu Extras /
Options P colors.

Sample type Symbol  Definition
Empty E Describes an empty position on the PCR plate
Unknown u Sample of unknown concentration or dilution

(measuring sample)

Standard S Sample of known concentration or dilution

Calibrator K Sample whose gene of interest expression level is set as
1

No template control N Complete reaction preparation but without matrix strand

(NTC)

Positive control + Positive control preparation for which a reaction product
is expected

Negative control - Negative control preparation for which no reaction

product is expected

Active wells (i.e. wells included in the analysis) are marked with their sample type
symbol. For deactivated wells the position is grey and the fluorescence data is hidden.
Empty wells are marked "E".

Click with the mouse to switch. The activation changes with each click on a well.

You can change adjacent wells by holding the mouse button and moving the cursor
over the wells.

Complete rows and columns can be inverted by clicking on the letter or number of
the row [A-H] or column [1-12].

The complete plate can be inverted by clicking on @ on the top left between A and
1.

To activate all wells click on the @ symbol below the chart.

To activate only samples of a specific type click on the corresponding symbol below
the chart. To activate multiple sample types at the same time keep the Ctrl key
pressed when clicking on the sample types.



5.1.3 Exporting fluorescence data

Evaluation

The data from the fluorescence measurement can be exported as ".csv" files. In addition,
the graphical display of the measurement results can be copied to the clipboard as a
hardcopy and is hereby made available for other programs.

= Right-click on the graph.

® A selection window for export and hardcopy appears.

= (lick on Copy chart to copy the chart to the clipboard.

m Select the Save chart option to export the fluorescence data.

The Save as standard window opens.
Enter a file name and confirm with [OK].

Real time pcr project - qTOWER3_Demo_AbsQuant1_T.rtp

i Settings & Monitoring

&4 Analysis

ﬂ Documentation

%% Absolute quantification 4% Relative quantification

Absolute Quantification: [SIER 1

Gene of interest (GOI):
FAM w

Indude pass. reference

v—

Group: Threshold:
Gop1  v| [L136 D

100

75

dRn
3
1

Copy chart

Save chart as C5V-File

(*.csv)

25+

GOI-FAM | Mean Ct | Mean conc.

Exporting data from the evaluation

5.1.4 Configure results table

For each analysis the results are summarized in a table that is accessible by the tab

TABLE.
well 8 I Sample name |Sam|:|le tvpe |Ct IMean Ck ICDnc. Std.
E1 iStdZ Standard 20,55 20,7 1000
B2 . Stdz Standard 20,78 20,7 1000
B3 . Stdz Standard 20,76 20,7 1000
1l Samplel Unknovn 20,03 19,93
2 Sample1 Unknown 19,78 19,93
i—l Samplel Urknawn 19,99 19,93
4

C

sl

"| rable [ Standard corve |

Results table

Depending on the analysis method the results table contains different data sets but for
each table the view and selection of columns to be displayed can be configured user-

defined:

= By click with the right mouse button on a column header a box is displayed in which
single columns can be selected or deselected to be shown in the table.
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Evaluation

By dragging a columns header with pressed left mouse button columns can be
exchanged against each other and the arrangement modified.

By click with the left mouse button on the left or right border of a columns header
the width can be modified.

By click with the left mouse button on a columns header the data becomes arranged
ascending or descending (by number or alphabetically).

The colors of the amplification curves can be changed after double-clicking on the
color cell in the table row.

Press the Ctrl key and double-click the Edit color window to set the color for multiple
wells (— section "Entering sample properties into the sample table" p. 43).

By click with the left mouse button on the column "Well" the display of data switches
between column- or row-wise representation of the results. The column- or row-
wise representation is based on the arrangement of samples in the layout.

Symbol Meaning

Witell m | Display of data by columns

Wel B Display of data by rows

Export results

The results table can be exported as Excel-file (*.xls) or "*.csv'-file.

®  (lick with the right mouse button on the results table.
A context menu opens with the commands SAVE TABLE AS EXCEL-FILE (*.XLS), SAVE
TABLE AS EXCEL-FILE (*.XLS) AND RUN EXCEL and SAVE TABLE AS CSV-FILE (*.CSV).
m  Select the corresponding command.
= The standard Windows dialog SAVE AS opens. Enter a name for the file and confirm
the settings with [OK].
Note:

User defined configurations of the results table are included in the exported data set (—
section "Configure results table" p. 69).

well B I Sample name |Sample type ICt IMean ct IConc. Std. Iﬂ
El Skdz Standard 20,58 20,7 1000
B2 | B Standard 2178 2.7 1000
B3 . Stz Save table as Excel-File (*.xls) 1000
Save bable as Excel-File (*.xls) and run Excel
C1 Sarmplel
farcd Samplel Save bable as CSY-File (*.csw)
3 Samplel nknown 19,99 19,93 -
K1 | »
Table | Standard curve |

Export results



5.2

5.2.1

Evaluation

Absolute quantification

The absolute quantification is used to determine absolute copy numbers in samples with
the help of the comparison with standards with known concentrations.

Creating an evaluation for an absolute quantification

1. Go to the Analysis / Abs quant project tab.
If the tab is not visible, click on the arrows 4 ¥ in the tab bar. This will scroll the
tabs.

i
2. (Click on the % symbol in the toolbar.
Optionally, call up the AbsQuant » Add abs. quantification menu command.

3. Aninput window appears. Enter the description for the current evaluation.
On the AbsQuant tab the following information is activated:

®  Parameter settings (1)

m Display of fluorescence spectra (2)

= Display of result table with measurement results (3)

= Display of the standard curves and the calculated coefficients (4)
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i Real time pcr project - T-Optical_Demo_AbsoluteQuantitation.rtp - |EI|§|
E Analysis

£ Settings & Manitoring [  Documentaticn

% Absolute quantification ]/% Relative quantification ]/“%t ddCt quantification ]4 I

o"-sulute Quantification: [i=e0ES -
ene of interest (GO Group: Threshold:
FAM *| [ Include pass. reference IGrouD 1 j |1;34 ﬂ
100
75
s |
& S0
2)
25
u]
T T T T T T T
] 10 15 20 29 30 35 40
Cycle

GOI-FAM | Mean Ct | Mean canc,

5 0
T T
el | Sample name |Sarnp|e type ct & |Mean Ct Caonc, Std, |ﬂ

Ez iStdl Standard 17,23 17,3 10000

E1l . Skdl Standard 17,27 17,3 10000

E3 .Stdl Standard 17,41 17,3 10000

fard . Samplel Unknown 19,73 19,93

C3 . Sarnplel Unknawan 19,99 19,93

i|_| B camplet Unkrowr 20,03 19,93 _|;|
L] 3

3 iTabIe Skandard curv@

Window for absolute quantification

5.2.2 Setting parameter for absolute quantification

Abs. Quantification: AbsQuant _

zene of interest (GOL) Group: Threshald:
Fi-c-mye - [ Include pass, reference IGroup 1 j [3.923 ﬂ

Parameter settings for absolute quantification

Set the following parameters for the absolute quantification:

Option Description

Selection list Selection of an evaluation created for the experiment

Gene of Selection list of target gene/dye combinations

interest (GOI) According to the selection, the fluorescence and regression curves for the

concentration are displayed.

Incloud pass. Only active if a dye has been defined as a passive reference on the Settings
reference /Scan project tab

If this option is activated, the fluorescence of the dye that has been set as a
passive reference is used for standardization.
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Setting the threshold
value

Fix Threshold

Evaluation

Group If several experiments were carried out on the PCR plate, select the group
of the experiment to be analyzed. (— section "Defining groups” p. 50).

Threshold Manually adjust threshold value
The threshold value must be between 1 and 100, depending on the
standardized representation of the fluorescence curves (dRn).
Note:
The threshold value can be calculated automatically or set manually in the
chart (see also "Setting the threshold value" below).

¥ Opens the selection window with display options (— section "Displaying
the fluorescence curves for absolute quantification” p. 73).

To determine Ct values for the evaluation, a threshold value needs to be determined for
each experiment first.

You have several options for setting the threshold value:
= |n the general options (— section "Making basic settings" p. 66).
= Manually in the parameters for the respective evaluation (see table above)

®  Graphically in the fluorescence curves representation:
In the chart, move the black threshold line up or down with the cursor. Press and
hold the left mouse button while doing so. At the same time, the Ct values in the
result table are updated.

Note:

Due to the further spread of the early exponential area of the product accumulation
curves, a logarithmic representation is better suited for setting the threshold
manually in the display range than a linear representation.

® By automatic calculation:
m
The automatic calculation of the threshold value is activated by clicking on the #
symbol.
Alternatively, you can call up the AbsQuant » Autom. Threshold menu command.

Whether you choose manual or automatic calculation, the resulting threshold value is
updated and displayed synchronously in the corresponding Threshold input field.

The threshold value becomes recalculated by the software each time basic settings for
the analysis are changed. For the analysis the option Fix Threshold can be used, so that
the threshold value is retained if the basic settings for the analysis are changed (—
section "Making basic settings" p. 66).

5.2.3 Displaying the fluorescence curves for absolute quantification

In the display range, the measured data, standardized to the value 100 for highest
fluorescence intensity, is plotted against the cycle for the selected target gene.

The respective fluorescence curves are displayed by switching to another target
gene/dye combination.

The fluorescence data is displayed as a linear or logarithmic representation depending
on the selected display option. For both display options the program shows brief
information on the sample if the cursor is placed on one of the curves.
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Switching the display 1. Click on the 2 button in the parameter bar.
options for the chart
A selection window for the display options opens.
2. Select the Scaling logarithmic or linear option.

Click next to the selection window. The changes are applied.

100

75 4

dRn

50

25

5 10 15 20 25 30 33 40

GOI-FAM | Mean Ct | Mean conc, |

Linear representation of the fluorescence curve for the absolute quantification

100

dRn

0,1 T T

GOI-FAM | Mean Ct | Mean conc, |

Logarithmic representation of the fluorescence curve with horizontal threshold line

5.2.4 Display of the mean Ct values or mean concentrations

After selecting the tab MEAN. CT or MEAN. CONC. the display changes to a presentation of
the results as bar chart. The respective sample name is given below each bar. The height
of the bar is determined by the mean Ct-value or the calculated mean concentration of
replicates. For each bar some short information about the position of the samples, the
mean value and the calculated standard deviation is shown if the mouse pointer is
placed on it. The size of the standard deviation is shown as error bar on top of each bar.
Since for large numbers of samples not all bars can be displayed in the screen the
diagram can be moved horizontally with pressed left mouse button and dragged to the
desired position.
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5.2.5 Displaying the standard curve and results of an absolute quantification
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Evaluation

In the bottom Standard curvesection of the Analysis project window, you can switch
between the calculated standard curve and the result table via the Curve and Table list
sheets.

For the display of the standard curve the Ct values of the standard samples are plotted
graphically against the logarithm of their concentration. In the value range on the right

the following calculated data is displayed:

the coefficient of determination R? of the linear equation
the standard curve gradient
the intersection of the curve with the y-axis at x=0 (offset)

The PCR efficiency
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The standard curve and the values are automatically calculated by the gPCRsoft software
and updated in case of settings modifications.

FaM u
FAM, 2, 24,48 B 0,99927
o 2T ; Slope 3,62
i}
504 Offset 31,72
| | | | | PCR Efficiency (0,59
1 1,5 2 25 3 35 4
Log Std. Conc.
Table | Standard curve |

Standard curve for absolute quantification

The result table for the absolute quantification contains all data and the associated
measurement values for the samples.

Wel B | Sample name ISampIe type ICt IMean Ct IConc. Std. |ﬂ
E1 iStdE Standard 20,55 20,7 1000

B2 .StdZ Skandard 20,78 20,7 1000

B3 . stdz Standard 20,76 20,7 1000

Cl Samplel Unknovn 20,03 19,93

c2 Samplel Unknown 19,78 19,93

C_SI—I Sample1 Unknown 19,99 19,93 _|;|

4 3

"| rable [ Standard curve |

Result table for absolute quantification

For the absolute quantification the results table contains the following information:

Column
Well

color of curve

Sample name
Sample type
Group

Gene

Ct

Mean. Ct
Conc. Std

Mean conc.

StdDev. Ct
%CV Ct

StdDev. Mean
conc.

Description
Position of sample

Each sample is automatically assigned an unchangeable color which is used
to display the corresponding fluorescence curve

Name of sample

Type of sample

Assignment of the sample to an experimental group
Name of gene measured in the sample

Ct value of sample

Mean Ct value of replicates

Concentration of the standard sample

Concentration determined from the standard curve on the basis of the mean
Ctvalue

Standard deviation of the Ct values between replicates
Variation coefficient of the Ct values between replicates

Standard deviation of the mean concentration

A shortened representation of the standard curve calculated by the software is displayed
in the project explorer under Abs. quant. The image displays the graphical plot of the Ct
values of the standard samples against the logarithm of their concentration:

Display in the project
explorer
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Log Std. Kz,

Representation of the standard curve in the project explorer

5.2.6 Exporting results of calculations

Excel and CSV

Export to qBASE+

Exporting measurement data and results of calculations enables you to perform more
extended data analysis by using dedicated software.

You can design the results table according to your requirements by setting type,
sequence and width of the columns to be displayed. You can also adjust the sort
sequence of data in the column (alphabetical, numerical, by column, by row). The table
configured this way can be exported as Excel or CSV file by right clicking the table.

Save table as Excel-File (*, xls)
Save table as Excel-File (*.x1s) and run Excel

Save table as CSY-File (*,csv)

Context menu for data export

gqBASE+ is a software which allows for a more detailed statistical analysis of your gPCR
data. For information see www.biogazelle.com. Using the analysis module ‘Absolute
Quantification’ of gPCRsoft you can export qPCR data to a file which can be read and
analyzed by qBASE+.

r.
1. In order to export qPCR data for use in gBASE+ click the symbol E¥ in the toolbar.
Alternatively you can select the menu ABSOLUTE QUANTIFICATION / QBASE EXPORT.

2. Choose the targets shall be exported and the data format shall be used (qBASE+ is
able to read both formats) in next dialogue.

The following information is sent to qBASE+:
= Well

= sample type

= sample name

= gene name

= (Ctvalue

®  concentrations of standards

® sample active/inactive
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Q1 (FAM)
QZ (ROX)

& * cov Expork
£ # wls Export

Ok, I Abbruch

Window QBase Export fort he data export to qBase+

Note:

Only those genes are displayed in the export dialogue which were set as GOI before.
Therefore in multiplex assays for each GOI, i.e. each dye, an absolute quantification
must be defined. To do so repeat the steps explained in section "Creating an evaluation
for an absolute quantification" p. 71, topic 2 and 3, for each GOI.

5.2.7 Importing the standard curve

Next to the option to measure a standard curve in the experiment, the qPCRsoft
software can also be used to determine the concentration of the samples based on the
saved standard curve. You can use the import function for this purpose.

1. Usethe l-:% symbol in the toolbar to open the Import standard curve window.

Optionally, you can call up the AbsQuant / Import standard curve menu command.

The mathematical equation that the standard curve is based on and the associated
dye are each displayed in the list fields of the window.

2. Select one of the import options from the Import standard curve window and make
the corresponding entries:

Option

Import from this
run

Import from saved
run

Manual input

Delete External
Standards

Meaning

Imports a standard curve from the current open project.

If several standard curves are saved in one project, all curves are
displayed and you can make a selection.

Imports a standard curve from a saved project.

If several standard curves have been saved, select the corresponding
curve from the list.

Standard curve coefficients are entered manually.

Enter the gradient and the intercept for the equation

Ct = gradient * log(conc) + intercept.

Deletes imported or entered standard curves so that they are no
longer used for analysis

5.2.8 Deleting the evaluation of an absolute quantification

An evaluation that is no longer required can be removed.
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1. Activate the evaluation by selecting its description in the evaluation list of the
method tab.

2. Clickon :ﬁi in the toolbar.Optionally, you can call up the Absolute quantification »
Delete evaluation menu command.

The evaluation is removed.

5.3  Relative quantification

Relative quantitation allows for determination of the relative expression level of a gene
of interest in relation to one or more reference genes (often housekeeping genes). If
one of the samples is denoted as the calibrator , the expression level of that sample is
set to unity and the relative expression levels of all the other samples are given in
relation to the calibrator sample. For relative quantification standard dilution series are
required for the gene of interest as well as for the reference genes.

5.3.1 Creating a new evaluation for a relative quantification

1. Go to the Analysis / RelQuant project tab.
If the tab is not visible, click on the arrows ¥ ¥ in the tab bar. This will scroll the
tabs.

el
2. Clickon the £ symbol in the toolbar.
Alternatively, call up the RelQuant » Add rel. quantification menu command.

3. Aninput window appears. Enter the description for the current evaluation.
On the Rel. Quant. tab the following information is activated:

= Parameter settings (1)

Display of the fluorescence curves for the target gene and the reference gene (2)

Display of the result table with the added values (3)

Display of the standard curves for the target gene and the reference gene and the
calculated coefficients (4)
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Efi Real-Time PCR Projekt - T-Optical_Demo_RelativeQuantitation.rkp
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Window for relative quantification

5.3.2 Parameter settings for relative quantification

Rel. Quantification: Reduant _

Gene of Inkerest (GO Group: Threshold:
FAM-c-myc - I | Include passive reference Group 1 j I23.163 ﬂ

Reference genes!

IVIC-GAPDH =l !l

Parameter settings for relative quantification

The following parameters must be set for the relative quantification:

Option Description
Selection list Selection of an evaluation created for the experiment
Gene of Selection list of target gene/dyecombinations

interest (GOI)  According to the selection, the fluorescence and regression curves for the
concentration are displayed.

Only one target gene at a time can be selected.
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Setting the threshold
value

Fix Threshold

Reference
genes

Include pass.

reference

Group

Threshold

¥

Evaluation

Reference gene selection list

In contrast to the target gene, several reference genes can be selected at the
same time. The number of list sheets in the display range therefore grows
with each reference gene.

The symbol is used to remove all reference gene settings from the
evaluation.

Only active if a dye has been defined as a passive reference on the Settings
/ Scan project tab.

If this option is activated, the fluorescence of the dye that has been set as a
passive reference is used for standardization.

If several experiments were carried out on the PCR plate, select the group of
the experiment to be analyzed. (— section "Defining groups' p. 50).
Manually adjust threshold values

The threshold value must be between 1 and 100, depending on the
standardized representation of the fluorescence curves (dRn).

Note:
The threshold value can be calculated automatically or set in the graph.

Opens the selection window with display options

To determine Ct values for the evaluation, a threshold value needs to be determined for
each experiment first.

You have several options for setting the threshold value:

= |n the general options (— section "Making basic settings" p. 66)

= Manually in the parameters for the respective evaluation (see table above)

®  Graphically in the fluorescence curves representation:
In the chart, move the black threshold line up or down with the cursor. Press and
hold the left mouse button while doing so. At the same time, the Ct values in the
result table are updated.

Note:

Due to the further spread of the early exponential area of the product accumulation
curves, a logarithmic representation is better suited for setting the threshold
manually in the display range than a linear representation.

® By having it calculated automatically:

iy
The automatic calculation of the threshold value is activated by clicking on the = &5

symbol.

Alternatively, you can call up the RelQuant » Autom. Threshold menu command.

Whether you choose manual or automatic calculation, the resulting threshold value is
updated and displayed synchronously in the corresponding Threshold iput field.

The threshold value becomes recalculated by the software each time basic settings for
the analysis are changed. For the analysis the option Fix Threshold can be used, so that
the threshold value is retained if the basic settings for the analysis are changed (—
section "Making basic settings" p. 66).
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5.3.3 Displaying the fluorescence curves in the relative quantification

In the display range, the measured data, standardized to the value 100 for highest
fluorescence intensity, is plotted against the cycle for the selected target gene. The
target gene/dye and the reference gene/dye combinations are each assigned a list sheet
that can be activated by clicking on the gene/dye tab on the bottom.

Since only one target gene/dye combination is permitted at a time, the fluorescence
curves of the selected combination are displayed whenever a new combination is
selected. The number of the available list sheets depends on the number of the selected
reference genes.

The fluorescence data is displayed as a linear or logarithmic representation depending
on the selected display option. For both display options the program shows brief
information on the sample if the cursor is placed on one of the curves.

Switching the display 1. Click on the 2 button in the parameter bar.
options for the chart
A selection window for the display options opens.
2. Select the Scaling logarithmic or linear option.

Click next to the selection window. The changes are applied.

100 <

75 4

50

dRn

25 -

5 10 15 20 25 30 33 40

GOI-FAM | Ref.gene-FaM | Morm.rel, conc, |

Linear representation of the fluorescence curve for the relative quantification

100

c /WB" B1, 21, 3,31 (5tdz)
= £
14 / M/
0,1 T T T T T T T
5 10 15 20 25 30 5 40

Cycle

GOI-FAM | Ref.qene-FAM | Morm.rel, conc, |

Logarithmic representation of the fluorescence curve for the relative quantification with horizontal
threshold line
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5.3.4 Display of the normalised relative concentrations

After selecting the tab Norm. rel. conc. the display changes to a presentation of the
results as bar chart. The respective sample name is given below each bar. The height of
the bar is determined by the mean Ct-value or the calculated mean concentration of
replicates. For each bar some short information about the position of the samples, the
mean value and the calculated standard deviation is shown if the mouse pointer is
placed on it. The size of the standard deviation is shown as error bar on top of each bar.
Since for large numbers of samples not all bars can be displayed in the screen the
diagram can be moved horizontally with pressed left mouse button and dragged to the
desired position.

RC

EAM - Sk
EfR - SkA7
EfR _ Skd=
FAM - Skdd

GOI-FAM | Ref.gene-FAM |Morm.rel. canc,

Bar chart for display of normalised relative concentrations

5.3.5 Displaying the standard curves and the results of a relative quantification

In the upper area of the project window you can switch between the display of the
calculated standard curves for the target gene and all selected reference genes and the
result table for the relative quantification using the Standard curve and Table list
sheets.

For the display of the standard curve the Ct values of the standard samples are plotted
graphically against the logarithm of their concentration. For the respective data points
errors bar are shown that indicate the standard deviation between replicates. For each
data point some short information about the sample name and the size of the standard
deviation of replicates is shown if the mouse pointer is placed on it. In the value range
on the right the following calculated data is displayed:

® the coefficients of determination R? of the linear equation

®  the standard curve gradients

® the intersections of the curves with the y-axis at x=0 (offset)
® the PCR efficiency

When more than one standard curve is displayed each curve has its individual color.
Accordingly each table has a color code in the header that reflects the assignment to the
respective standard curve. The standard curve and the values are automatically
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calculated by the qPCRsoft software and updated in case of settings modifications.
According to the number of genes used a scroll bar appears under the table. It can be
used to navigate through the table's columns.

FaM-cmyc ®[FAM-GAPCH m |
30
FAM-GAFDH, 2,18, 25,68 | R2 0,993z2 u,99222

& 254 Slope -3,06 -4,18

20 Cffset 29,1 34,28

| | | PCR Efficiency |1,12 0,74
1 B 3 4
Log Std. Conc.

Table [Standard curve

Standard curves for relative quantification

The result table for the relative quantification contains all data and the associated
measurement values for the samples.

Al El Sample name ISampIe type IGOI IReFerence... ICI: GOl ICt ReFere..ﬂ
B1 Skdz Standard c-myc 20,23
B2 Bt Standard eyt 20,35
B3 | Et Standard c-mye 20,29
B7 B Standard eyt 26,21
Ba B Standard c-mye 26,15
i—l | Standard c-mye 26,14 _|LI
4 »

| rable [ Standard curve |
Result table for relative quantification

For the relative quantification the results table contains the following information:

Column Meaning
Well Position of sample

Color of curve Each sample is automatically assigned an unchangeable color which is

used to display the corresponding fluorescence curve
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Sample name
Sample type
Group

GOl

Reference gene
Ct GOI

Ct Reference
gene

Mean. Ct GOI

Mean. Ct
Ref.gen

Conc. Std. GOI

Conc. Std
Ref.gen

Mean Conc. GOI

Name of sample

Type of sample

Assignment of the sample to an experimental group

Gene of interest

Reference gene

Ct value of gene of interest

Ct value of reference gene

Mean Ct value of replicates of the gene of interest

Mean Ct value of replicates of the reference gene

Concentration of the standard for the gene of interest

Concentration of the standard for the reference gene

Concentration for the gene of interest determined from the standard

curve on the basis of the mean Ct value



Display in the project
explorer

5.3.6

Mean Conc.. Ref.

gen

Std.Dev. Ct GOI

Std.Dev. RefGen

%CV Ct GOI

%CV Ct RefGen

Relative Conc.

Norm. Rel. Conc.

Std.Dev.
Relative Conc.

Std.Dev. Norm.
Rel. Conc.

Evaluation

Concentration for the reference gene determined from the standard curve
on the basis of the mean Ct value

Standard deviation of the Ct values between replicates of the gene of
interest

Standard deviation of the Ct values between replicates of the reference
gene

Variation coefficient of the Ct values between replicates of the gene of
interest

Variation coefficient of the Ct values between replicates of the reference
gene

Relative (x-fold) expression level of the gene of interest in relation to the
reference gene

Relative (x-fold) expression level of the gene of interest in relation to the
reference gene, standardized to the expression of the calibrator (if
defined)

Standard deviation of the relative concentrations

Standard deviation of the normalised relative concentrations

A shortened representation of the standard curves calculated by the software is
displayed in the project explorer under Relative quantification. The image displays the
graphical plot of the Ct values of the standard samples against the logarithm of their

concentration.

B Relative quantification =

30
o 257
(]

20

Log 5td. Conc.

Representation of the standard curves in the project explorer

Importing the standard curve for relative quantification

Next to the option to measure a standard curve in the experiment, the qPCRsoft
software can also be used to determine the concentration of the samples based on the
saved standard curve. You can use the import function for this purpose.

1. Usethe ﬂ?" symbol in the toolbar to open the Import standard curve window.

Optionally, you can call up the RelQuant » Import standard curve menu command.

2. All additional setting are analogous to the settings for the absolute quantification
(— section "Importing the standard curve" p. 78).

85



Evaluation

5.3.7 Deleting the evaluation of a relative quantification

An evaluation that is no longer required can be removed.

1. Activate the evaluation by selecting its description in the evaluation list of the
method tab.

ade=

= s .
2. Click on the = E% symbol in the toolbar.
Alternatively, call up the RelQuant » Delete rel. quantification menu command.

The evaluation is removed.

5.4 AACt method

The AACt-method allows for determination of the relative expression level of a gene of
interest in relation to one or more reference genes (often housekeeping genes). One of
the samples has to be denoted as the calibrator. The expression level ofthe calibrator is
set to unity and the relative expression levels of all the other samples are given in
relation to the calibrator sample. In AACt-method there is no need to measure standard
dilution series. However, if the AACt-method shall be validated within the same PCR run
standard dilution series must be defined.

5.4.1 Creating a new evaluation for a AACt method

1. Go to the Analysis / ddCt quantification project tab.
If the tab is not visible, click on the arrows 4 * in the tab bar. This will scroll the
tabs.

ddlt
2. Click on the % symbol in the toolbar.
Alternatively, call up the DeltaDeltaCt / Add ddCt quantification menu command.

3. Aninput window appears. Enter the description for the current evaluation.

On the DeltaDeltaCt tab the following information is activated:

= Parameter settings (1)

= Display of the fluorescence curves for the target gene and the reference gene (2)

= Display of the result table with the added values (3)

If standards have been defined, display of the standard curve (4) and the validation
curve (5) for the expression level of the gene of interest in relation to the reference
gene and the calculated factors
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Project window for the AACt method

5.4.2 Parameter settings for the AACt method

ddCt Quantification: [EERE Rl _

Gene of Interest (GOT):
FAM-c-myc -

Reference genes:

Group: Threshold:

Group 1 ﬂ |39- 125 ﬂ

| ROX-Tubulin

=] x|

Parameter settings for the AACt method

The following parameters must be set for the AACt method:

Option

Description

Selection list

Selection of an evaluation created for the experiment

Gene of
interest (GOI)

Selection list of combinations of measured dyes and target genes to be
quantified

Only one target gene at a time can be selected.
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Fix Threshold
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Reference Selection list for the reference genes

genes In contrast to the target gene, several reference genes can be selected at the

same time. The number of list sheets in the display range therefore grows
with each reference gene.

With the symbol you can remove all selected reference genes from the
selection.

Group If several experiments were carried out on the PCR plate, select the group of

the experiment to be analyzed. (— section "Defining groups" p. 50).

Threshold Manually adjust threshold values

The threshold value must be between 1 and 100, depending on the
standardized representation of the fluorescence curves (dRn).

Note:

The threshold value can be calculated automatically or set in the graph.

| Opens the selection window with display options

To determine Ct values for the evaluation, a threshold value needs to be determined for
each experiment first.

You have several options for setting the threshold value:

In the general options (— section "Making basic settings" p. 66).
Manually in the parameters for the respective evaluation (see table above)

Graphically in the fluorescence curves representation:

In the chart, move the black threshold line up or down with the cursor. Press and
hold the left mouse button while doing so. At the same time, the Ct values in the
result table are updated.

Note:

Due to the further spread of the early exponential area of the product accumulation
curves, a logarithmic representation is better suited for setting the threshold
manually in the display range than a linear representation.

By having it calculated automatically:

The automatic calculation of the threshold value is activated by clicking on the ==
symbol.

Optionally, you can call up the DeltaDeltaCt » Autom. Threshold menu command.

Whether you choose manual or automatic calculation, the resulting threshold value is
updated and displayed synchronously in the corresponding Threshold iput field.

The threshold value becomes recalculated by the software each time basic settings for
the analysis are changed. For the analysis the option Fix Threshold can be used, so that
the threshold value is retained if the basic settings for the analysis are changed (—
section "Making basic settings" p. 66).

5.4.3 Displaying the fluorescence curves for the AACt method
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In the display range, the measured data, standardized to the value 100 for highest
fluorescence intensity, is plotted against the cycle for the selected target gene. The



Switching the display
options for the chart

Evaluation

gene/dye and the reference gene/dye combinations are each assigned a list sheet that
can be activated by clicking on the gene/dye tab on the bottom.

In the evaluation you can always use only one target gene but several reference genes.
The number of the available list sheets depends on the number of the selected genes.

The fluorescence data is displayed as a linear or logarithmic representation depending
on the selected display option. For both display options the program shows brief
information on the sample if the cursor is placed on one of the curves.

1. Click on the ﬂ button in the parameter bar.
A selection window for the display options opens.
2. Select the Scaling logarithmic or linear option.

Click next to the selection window. The changes are applied.

100
75 4

05 Well A1 {sal)

25

dRn

5 10 15 20 25 30 35 40

Cycle

GOI-FAM | Ref.gene-FAM | Mormalized expression | Relative quantity |

Linear representation of the fluorescence curve for the AACt method

100

well &l (sal) t

dRn

0,1 T T T T T T T
5 10 15 20 25 30 35 40

Cycle

—|GOI—F.¢\M [ Ref.qene-Fam | Marmalized expression | Relative quantity |

Logarithmic representation of the fluorescence curve for the AACt method

5.4.4 Display of the normalized relative expression or relative quantities

After selecting the tab Normalized Expression or Relative Quantity the display changes
to a presentation of the results as bar chart. The respective sample name is given below

each bar. The height of the bar is determined by the calculated normalized expression or
the calculated relative quantity of replicates. For each bar some short information about

the position of the samples, the mean value and the calculated standard deviation is
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shown if the mouse pointer is placed on it. The size of the standard deviation is shown
as error bar on top of each bar. For the representation of the relative quantities the
results for the target gen and reference gene the bars are colored differently. Since for
large numbers of samples not all bars can be displayed in the screen the diagram can be
moved horizontally with pressed left mouse button and dragged to the desired position.

1,75
1,5

1,25
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BS, B6 | 1| 2,04
0,75
0,5

0,25

=L R |
[ =010 R )
FAM _ a2
Cama eoa
FAM - 5a5

GOI-FAM | Ref.gene-FAM [Mormalized expression | Relative quantity |

Bar chart for display of normalized expression of replicates

RO

B3, B4 | 2,65 | 4,51

GOI-FAM | Ref.gene-FAM | Mormalized expression | Relative quankity

Bar chart for display of relative quantities of replicates

5.4.5 Setting the calculation mode for the standardized expression
The qPCRsoft software enables you to calculate the standardized expression SE with two
different methods:
= Without PCR efficiency calculation (Livak method)
= With PCR efficiency calculation for GOl and reference genes (Pfaffl method)

To calculate the standardized expression SE, one sample must be defined as the
calibrator.
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SE without efficiency
calculation (Livak
method)

Calculating the
standardized expression
SE with efficiency
calculation (Pfaffl
method)

Evaluation

The Livak method assumes that the PCR efficiencies of the gene of interest (GOI) and
the reference gene (RefG) are equal. The following applies:

NE = 2—AACt

where AACt = ACt(Calibrator) — ACt(Sample)
and ACt(Sample) = Ct(GOI,Sample) — Ct(RefGene, Sample)
ACt(Calibrator) = Ct(GOI, Calibrator) — Ct(RefGene, Calibrator)

The Pfaffl method considers the efficiencies determined for the gene of interest (GOI)
and the reference gene (RefGene). The efficiencies (E(GOI) and E(RefGene)) can be
calculated from dilution series or specified in the software. The following applies:

3 [1+ E(GOI)]Act(6oD
"~ [1 + E(RefGene)ACt(RefGene)

NE

where ACt(GOI) = Ct(GOI,Calibrator) — Ct(GOI, Sample)
and ACt(RefGene) = Ct(RefGene,Calibrator) — Ct(RefGene, Sample)

The Pfaffl method is generally preferred as the basic assumption of the Livak method
(equal efficiency when amplifying the gene of interest and the reference gene) is rarely
the case in practice and the calculation can therefore lead to incorrect values.

The calculation method is selected in the ddCt Options window.

N
= (Click on the “¥ symbol in the toolbar.
Alternatively, call up the DeltaDeltaCt [¢| ddCt Quant. options menu command.

m  Select the desired calculation method.
For the Pfaffl method, the efficiency values can be determined automatically from
the standard curves (dilution series) for the gene of interest and the reference gene
(if standards have been defined) or the values can be entered manually in the
respective fields.
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ddCt Options window for presetting the analysis of the AACt method

5.4.6 Displaying the validation curves and values
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To calculate the AACt values there is no need to determine a validation curve. However,
it might be useful to consult it when checking the data quality.Prerequisite for creating a
validation curve is measuring a standard series with different dilution levels of target
gene and reference gene. If standard series have been measured for the target and
reference gene, the expression ratio between target and reference gene is represented
graphically in the Validation curve display. For this purpose, the mean Ct value of the
target gene is subtracted from the mean Ct value of the reference gene for the
corresponding dilution level and the resulting dCt(V) value is plotted against the
logarithm of the concentration.

In the value range on the right the following calculated data is displayed:
= The coefficient of determination R?

®  The gradient of the validation straight line

= the intersection of the curve with the y-axis at x=0 (offset)

The gradient of the curve should not exceed a value of + 0.1. The assumption then
applies that the efficiencies of the amplification of the gene of interest and the reference
gene are almost identical and the calculation of the AACt values produces valid data.
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Fal-GAPDH m
1,27 u Rz 0,21318
- 1,14
T \ Slope -0,05
=] B [
= 0,5 | Offset 0,91
]
0,8 T T T T T

Log Std. Conc.

Table | Standard curve |Validation

Validation curves view for the AACt method

You can switch between the AACt calculation views using the Table, Standard curve and
Validation tabs. The validation curves and the values are automatically calculated by the
gPCRsoft software and updated if the settings change. For both, validation curves as
well as standard curves the respective data points errors bar are shown that indicate the
standard deviation between replicates. For each data point some short information
about the sample name and the mean Ct value of replicates is shown if the mouse
pointer is placed on it.

When more than one standard curve is displayed each curve has its individual color.
Accordingly each table has a color code in the header that reflects the assignment to the
respective standard curve.

Fabtc-mye m |FAM-GAPDH = |
R2 0,99997 0,99919
o 2T Slope 3,65 3,71
a
20 - OFfset 16,38 17,29
; ; | | ; PR Efficiency |0,58 0,86
3 25 2 -15 -1 @5 0
Log Std. Conc.
Table |Standard curve | Validation |
Validation curves view for the AACt method
Well B I |Sam|:n|e name ISampIe bype IGOI |Reference. . |CEGOL ICt R;I
Al sal Unknowan -y 23,16
az sal Unknown C-MYEC 25,08
a3 sal Unknown GAPDH 18,0
i sal Unknown GAPDH 20,1
a5 saz Unknown C-myc 29,36
LT3 532 Unknowan c-rye 31,44 -
4 I | »

"| rable [ Standard curve | validation |
Result table view for the AACt method

For the AACt-quantification the results table contains the following information:

Column Meaning
Well Position of sample*
Color of curve Each sample is automatically assigned an unchangeable color which is

used to display the corresponding fluorescence curve

Sample name Name of sample*
Sample type Type of sample*
Group Assignment of the sample to an experimental group*
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Display in the project
explorer

5.4.7
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GOl

Gene of interest

Reference gene

Reference gene

Ct GOl Ct value of gene of interest

Ct Ref.gene Ct value of reference gene

Mean Ct GOI Mean Ct value of replicates of the gene of interest
Mean Ct Mean Ct value of replicates of the reference gene
Ref.gene

Std.Dev. Ct GOI

Standard deviation of the Ct values between replicates of the gene of
interest

Std.Dev. Ct Standard deviation of the Ct values between replicates of the reference

Ref.gene gene

%CV Ct GOI Variation coefficient of the Ct values between replicates of the gene of
interest

%CV Ct Variation coefficient of the Ct values between replicates of the reference

Ref.gene gene

dCt GOI Delta Ct value for replicates of the gene of interest

dCt Ref.gene Delta Ct value for replicates of the reference gene

RQ GOI Calculated relative amount for replicates of the gene of interest in the
original sample

RQ Ref.gene Calculated relative amount for replicates of the reference gene in the
original sample

Mean RQ Average calculated relative amount for replicates of the reference gene in

Ref.gene the original sample

Norm. Standardized relative (x-fold) expression level of the gene of interest in

Expression the sample in relation to the calibrator

A shortened representation of the validation curves calculated by the software is
displayed in the project explorer under DeltaDeltaCt. The image displays the graphical
plot of the dCt(V) values against the logarithm of the sample concentration:

% ddCt quantification

dct(v)

Log 3td. Conc.

Representation of the validation curves in the project explorer

Deleting a AACt method evaluation

An evaluation that is no longer required can be removed.

1. Activate the evaluation by selecting its description in the evaluation list of the

method tab.
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ddCt
2. Click on the E= symbol in the toolbar.
Optionally, call up the DeltaDeltaCt » Delete ddCt quantification

3. menu command.

The evaluation is removed.

5.5  Melting curve analysis

When performing a melting curve analysis the temperature in the reaction mixture is
increased successively until the PCR product is denatured. The dissociation of the
fragment in single strands will result in the release of a intercalating dye. The associated
reduction of the fluorescence intensity is measured and recorded by the device. By
forming the first derivative of the fluorescence curve you will get a peak that describes
the melting point and the approximate concentration of the PCR fragment. By means of
melting curve analysis you can differentiate whether the reaction has caused the
formation of a specific PCR product or whether unspecific by-products, such as
primerdimers, were produced.

5.5.1 C(Creating a new melting curve analysis

1. Go to the Analysis » Melt. curve project tab.
If the tab is not visible, click on the arrows 4 P in the tab bar. This will scroll the
tabs.

Y
3 Al .
2. Click on the " 7 symbol in the toolbar.
Optionally, call up the Melting curve » Add melting curvemenu command.

3. Aninput window appears. Enter the description for the current evaluation.
On the MeltCurve tab the following information is activated:
= Parameter settings (1)

m  Display of the fluorescence values as a function of the temperature and/or its first
derivative (2)

® Display of the result table (3)
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5.5.2
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Window for melting curve analysis

Parameter settings for melting curve analysis

[ abs. Quant. ]/% Rel. Quant. ]/“%’ DeltaDeltaCt j/’_: Melt. curve 1 b
Melting curve: Melt Temperatures1 -

Gene of Interest (GOL): Group; Threshold:
Gap: - 4 0

Parameter settings for melting curve quantification

Set the following parameters for the meltings curve quantification:

Option Description

Selection list Selection of a selection created for the experiment
Gene of interest Selection list of target gene/ dye combinations
(Gor)

Generally, an intercalating dye must be selected for the target gene for
the melting curve analysis.

According to the selection, the fluorescence and regression curves for the
concentration are displayed.

Group If several experiments were carried out on the PCR plate, select the group
of the experiment to be analyzed. (— section"Defining groups” p. 50).




Setting the threshold
value

Fix Threshold

Evaluation

Threshold Manually adjust threshold values
The threshold is now effective on the Derivative tab. Only curves whose
maximum dRn/dT is greater than the threshold are analyzed.

Note:
The threshold value can be calculated automatically or set manually in
the chart (see also "Setting the threshold value" below).

ﬂ Opens the selection window with display options

For the correct evaluation a threshold value must be determined for the melting curves.
You have several options for setting the threshold value:

= |n the general options (— section "Making basic settings" p. 66)

= Manually in the parameters for the respective evaluation (see table above)

®  Graphically in the representation of the fluorescence curves derivative:
In the chartDerivative, move the black threshold line up or down with the cursor.
Press and hold the left mouse button while doing so. At the same time, the Tm
values in the result table are updated.

= Automatic calculation:

The automatic calculation of the threshold value is activated by clicking on the IT:—'
symbol.
Optionally, you can call up the Melting curve / Autom. Threshold menu command.

Whether you choose manual or automatic calculation, the resulting threshold value is
updated and displayed synchronously in the corresponding Threshold iput field.

The threshold value becomes recalculated by the software each time basic settings for
the analysis are changed. For the analysis the option Fix Threshold can be used, so that
the threshold value is retained if the basic settings for the analysis are changed (—
section "Making basic settings' p. 66).

5.5.3 Displaying fluorescence curves/melting curves

In the display area, the measured fluorescence curves are shown in relation to the
temperature and are either standardized to the highest fluorescence value or both
standardized to a target value of 100, depending on the settings made in the Melt.
Curve Options window. The data is displayed as a linear or logarithmic representation
depending on the selected display option.
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Display options for melting curve analysis

The program shows brief information on the sample if the cursor is placed on one of the
curves.

The melting temperature Tm is determined by forming the first derivative of the melting
curves from the maxima of the forming peaks. To evaluate fluorescence data from
protein stability measurements, the melting curves can be reversed. The reversal of the
melting curves can be activated via the flip curve option.

ddrn/dT

Temp. (°C)

View of the melting curves derivative with threshold line

You can switch between the melting curves display and the derivatives via the tab in the
bottom left corner of the display range.

1. Click on the i button in the parameter bar.
A selection window for the display options opens.
2. Select the Scaling logarithmic or linear option.

Click next to the selection window. The changes are applied.
The Derivative tab cannot be displayed logarithmically.
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dRn

&0 &5 70 75 a0 g5 a0 95

Temp. {°C)

Fluorescence curves display (linear view)

The linear display does not show a threshold line.

5.5.4 Display of melting temperatures

5,55

After selecting the tab Tm the display changes to a presentation of the results as bar
chart. The respective sample name is given below each bar. The height of the bar is
determined by the measured melting temperature of replicates. For each bar some short
information about the position of the samples, the mean value and the calculated
standard deviation is shown if the mouse pointer is placed on it. The size of the standard
deviation is shown as error bar on top of each bar. Since for large numbers of samples
not all bars can be displayed in the screen the diagram can be moved horizontally with
pressed left mouse button and dragged to the desired position.
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Bar chart for display of melting curves

Displaying the result table for the melting curves

The result table for melting curves contains all data and the associated measurement
values for the samples.
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Wiyell @ I Sample name  |Sample type Gene Tm Mean Tm |Sta:ﬂ

Bz 100 Standard 34,2 84,27 0,0

D2 . 1 Standard 34,3 84,3 0,14

Fz .D,Dl Standard 83,7 83,79 0,08

B3 B :oo Standard 34,3 84,27 0,05

c3 . 10 Standard 34,3 84,3 o

D3 N Standard 84,4 84,3 u,_14|;|

BT »
Table

Result table for melting curve analysis

For melting curves the results table contains the following information:

Column Meaning

Well Position of sample

Color of Each sample is automatically assigned an unchangeable color which is used to
curve display the corresponding fluorescence curve

Sample Name of sample

name

Sample type  Type of sample

Group Assignment of the sample to an experimental group

Gene Name of gene measured in the sample

Tm Melting temperature of the sample

Mean Tm Mean melting temperature of replicates

Stabw. Standardabweichung der durchschnittlichen Schmelztemperatur von

Mittl. Tm Replikaten
Display in the project A shortened representation of the melting curves calculated by the software is displayed
explorer in the project explorer under "Melt Curve". This representation shows the graphical plot

of the first derivative of the fluorescence values against the temperature.

B& Melting curve =

ddRn/dT

60 65 YO 75 B0 8% 90

Temp. {°C)

Representation of the melting curve derivatives in the project explorer

5.5.6 Deleting a melting curve analysis

A melting curve analysis that is no longer required can be removed.
1. Activate the evaluation by selecting its description in the evaluation list of the
method tab.

=
2. Click on the L_=! symbol in the toolbar.
Alternatively, call up the Melting curve » Delete melting curve menu command.

The evaluation is removed.
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Genotyping serves to determine sequence differences between a sample and a standard.
The standard is defined as the reference sequence (genotype 1); the genetic condition
of the sample is to be determined in the experiment. Genotyping shows which alleles an
individual has inherited from its parents.

5.6.1 Creating a new evaluation for genotyping

1.

3.

Go to the Analysis / Genotyping project tab.
If the tab is not visible, click on the arrows 4 ¥ in the tab bar. This will scroll the

tabs.
Click on the & symbol in the toolbar.
Alternatively, call up the Genotyping / Add genotyping menu command.

Enter the description for the current evaluation in the input window.

The following information is activated on the Genotyping tab:

Parameter setting for defining the threshold and selecting the dye with which the
wild type and the mutant were measured (1)

Display of the fluorescence curves of wild type and mutantand/or display of the
results as a scatter plot or bar graph

Display of the result table with the results (3)
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Genotyping window

Parameter settings for genotyping

Genotypel: Group: Threshold:
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Genotype2: | ]

ROX -

Parameter settings for genotyping for the fluorescence curve display

Set the following parameters for the absolute quantification:

Option Description

Selection list Selection of an evaluation created for the experiment

Genotype 1 Selection list for the dye with which the genotype 1 was measured.
Genotype 2 Selection list for the dye with which the genotype 2 was measured.
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Fix Threshold
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Include passive Only active if a dye has been defined as a passive reference on the
reference Settings / Scan project tab.

If this option is activated, the fluorescence of the dye that has been set as
a passive reference is used for standardization.

Group If several experiments were carried out on the PCR plate, select the group

of the experiment to be analyzed (— section "Defining groups' p. 50).

Threshold Manually adjust threshold value.

The threshold value must be between 1 and 100, depending on the
standardized representation of the fluorescence curves (dRn).

Note

The threshold value can be calculated automatically or set manually in the
chart (— see also "Setting the threshold value" below).

¥ Opens the selection window with display options (— section "Displaying

the fluorescence curves for absolute quantification"S. 73).

When changing to the scatter plot or end point bar graph, two fields are displayed for
the CutOff value for the Genotype 1 and the Genotype 2 instead of the Threshold field:

Genotypel: Group: CutOff Genotypel:
Indude passive reference Group 1 v 36,019
Genotype2: | | CutOff Genotype2:

Parameter settings for the scatter plot and the bar graph of a genotyping

To determine Ct values for the evaluation a threshold value must be determined for
each experiment.

You have several options for setting the threshold value:

In the general options (— section "Making basic settings" p. 66)
Manually in the parameters for the respective evaluation (see table above)

Graphically in the fluorescence curves representation:

In the chart, move the black threshold line up or down with the cursor. Press and
hold the left mouse button while doing so. At the same time, the Ct values in the
result table are updated.

Note:

The logarithmic view is more suitable for placing the threshold manually in the
display area than the linear view because of the wider spread of the early
exponential area of the product accumulation curves.

By having it calculated automatically:

To activate the automatic calculation of the threshold value, click on the =l symbol.
Alternatively, you can call up the Genotyping / Autom. threshold menu command.

Whether you choose manual or automatic calculation, the resulting threshold value is
updated and displayed synchronously in the Threshold input field.

The threshold value becomes recalculated by the software each time basic settings for
the analysis are changed. For the analysis the option Fix Threshold can be used, so that
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the threshold value is retained if the basic settings for the analysis are changed (—
section "Making basic settings' p. 66).

5.6.3 Specifying genotyping options
Special evaluation options are available for genotyping.

N
= Clickon “™ in the toolbar to open the Genotyping Options window.

Alternatively, you can call up the Genotyping / Genotyping Options menu

command.
Genotyping options ﬁ
Smoothing Scaling Cycle ofinterest
~ none @) linear ") Set to last cyde
@ |5 - |Points ~) lngarithmic @) Set to cyde 40 M
Baseline correction Descriptions
_ For all samples If genotypel: wild type
From cydle: To cyde:
3 = 15 = If genotype2: mutant
@) Sample specific If heterozygote: heterozygote
Crop first cycles:
5 5 otherwise: error
Auto threshold Scatter Plot
@) Standard deviation of base lines _! based on intensities dRn
_) Defined standards @) based on Ct - values
Filter
7 )
iy Cancel noise
Imedium VJ
[ Ok - Auto Threshold l [ 0Ok - Fix Threshold J I Cancel

GenoTyping Options window for genotyping settings

Option Description

Cycle of Select the cycle for evaluation. This can preferably be the last cycle (end point)

interest but also any other cycle of the PCR run. The respective cycle can be selected
from a list.

Name Input fields for own names for the genotypel, genotype 2, heterozygote

categories or otherwise

Scatter Generation of the scatter plot based on the fluorescence intensities of the
Plot analyzed cycle and/or the Ct values

5.6.4 Displaying the fluorescence curves, scatter plot and bar graph

The respective combination of genotype 1 dye or genotype 2 dye displayed is shown on
the tabs in the bottom left corner of the area. The entry for the respective active
combination on the tab is highlighted in white. The fluorescence data is displayed as a
linear or logarithmic representation depending on the selected display option. For both
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view types a brief information is shown as soon as the mouse pointer is positioned on
one of the curves.

1. Click on the 4 button in the parameter bar.
A selection window for the display options opens.
2. Select the Scaling logarithmic or linear option.

Click next to the selection window. The changes are applied.

100

734

dRn

30+

257

Cycle

Genotype 1-FAM | Genotype2-ROX | Scatter plot | End point

Linear representation of the fluorescence curve for genotyping

100

dRn

0,1 T T T T

Cycle

Genotype 1-FAM | Genotype2-ROX | Scatter plot | End point

+

Logarithmic representation of the fluorescence curve with horizontal threshold line

To determine Ct values for the analysis a threshold value must be determined for the
fluorescence curves. This can be automated but is also possible manually in the display
area (— section "Parameter settings for genotyping" p. 102).

In addition to the fluorescence curves representation, the results can also be displayed
as a scatter plot or bar graph. This can be selected via the respective tabs below the

display area.

105



106

Evaluation

wild type error
40 I OEm
w375
2
B 354
£
GIIJ 32,5
o
(5} 30 @)- - B
27,5 " .
]
25 —heterozygote mutant
T T T T T T T T T T T
30 31 32 33 34 35 35 3T 38 32 40 41 42
Ct-Genotypel

Genotype1-FAM | Genotype2-ROYK | Scatter plot | End point

Scatter plot for genotyping

The scatter plot is divided into four quadrants for genotypel, genotype 2, heterozygote
and error. The samples are assigned to one of the quadrants based on the measured
relative fluorescence or the Ct values of the two dyes. The respective cutoff value for the
sample assignment is represented by two black lines in the scatter plot view. To change
the position of the lines and thus change the cutoff value, select the lines and keep the
left mouse button pressed. Alternatively, the respective cutoff value for genotype 1 and
genotype 2 can also be entered in the respective fields in the selection area (—
"Parameter settings for genotyping" p. 102).

100 —

75

dRn

30

25

L R R RN RN RN R AR AR RA RN RN RN R R RARARA R RRIRAR NN AR RN AR AR A

A B iz D E F G H

Genotype 1-FAM | Genotype2-ROX | Scatter plot |End point

Bar chart for genotyping

The bar graph shows the measured relative fluorescences as bars. The x-axis is scaled
from A to H based on the rows of the block, i.e. the first twelve samples correspond to
positions Al to A12 in the block, the next twelve samples correspond to positions B1 to
B12 etc. The cutoff value is set by moving the red or blue horizontal line up or down
with the left mouse button pressed. Alternatively, the respective cutoff value for mutant
and wild type can also be entered in the respective fields in the selection area of this
view (— "Parameter settings for genotyping" p. 102).

The cutoff values are thresholds after which the question whether a sample shows a
reaction is answered with "Yes" (see Reaction genotype 1 and Reaction genotype 2
table columns).
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5.6.5 Display of the values for the genotyping evaluation

The result table for the genotyping combines all data and corresponding measurements
for the samples. The columns shown in the result table differ depending on the tab
selected in the display area. The table for the fluorescence curves provides a summary
which includes the measuring data of both dyes. If the fluorescence intensity at the end
point is evaluated, the result table for the scatter plot is the same as the one for the bar
graph. The data summarized in the result table for the fluorescence curves, however,
partly differ from the data in the scatter plot or bar graph evaluation.

el 0 I Sample name ISampIe by pe IGenDtyp IReactinn v IReactiDn v IGent - |
a4 H1 Unknowwn heterozygote  wes WES hiet

B4 . H1 Unknowwn heterozygote  wes WES hete

Z4 . Hz Unknowwn heterozygote  wes WES hete

04 . Hz Unknowwn heterozygote  wes WES hete

E4 . H3 Unknowwn heterozygote  wes WES hete

F4 . H3 Unknowwn heterozygote  wes WES hete

4 . M1 Unknowwn mukank no ves mu_t-ill
1 | | »

Results table for genotyping

For the genotyping the results table contains the following information:

Column Meaning
Well Position of sample*
Color of curve Each sample is automatically assigned an unchangeable color which is

used to display the corresponding fluorescence curve

Sample name Name of sample*

Sample type Type of sample*

Group Assignment of the sample to an experimental group™*

Ct Genotype 1 Ct value of genotype 1

Mean Ct Mean Ct value of replicates of the genotype 1

Genotype 1

Std.Dev. Ct Standard deviation of the Ct values between replicates of the genotype 1

Genotype 1

Ct Genotype 2 Ct value of genotype 2

Mean Ct Mean Ct value of replicates of the genotype 2

Genotype 2

Std.Dev. Ct Standard deviation of the Ct values between replicates of the genotype 2

Genotype 2

Genotype Assign the sample according to genotype 1, genotype 2, heterozygote or
error

Reaction Yes or no, depending on the end point fluorescence or Ct value

Genotype 1

Reaction Yes or no, depending on the end point fluorescence or Ct value

Genotype 2
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Display in the project
explorer

108

Genotype Assign replicates according to genotype 1, genotype 2, heterozygote or
Replicates error ("?" symbol)

dRn Genotype 1 Standardized fluorescence intensity of the genotype 1reaction

Mean dRn Standardized fluorescence intensity between replicates of the genotype
Genotype 1 1 reaction

Std.Dev. dRn Standard deviation of the standardized fluorescence intensity between
Genotype 1 replicates of the genotype lreaction

dRn Genotype 2 Standardized fluorescence intensity of the genotype 2reaction

Mean dRn Standardized fluorescence intensity between replicates of the genotype
Genotype 2 2reaction

Std.Dev. dRn Standard deviation of the standardized fluorescence intensity between
Genotype 2 replicates of the genotype 2reaction

Individual columns can be shown or hidden by selection or deselection. The layout of the
columns can also be freely modified. By dragging a column heading with the left mouse
button depressed columns can be swapped. The display of the results in the table can
thus be adjusted as desired.

Optional the scatter plot or the end-point analysis calculated by the software can be
displayed in short form in the project explorer under the point Genotyping. The scatter
plot is divided into for quadrants for mutant, heterozygous, wild-type and error. The
samples are assigned to a quadrant by the relative fluorescence or the Ct values
determined for both fluorescent dyes. For the end-point analysis the measured relative
fluorescence is plotted as bar chart. Die height of the bars defines the samples as
genotype 1, genotype 2, heterozygous or error.

i Genotyping =

40 oarm

30 -
2] W d
|

L L
IR HIEIFTHEINALR

Ct-Genstypel

Representation of results for genotyping as scatter plot.

Bl Genotyping =

100

dRn
(4]
(]

Representation of results for genotyping as bar chart.
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5.6.6 Deleting a genotyping

An evaluation that is no longer required can be removed.
1. Activate the evaluation by selecting its name in the evaluation list of the method tab.
-
2. Clickon M in the toolbar.
Alternatively, call up the Genotyping » Delete Genotyping menu command.

The evaluation is removed.

5.7 POS/NEG analysis at the end point

Positive / negative analysis at the end point of a qPCR is used to decide, whether or not
a target gene is present in the reaction mix. Such an analysis can be configured as
singleplex or multiplex experiment using fluorescence data at the end point of a PCR
run, i.e. after amplification is finished. The position of the end point — with respect to
the cycle number - as well as the cycles to be included can be set by you. Using the NTC
samples a cutoff value is calculated which discerns positive and negative for each
individual sample. The software also accounts for internal positive controls (IPC) which
can be added to each sample in order to avoid false negative results thus increasing the
confidence level of the experiment.

5.7.1 Starting end point analysis

1. Go to the Analysis / Endpoint project tab. If it is not visible, click on the arrows in
the tab bar. This will scroll the tabs.

g
2. Click the symbol EA in the toolbar. Alternatively you can select the menu ENDPOINT
/ ADD ENDPOINT.
3. Aninput window appears. Enter the description of the current evaluation.

Note:
An end point analysis can only be opened if the plate layout contains at least one NTC-
sample (— section "Editing the sample table" p. 39).

On the Endpoint tab the following information is activated:
m  Edit fields for parameter settings

= Amplification curves of the selected GOl and the internal positive control IPCin a
combined diagram.

= Amplification curves of the selected GOI and the internal positive control IPCin
separate diagrams which allow for setting the cutoff.

®  Display of results in a PCR plate scheme
®  Display of results in a bar chart

m  Results table with measurement data and classification of the unknown samples as
POS, NEG, ???, CHECK
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EEi Real time pcr project - Behelfs-Testprojekt Endpunkt.rEp - Dlll
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All| Go1 | 1PC | Grid | Bar Chart |
+ 4
T T
well m I Sample name ISampIe bype Group FluoGoT IMean Fluoﬂ
a4 H1 Unknawn Group 1 43694,45 41071,62
B4 H1 Unknown Group 1 35248, 79 41071,62
N [ unknown Group 1 3171467 34864, 64
D4 | [ Urknown Group 1 38014,61 34864, 64
E4 H3 Unknawn Group 1 26587,02 30696,55
F4 H3 Unknawn Group 1 34806,00 30696,55
G4 HTC HTC Group 1 -199,7 24,41 _|LI
4 I »

Window for end point anaylis

5.7.2 Parameters settings for endpoint analysis

Endpoint: [ N =

GOLL Group: CUkCFF;
[Far-Gor -] Groupl 7| J2484,081 |

IPC: ]
IROX—IPC - |
Parametersettings for endpoint analysis

1. Set the following parameters for endpoint analysis:

Option Meaning
Shortlist Selection of an evaluation created for this experiment
Gene of Interest (GOI) Selection list of the gene/dye combination of interest

Internal Positive Selection of the gene/dye combination which is used for IPC
Control (IPC)

Group If several experiments were carried out on the plate, select of
experiments to be analyzed.

Cutoff Cutoff defines the fluorescence value above which the sample is
considered to be positive

2. Define the cycle numbers which shall be considered as endpoint.
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By default the mean fluorescence of the last two cycles is taken for calculations. You
can define more than 2 cycles at the end or an interval of cycles of the gPCR run as
source of endpoint fluorescence data.

The selected cycles are highlighted in the chart by a yellowish bar.

nd Paink nd Poink

% last |2 _l; cycles " last |2 _|: cycles
= From cycle |39 _% to cyele |41 _% " from cycle I36 = toeyde Ibg =

Last 2 cycles are marked Cycle 36 to 39 are marced

Area selection for endpoint analysis

Cutoff-values for GOl and IPC can be set manually or calculated automatically. You can

o
select different methods for automatic calculation in the options dialogue tﬁ for
endpoint analysis.

Manual methods

= Enter a number for Cutoff directly in the edit field Cutoff or in the options dialogue
®  Shift the Cutoff line using the mouse in the tabs GOI and IPC

Automated methods

®  With negative control or NTC:
The Cutoff-value is calculated from the mean fluorescence of the NTC samples plus
the fraction (given in percent) from the difference between maximal sample
fluorescence and mean fluorescence of the NTC samples. Fluorescence data is taken
from the specified end point cycles.

® With internal positive control IPCand NTC:
Cutoff values for NTC and IPC are calculated separately. The standard deviation of
the fluorescence of all NTC samples (or IPC- samples, i.e. samples which do not
contain an internal positive control) is multiplied with a factor T which is read from a
table and is dependent from the desired confidence interval and the number of
samples.

®  You can start the automatic calculation of Cutoffs according to the settings in the
options by clicking EA . Alternatively you can choose the command ENDPOINT / AUTO
THRESHOLD CUTOFF from the menu.

Note:
If the plate layout does not contain samples which are labeled as IPC-, the option "with
internal positive control and NTC" will not be available. On the tab Settings / Samples
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selected wells can be labeled as IPC- by right clicking the highlighted wells and select
Assign IPC- from the context menu (— section "Editing the sample table" p. 39).

5.7.3 Displaying results in end point analysis

The results of the analysis (POS, NEG, ???, CHECK) are evaluated according to the
following rules:

Without IPC Fluoescence of a single GOl sample  Result
> Cutoff (GOI) POS (positive)
< Cutoff (GOI) NEG (negative)
With IPC Fluoescence of a single GOl sample  Fluoescence of a single IPC Result
sample
> Cutoff (GOI) > Cutoff (IPC) POS (positive)
< Cutoff (GOI) > Cutoff (IPC) NEG (negative)
> Cutoff (GOI) < Cutoff (IPC) 7?7 (problematic)
< Cutoff (GOI) < Cutoff (IPC) 7?7 (problematic)

Bewertung bei Replikaten ~ Samples which are present in replicates (having the same sample name) are considered
to be POS or NEG if all replicates of that sample are POS or NEG. If this is not the case
CHECK will be displayed. It is possible to manually deselect samples in the project
explorer which are recognized as outliers.

Fluoescence of replicates  Result of sample

all POS POS (positive)
all NEG NEG (negative)
otherwise CHECK (eliminate outliers or repeat sample)

After creation of a new analysis or after having changed options or cutoff values the
results are re-calculated and charts and table will be refreshed.

Results table

wel m| [samplename  [sample type Group FluoGOI Mean FluoGOL  [std.Dev. FluoGol _ [FluolPC Mean FluolPC Std.Dev. FluoIPC [Status GOI [statusIPC_ [Resultsa...  [Result replicates
a4 im Urknown Group 1 43994,45 41071,62 3992,08 17019,34 15944,53 1519,44 FOS FOS FOS ROS
B4 HL Urknown Group 1 38248,79 41071,62 3992,08 14670,52 15944,53 1519,44 oS oS POS POS
[ | [ Urknown Group 1 31714,67 34864,64 4454,74 12612,05 13328,08 723,78 POS POS FOS POS
o4 | B3 Urknown Group 1 38014,61 34864,64 4454,74 13844,11 1332808 723,78 POS POS POS POS
E4 H3 Urknown Group 1 26587,02 30696,55 S811,76 15718,75 14758,92 1357,41 FOS POS FOS ROS
F4 H3 Urknown Group 1 34806,09 30696,55 5611,76 13799,08 14758,92 1357,41 oS oS POS POS
G4 NTC NTC Group 1 -199,7 24,41 247,89 15239,33 16507,35 1794,1 HEG FOS HEG MNEG
H4 TC TC Group 1 150,88 24,41 247,89 17776,58 16507,95 1794,1 HEG POS HEG NEG
a7 w1 Urknown; IPC- Group 1 55748,83 s0011,56 8113,73 238,58 213,27 35,8 POS HEG

B7 w1 Uriknown; [RC- Group 1 44274,29 50011,56 8113,73 -187,95 213,27 35,8 FOS HEG

c7 wrz Urknown; [RC- Group 1 36536,65 39368, 36 4032,65 246,75 -149,26 137,84 oS HEG

o7 | [GA Uriknown; IFC- Group 1 42239,67 39368,36 4032,65 51,81 -149,26 137,84 FOS HEG

F7 Mz Urknown Group 1 346,38 -411,01 91,4 15201,38 15105,65 135,33 HEG POS HEG NEG
G7 | 2 Urknown Group 1 475,65 -411,01 91,4 15009,51 151085,65 135,33 HEG POS HEG NEG
H7 3 Urknown Group 1 85,52 85,52 ] 17320,61 17320,61 o HEG POS HEG NEG

Result table of endpoint analysis

For the end point the results table contains the following information:
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Column
Well

Color of curve

Sample name
Sample type
FluoGOI
Mean FluoGOI

Std.Dev.
FluoGOI

FluolPC
Mean FluolPC
Std.Dev.FluolPC

Status GOI
Status IPC
Result sample

Result replicates

Evaluation

Meaning
Position of sample

Each sample is automatically assigned an unchangeable color which is
used to display the corresponding fluorescence curve

Name of sample
Type of sample*
Fluorescence of the GOl samples at the endpoint

Mean fluorescence of the GOl replicates at the endpoint

Standard deviation of the GOI replicates at the endpoint

Fluorescence of the IPC samples at the endpoint

Mean fluorescence of the IPC replicates at the endpoint
Standard deviation of the IPC replicates at the endpoint
POS if FLu0GOI > CuTOFF, else NEG (for each sample well)
POS if FLuolPC > CuTOFF, else NEG (for each sample well)
Rating POS/NEG/??? for each well

Rating POS/NEG/CHECK of the replicates

The results table displays all calculated numerical data and the evaluation of single
samples and replicates. You can design the results table according to your requirements
by setting type, sequence and width of the columns to be displayed. You can also adjust
the sort sequence of data in the column (alphabetical, numerical, by column, by row).
The table configured this way can be exported as Excel or CSV file by right clicking the

table.

Save table as Excel-File (*, xls)
Save table as Excel-File (*.x1s) and run Excel

Save table as CSY-File (*,csv)

Context menu for data export
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Results of endpoint analysis on the plate scheme

For gTOWER? 84, the columns from 1 to 24 and rows from A to P are available using
the scroll bars.

The PCR plate scheme offers a quick overview of the results obtained in each single well.
If the mouse pointer is moved across a well a hint box is displayed showing the sample
name and the end point fluorescence of GOI and IPC for that well. You can change the
colors which code for POS, NEG and 7?7 in EXTRAS / OPTIONS / COLORS.

s_;;i Settings ]/\__ Manitoring J/ﬁf Analysis I/D Documentation ] 4 I
T Melting curve ]/3"“ Genotyping J/E Endpoint] 4 B

erdpors B - I
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A B C D E F 6} H

&l Go1| IPC | Grid |Bar Chart
L

Bar graph of endpoint analysis results

The bar chart displays the end point fluorescence of the GOI together with the IPC as
well as the corresponding cutoff values as horizontal lines. Red lines denote the GOI and
blue ones the IPC. If the mouse pointer is moved across a bar a hint box is displayed
showing the sample name and the end point fluorescence of GOl and IPC for the
corresponding well.
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Note:
Cutoff lines can not be changed in the bar chart. To do so, please switch to the tabs GOI
or IPC.
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6  Multigene-/Multiplate-Analysis

The Multigene-/Multiplate-Analysis is used to analyze real-time PCR data of multiple
target genes in parallel or to analyze data from multiple project files if, for example,
several PCR plates have been used for an experiment. The Multigene-/Multiplate-
Analysis is executed as dialog in a separate window independend of the surface of the
gPCRsoft software. For the Multigene-/Multiplate-Analysis project files generated by
the qPCRsoft software are used. The project files must include a AACt-analysis for
Multigene-/Multiplate-Analysis.

6.1  Start Multigene-/Multiplate-Analysis

To start the Multigene-/Multiplate-Analysis click on the button M in the toolbar. A
new window for Multigene-/Multiplate-Analysis appears.

6.2 The window for Multigene-/Multiplate-Analysis

After starting the dialog the window for Multigene-/Multiplate-Analysis opens. It is
devided into the following sections:

Menu bar The menu bar contains the menu commands for, e.g., opening, editing, saving

(1) and printing of Multigene-/Multiplate-Analysis files and a help function.
Toolbar In the toolbar commands for editing Multigene-/Multiplate-Analysis files are
(2) arranged.

Project list  In the project list projects that are used for Multigene-/Multiplate-Analysis are
(3) listed and administrated.

Samples In the layout the measurement data of samples can be selected or unselected.
(4) Only data of selected samples becomes included to the analysis and is used for

the results calculation. Furthermore in the layout the position of interplate
standards (IPS) can be defined.

Data In the data display amplification curves of imported project files are shown or
display the results of the Multigene-/Multiplate-Analysis are plotted as bar chart.

(5)

Results In the results table the imported measurement data of the activated project file

table (6) or the results of the Multigene-/Multiplate-Analysis are shown.
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Windows Multi gene for Multigene-/Multiplate analysis

6.3

Overview of menu

commands

In the Multigene-/Multiplate-Analysis window the following menu commands are

available:
Menu  Function Description
File New Multigene-/Multiplate- Opens a new Multigene-/Multiplate-Analysis

Analysis

Open Multigene-/Multiplate-
Analysis

Opens a Multigene-/Multiplate-Analysis.

Save Multigene-/Multiplate-
Analysis

Saves a Multigene-/Multiplate-Analysis in the
gPCRsoft standard folder

Save Multigene-/Multiplate-
Analysis as

Saves a Multigene-/Multiplate-Analysis in any
user-selected folder

Print Multigene-/Multiplate-
Analysis

Prints the results of a Multigene-/Multiplate-
Analysis

Close

Closes the window for Multigene-/Multiplate-
Analysis
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6.4 Overview of the tools in the toolbar

Button Command  Function

B NEw Opens a new Multigene-/Multiplate-Analysis

= _  Open Opens a Multigene-/Multiplate-Analysis

H Save Saves a Multigene-/Multiplate-Analysis

L]
= Print Prints a Multigene-/Multiplate-Analysis
4@3 Options Allows the input of efficiencies of PCR reactions for single genes of
- interest

6.5 Help function

You can get help on the operation of the Multigene-/Multiplate-Analysis via the menu
command Help » Content.

While working with the Multigene-/Multiplate-Analysis, you can activate the help
function by pressing function key [F1].

The program pops up brief information (tool tips) on buttons of toolbar while you move
the mouse pointer across the button.

6.6  Managing Multigene-/Multiplate-Analysis files

After clicking on m the Multigene-/Multiplate-Analysis dialog starts in a separate
window and contains no data.

6.6.1 Start new Multigene-/Multiplate-Analysis

To start a new Multigene-/Multiplate-Analysis press on — orcall up the File » New
menu command. An already loaded Multigene-/Multiplate-Analysis will be closed. If the
analysis has been modified and the changes are not yet saved, a prompt opens.

Note:
Only one Multigene-/Multiplate-Analysis can be opened.

6.6.2 Open saved Multigene-/Multiplate-Analysis

% -
1. Clickon or call up the File » Open Multigene-/Multiplate-Analysis menu

command.

2. Inthe standard window, select the desired file to open and confirm the selection
with [OK].
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Note:

If the file type is linked to the qPCRsoft application in Extras » Options the dialog for
Multigene-/Multiplate-Analysis starts automatically by a double click on the selected
file.

The Multigene-/Multiplate-Analysis including the project list, sample layout,
measurement data and analysis opens.

6.6.3 Save Multigene-/Multiplate-Analysis

The Multigene-/Multiplate-Analysis including all loaded project files and analysis is
stored.

1. Select the menu command File » Save Multigene-/Multiplate-Analysis.

2. To save files enter the name of the template in the standard window and save the
template with [OK].

Changes in a Multigene-/Multiplate-Analysis can be saved with the File » Save
Multigene-/Multiplate-Analysis menu command. Optionally, you can click on the

symbol H in the toolbar.

6.6.4 Close Multigene-/Multiplate-Analysis

The File » Close Multigene-/Multiplate-Analysis menu command closes the
Multigene-/Multiplate-Analysis window. If any unsaved changes have been made in
analysis, a confirmation prompt appears.

6.6.5 Print Multigene-/Multiplate-Analysis

The data and results of a Multigene-/Multiplate-Analysis can be printed using the Print
function. For this purpose, an analysis must be applied and in the data display the tab
Analysis must be selected (— section "The window for Multigene-/Multiplate-Analysis"
p. 116). By using the command File » Print Multigene-/Multiplate-Analysis or the icon

= in the toolbar the print function is started.

6.7 Load Project Files

If a new Multigene-/Multiplate-Analysis is started, at first a blank window is displayed.
To perform an analysis project files have to be loaded. In the project files a AACt-analysis
must be applied to evaluate them by Multigene-/Multiplate-Analysis.

1. To load a project file click on the button [Add project].

2. Inthe standard window select one or more stored project files and confirm your
selection with [OK]. Loaded projects are listed in the project list.
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6.8

6.9

120

Add project E Remove project

[#i| multidata3 3.rh
& multidata1_1.rtp
¥ multidataz_2.rip

Projekt list for Multigene-/Multiplate-Analysis
1. Toremove a project file mark the File in the project list.

2. Click on button [Remove project].

Activate/Deactivate project files for Multigene-/Multiplate-Analysis

In the project list, a check box is show next to each loaded project. By the check box
projects can be activated or deactivated. Only data from activated projects is used for
analysis.

Add project E Remove project

¥ multidata3_3.rip
multidaizl Lrip

¥ multidata?_2.rip

Projekt list for Multigene-/Multiplate-Analysis with activated/deactivated samples

The data of deactivated project files remain loaded in the background and after re-
activation are used for analysis again.

Activate/Deactivate samples for Multigene-/Multiplate-Analysis

In the data display for Multigene-/Multiplate-Analysis activate the tab Projects (—
section "The window for Multigene-/Multiplate-Analysis' p. 116). On the tab Activate
samples of the data display samples of single wells can be activated or deactivated for
analysis. By deactivation of samples outliers are eliminated and not included in the
calculation of mean values.

Note:
The sample selection has only influence on the analysis of data, no measurement data is

deleted.

HOPeOGOGO
@:-00000¢

" | Activate samples [ Assign IPS |

Sample layout for Multigene-/Maultiplate-Analysis
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The sample layout is taken from the loaded project files. The color code for each sample
type can be modified in menu EXTRAS 7/ OPTIONS » COLORS.

Sample type Symbol  Definition
Empty E Describes an empty position on the PCR plate
Unknown u Sample of unknown concentration or dilution

(measuring sample)

Stnadard S Sample of known concentration or dilution

Calibrator K Sample whose gene of interest expression level is set as
1

No Template Control N Complete reaction preparation but without matrix

(NTC) strand

Positive Control + Positive control preparation for which a reaction

product is expected

Negative control - Negative control preparation for which no reaction
product is expected

Active wells (i.e. displayed wells) are marked with their sample type symbol. For
deactivated wells the position is grey and the fluorescence data is hidden. Empty wells
are marked "E".

®  (lick with the mouse to switch. The activation changes with each click on a well.

®  You can change adjacent wells by holding the mouse button and moving the cursor
over the wells. To select non-adjacent positions press the Ctrl key on the keyboard
plus the left mouse button at each position.

= Complete rows and columns can be inverted by clicking on the letter or number of
the row [A-H] or column [1-12].

®  The activation status of the complete plate can be inverted by clicking on '®on the
top left between A and 1.

®  To activate all wells click on the symbol @ below the chart.

®  To activate only samples of a specific type click on the corresponding symbol below
the chart. To activate multiple sample types at the same time keep the Ctrl key
pressed when clicking on the sample types.

6.10 Define Interplate-Standards for Multigene-/Multiplate-Analysis

Activate the tab Projects in the data display for Multigene-/Multiplate-Analysis (—
section "The window for Multigene-/Multiplate-Analysis" p. 116). For the Multigene-
/Multiplate-Analysis Interplate-Standards (IPS) are used on each PCR plate and the
deviations among themselves are determined and calculated.

1. To define Interplate-Standards activate the tab Assign IPS in the sample display.
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[ DeleteIPS  [7]1PS on identical positions

@113455?59151111

elelelelelelelelelelele)

X

el 1 1 el 1 )
elel L L lelele)
clelelelelelele,

@:00000¢

QOO
olol 1 T J

Activate samples |.ﬁ.ssign IPS |
Defining IPS
2. Select the position of Interplate-Standards:

®  Press the left mouse button and drag the area that contains the IPS samples:
Selected samples are displayed in grey against a green background. For not
selected samples only the sample type icon is displayed. Empty wells are marked
with "E". To select samples see also section "Activate/Deactivate samples for
Multigene-/Multiplate-Analysis" p. 120.

= [fthe IPS position is the same on all plates the current selection is transferred to
all loaded projects by activating the checkbox [IPS on identical positions].

®  (lick on the button [Delete IPS] to delete the IPS in all loaded projects.

6.11 Set threshold and PCR-efficiencies for Multigene-/Multiplate-Analysis

After loading project files the measurement data for the active project is shown in the
display area. The active project is marked blue in the project list on the left. By clicking
on the name in the project list another project can be activated and thus switched
between different projects.
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[55] Multi gene - MGA_multiplex_3plates.mga E‘ﬂg
File Help
D2 - | & @
e | ety | T
Add project E Remave project
[ B Ceome |
R
[ multidatal_lrtp Dye: Group: Threshold:

100

75

c
% a0+
25
1]
T T T T T T T T T
5 10 15 20 25 30 35 40 45
Cycle
@: 234567 85 wnn Chart
1 000000000000 .
8
c 8888:::855%8 wel [ [sample name ¥ [sample type  [Group Gene ct Mean Ct 5td.Dev. Ct -
o @ @ . . . @ . . . @@ @ D3 E6-3 Standard Gruppe 1 Tubulin 10,02 9,67 0,3 D
£ @ @ . . . @ . . . ®© @ D4 . E6-3 Standard Gruppe 1 Tubulin 9,67 9,67 0,3
e @@...@...@@@ D5 .EG*S Standard Gruppe 1 Tubulin 9,31 9,67 0,36
s D7 . E5-3 Standard Gruppe 1 Tubulin 13,41 13,59 0,27
@ @ . . . @ @ @ @ @ @ @ D8 . E5-3 Standard Gruppe 1 Tubulin 13,9 13,59 0,27
" ©©©©©©®©®®©® D3 .ES-S Standard Gruppe 1 Tubulin 13,46 13,59 0,27
@ E ' . . . . - E3 - E4-3 Standard Gruppe 1 Tubulin 17,17 17,33 0,21 S
Activate samples | Assign IPS | M

For the active project the fluorescence curves and results are shown under the tab "Projects"

From the loaded projects all measurement results and settings are taken. In the dialog
for Multigene-/Multiplate-Analysis most settings cannot be modified, this is only
possible in the individual projects in the gPCRsoft software.

Edit threshold On the tab Projects the threshold for each dye can be adapted.
1. Activate the relevant project in the project list.

2. Select a dye from the list on the tab Projects.

Dye:
FAM -

HEX
TexasFed
Cys

Select list for dyes

3. Ifin the project file different groups are defined select the right group from the list.

Group:
Gruppe 1 hd

Select list for groups
4. To modify the threshold value two different options are available:

®  |n the chart, move the black threshold line up or down with the cursor. Press and
hold the left mouse button while doing so.

m  Enter a value in the field Threshold.
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With the modification of the threshold the values in the result table displayed below are
updated.

Basically, PCR efficiencies are taken from the loaded project files but it is possible to set
adjust the value for the considered genes.

1. Activate the tab Analysis in the data display and click the button 4‘23 in the toolbar.

2. Adjust for each gene the PCR efficiency in the window Options.

Options ﬁ
Genes Efficency
FAM-Tubulin
HEX-Actin 1
TexasRed-IL1b 1
Cy5-GAPDH 1

[ Ok H Cancel J

Window Options for editing of PCR efficiency

3. Enter a new value and confirm with [OK].

6.12 Evaluation of the Multigene-/Multiplate-Analysis
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The results of the Multigene-/Multiplate-Analysis are summarized under the tab
Analysis of the data display.
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multidata3_3.rtp IL1b-TexasRed sh 3 37 36,8 0,18 5,02E-5 6,42E-6 &,00E-6 7,76E-7 [
multidata3_3.rty [GAPDH-CyS]  E2-3 3 22,96 23,97 0,51 0,04 0,01
multidata3_3.rty [GAPDH-CyS] ES-3 3 12,42 13,43 0,44 60,29 18,49 @
multidata3_3.rty [Actin-HEX]  6h 3 22,69 21,72 0,05 8,35 0,32
multidata3_3.rip [ActinHEX]  E2-3 3 25,88 24,91 0,3 0,91 0,19
multidata3_3.rty [Actin-HEX]  ES-3 3 15,12 14,15 0,51 1583,23 560,54 -
<« [ 3
—[‘rabele IPS

Results of the Multigene-/Multiplate-Analysis

Parameter settings for
Multigene-/Multiplate-
Analysis

The data display is divided into the following sections:

Parameter settings (1)

= Graphical data display (2)

Genes of interest:
TexasRed-IL 1b;FAM-Tubulin

Reference genes:
HEX-Actin; Cy 5-GAFDH

Results table with measured values (3)

Scaling ¥:

Inter plate calibration

Parameter settings for Multigene-/Multiplate-Analysis

Option Description
Genes of Selection list of target gene/dye-combinations. Multiple target genes can be
Interest selected.
GOl . .
(Gon The symbol @ is used to remove all target genes from the evaluation
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*Correction calculation

Results display for
Multigene-/Multiplate-
Analysis
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Reference Selection list of reference gene/dye-combinations. Multiple reference genes
genes can be selected.

The symbol @ is used to remove all reference genes from the evaluation.

Scaling Y Selection of the scaling of the Y-axis.
Interplate With activated interplate calibration from the selected IPS samples of all
calibration plates a correction factor is determined* and from the mean Ct values of

replicates the corrected mean Ct values are calculated (see results table). The
corrected mean Ct values are then used to calculate the relative quantity and
the normalized expression. Is the interplate calibration deactivated, the
corrected mean ct values are equal to the mean ct values.

CtEZTT — Ct{[);.)eas _ agpc + % Zg=1 Ct;,PC

with

Ctiy"" — corrected Ct — value for replicate i on plate p
Ct]y® - measured Ct — value for replicate i on plate p

EQPC — mean value of Ct — values of IPS — samples on plate p

S h=1Ct;’¢ — mean value of Ct — values of all IPS — samples on all N plates

The results of the Multigene-/Multiplate-Analysis are shown as bar charts. In the tab
Normalized Expression the expression of selected genes of interest, normalized to the
expression of the reference genes, is shown. In the second tab Relative Quantity the
corresponding quantity for the genes of interest and reference genes is displayed. The
respective sample name is given below each bar. The height of the bar is determined by
the calculated normalized expression of replicates. For each bar some short information
about the sample name, mean value and the calculated standard deviation is shown if
the mouse pointer is placed on it. The standard deviation for the normalized expression
is shown as error bar on top of each bar. Since for larger numbers of samples not all can
be displayed in the screen the diagram can be moved horizontally with pressed left
mouse button and dragged to the desired position. Using the mouse wheel allows to
narrow or broaden the width of the representation. Alternatively the cursor keys T and
can be used.

By a right-click on the chart the results are sorted by genes or samples names on the x-
axis.
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In the tab Table of the results table for Multigene-/Multiplate-Analysis all data and

measurement values for the samples are summarized.

|Norm. EXp... |Std.Dev.n...

|Sb:|. DEV. ...
0,01
0,05
0,02
0,01
0,02

ra

|Sb:|.Dev.

|Mean calib...
19,34
22,52

|Mean Ct

15,28
20,78

22,13

|Sam|:-le Name & |No. of repl...

Project name |Gene

0,01
0,07
0,03
0,01
0,03
2,15

oh

trILib-TexasRed Ch

tidatal_1.r

tr [GAPDH-Cy5]

tidatal_1.r

0,05

tidatal_1.r

24,78

oh
oh
Oh
oh

tr [Actin-HEX]

tidatal_1.r

19,34
24,78

16,28

22,13

1 [GARDH-Cy5]
tr [Actin-HEX]
tr Tubulin-FAM

tidatal_1.r

tidatal_1.r

30,59

27,14

i

mui

i

i

rriLl

i

IPS

Table

Result table for Multigene-/Multiplate-Analysis

For the Multigene-/Multiplate-Analysis the results table contains the following

information:
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Column

Project name

Gene

Sample NAME

No of replicates

Mean Ct

Mean Calib. Ct

Std. Dev. Mean Calib. Ct

RQ

Std. Dev. RQ

Norm. Exp.

Std. Dev. Norm. Exp.

Multigene-/Multiplate-Analysis

Meaning

Name of the loaded project that contains the sample

Name of the investigated gene

Name oft he sample

Number of replicates of the sample

Mean Ct-value of the replicates of a sample

Mean Ct-values of replicates of a sample calibrated by the IPS

Standard deviation of the mean calibrated Ct-values of replicates
of a sample

Calculated relative quantity for replicates of the gen in the
original sample

Standard deviation of the calculated relative quantity for
replicates of the gen in the original sample

Normalized expression of the sample

Standard deviation of the normalized expression of the sample

You can design the results table according to your requirements by setting type,
sequence and width of the columns to be displayed. You can also adjust the sort
sequence of data in the column (alphabetical, numerical, by column, by row). The table
configured this way can be exported as Excel or CSV file by right clicking the table.

Save table as Excel-File (*, x1s)

Save table as Excel-File (*,x1s) and run Excel

Save table as CSY-File (*,csv)

Context menu for data export

In the tab IPS of the results table for Multigene-/Multiplate-Analysis all data for the
Interplate Standards (IPS) is summarized.

Project name |Dye |Mean Ct (IPS, Project) |Mean Ct (IPS, all Projects) |Correcti0n value |
multidata3_3.rtp FAM 9,67 8,48 -1,19
multidata3_3.rtp HEX 11,35 10,38 0,97
multidata3_3.rtp TexasRed 8,35 8,75 0,21
multidata3_3.rtp Cy5 8,36 9,36 1
multidatal_l.rip FAM 5,03 8,48 3,45
multidatal_1.rtp HEX 774 10,38 2,65
Table | 1PS |
Summarization of IPS data
Column Meaning

Project name
Dye
Mean Ct (IPS, Project)

Mean Ct (IPS, all
Projects)

Name of the loaded project that contains the IPS sample
Dye that has been used to determine the Ct value of the IPS sample

Mean Ct value of IPS samples in the project (dependent upon the
used dye)

Mean Ct value of IPS samples in all projects (dependent upon the
used dye)
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Correction value Ct correction value that is applied for all samples of the project
(column 1) and the dye (column 2)
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7 MIQE documentation

Instructions for
completing the MIQE
documentation

In 2009 an international group of experts led by Prof. Steven Bustin developed
guidelines for the publication of real-time PCR data (Bustin et al. 2009, Clinical
Chemistry 55:4, 611-622). The aim was to prevent the publication of incomplete or
incorrect real-time PCR data and to ensure comparability and reproducibility of
experiments. The guidelines reqgulate the requirements regarding the minimum
information necessary for the publication of data and have become known as MIQE
(Minimum Information for Publication of Quantitative Real-Time PCR Experiments).

1. MIQE consists of a list of questions to 9 different topics about real-time PCR
experiments. In the gPCRsoft software under the tab MIQE buttons for each topic
buttons are present providing access to the corresponding list of questions.
Additionally the button MIQE-HOME allows to jump back to the main menu from any
sub menu.

2. In general at first by activating the corresponding radio button in the main screen it
should be defined is DNA or RNA has been used as starting material. If the option
DNA is activated the questions for topic REVERSE TRANSCRIPTION do not have to be
answered and the corresponding button becomes inactive.

3. After clicking on a button the corresponding questionnaire opens. The number of
questions differs between the topics. The user should answer as much questions as
possible..

4. The answer to some questions is taken from the currently opened project and active
project if the relevant information is available.

5. The completeness of the answers to the questions is presented by the software as
progress bar and measured in %. The MIQE questionnaire distinguishes between
essential questions that should be answered and additional optional questions that
can be answered. The entry fields for essential questions are highlighted by a red
colored background whereas additional questions have a white colored background.
For the progress bar only the answered essential questions are ranked by the
software. The total number of questions differs depending on whether DNA or RNA
has been used as starting material. The software cannot evaluate the quality of the
answers. It is up to user to fully answer the questions and with due diligence.

6. The gPCRsoft software offers to import MIQE data from other projects. Clicking on
|
the button E:a in the toolbar or by using the menu item MIQE / Import MIQE

Documentation opens a dialog screen. After selecting the appropriate project the
saved MIQE data is imported into the current project.

7. The questionnaire can be printed by the PRINT function of the qPCRsoft software.
Select the point MIQE under DOCUMENTATION (— section "Printing" pg. 22) and press
PRINT. It is always the complete questionnaire printed.
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Real tirme pcr template - vorlagel.rts

\/ Reverse transcription

gPCR Target information

Primer & Assays

qPCR protocol

qPCR validation

Data analysis

Progress:

27%

Essential Information

Main menu of the MIQE input mask

ﬁ}‘ Settings ]/'\CA Maonitoring VE Analysis J/D Documentation 4
L] MIQE 4
Targek:
ﬁ MIQE-Home B
) RNA
@ DNA
Experimental design
Sample information MIQE
Minimum Information for Publication of Quantitative Real-Time PCR
Mucleic acid extraction Experiments

(According to the MIQE guidelines published by 5.A. Bustin et. al. in
Clinical Chemistry 55:4 (2009) 611-622.)

This tool provides a guestionnaire for gathering essential and desireable
information on the real-time PCR experiment shown in this project file.
The data can be used to generate a MIQE report by using the print
function.



Functions in Extras menu

8 Functions in Extras menu

8.1 Device initialization

The device initialization sets the device to the original state. A device initialization is
only required after an error has occurred.

= (all up the Extras » Device initialization command.

8.2  Editing color modules

After inserting the color modules into the device's probe the color modules must be
specified in the software.

Real time pcr template - Salmonella.rtsx EI@
i/ Settings & Monitoring % Analysis |j Documentation 4 b
["] General [ Thermal Cyder & Scan [ samples 1 b

Title:

|Salm0nella |

Operator:

|User |

Start: End:

Comment:

optional notes about the experiment]

Edit color modules window
1. Call up the Extras » Edit color modules command.
A window with the same name opens.
2. The available color modules for your device are displayed on the left.

3. From the list, select the module you have installed in the device, activate the
Properties checkbox and select the position on which the module is mounted in the
device. If necessary, you can also add dye names if these have not yet been added to
the list. Click on [Accept].

4. Repeat this for each color module you have installed.

5. If you wish to define a new color module that is not included in the list of available
color modules, click [Add]. A new color module with the description
COLOR.000.000.00.0 is created. You can define the properties on the right side of
the dialog.

6. To delete a color module from the list, mark the module with the cursor and click on
[Delete].

7. To change the properties of a color module, proceed as follows:
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®m  Activate the Properties checkbox.

= |n the Position list select the position of the color module on the carrier in the
fluorescence probe.

®  Enter the dye that is detected with the color module.
Click on [+].
The dye is added to the list below.
You can remove a dye by marking it in the list and clicking on [-].

®  (lick [Accept] to assign the properties to the marked color module.

Note
A dye can only be assigned to one module. If it is to be measured with a different
module, it first has to be removed from the first module.

8.3  Connecting the device to the PC

The software qPCRsoft automatically recognizes which instrument is connected and
whether it is switched on or not. The instrument may also be switched on and off during
running qPCRsoft. Whether an active connection is established will be indicated in the
lower left corner of the status line.

= |f a connection cannot be obtained in between 30 seconds you can use the Extras b
Device identification in order to solve the problem

8.4  General settings in the gPCRsoft software

General settings for the gPCRsoft program can be made in the Options window.

Note
For most of the settings in the Options window you need to be logged into qPCRsoft as
an administrator.

1. Close all projects.
2. Select the Extras » Options menu command to open the window of the same name.

3. Make the following settings on the tabs:

Tab Function

General Define that the last measurement results are saved automatically (—
section "Opening an automatically saved project' p. 20).

Define the saving mode of projects and their file names (— section "Saving a
project'S. 21).

Data format Select decimal separator for the data export and number of decimal places
to be displayed for different variables.

Language Select language of the qPCRsoft program interface.
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Analysis

Device

File

User
management

Colors

Functions in Extras menu

Sensitivity

Set the basic sensitivity for optical measurements.

Meas. rep. color comp.

Enter the measurement repetitions for recording the color compensation.

Show negative values resulting from color compensation
If activated, negative values are also displayed in the sequence of the color
compensation, otherwise the output is"0".

STC (simulated tube control) active

If active, the temperature control of the sample block is performed in such a
way to obtain the temperature profile desired immediately in the sample.
This function is default when generating a new template.

You can enter a factor for the quantitative evaluations (Quant factor), for
the melting curve analysis (Melting factor) and for the genotyping
(Genotyping factor) in the list fields. This factor will be used for the
automatic calculation of the threshold.

Fix scaling to 100%

In all charts which display normalized fluorescence (fluorescence, dRn) the
maximum value of the Y axis can be set to 100% permanently. There will be
no auto scale of the Y axis. This option simplifies the evaluation of weak
fluorescence data.

Enables you to define a file name into which the device communication data
will be written. The recorded data is used for error diagnosis (— section
"Appendix B - How to save communication data" p. 154).

With the Select device function, the gPCRsoft program can be switched over
to other real-time PCR devices offered by Analytik Jena AG, without the
appropriate device being connected. Projects that were created with this
device can thus be analyzed on a different PC than that used for
measurement. If a device is connected via USB und turned on when starting
the program, it is automatically selected.

If activated, the gPCRsoft program starts and the file opens if you select a
file of this type in the file explorer of the operating system.

See also information about file formats in section "Managing projects and
templates' p. 19.

Activate or deactivate the user management.

If the user management is deactivated, no login prompt will appear at the
program start. The functions for setting up the user management and for
signing projects will not be available.

If the module 21CFR Part11 is installed and active, the user management
can't be de-activated.

Allows to select the color code of sample type and replicates and to let
display the curves color according to sample type, well or replicates.

The desired colors for wells, replicates, sample types and the marking of
positive and negative analyses can also be set.
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9 User management

Note on the general data Due to the encryption used, reading and changing project, template, evaluation and
security communication files generated by gPCRsoft is only possible with gPCRsoft.

The usermangement will be enabled in the window Options / User management.

Option Description
User login is If enabled, the user management is effective at the next program start.
required Logging on to the program is then only possible with a valid user profile.

Note: The first time the program is started after installation, an
administrator with access to the user administration is created.

[Settings] Settings for passwords, login and logout
[Edit] Manage user profiles
Options @

| General I Data format I Language | Measurement I Analysis | Device | File | User management | Colors

User log in required

Ok ] ’ Cancel

Window Options / User management

9.1 Basic settings for password, login and logout

To access the basic settings that apply to all users, select the Extras » Options menu
command. On the User management tab click on [Settings].

You can make the following settings in user management:

= Number of login attempts: If the number of allowed login attempts to a user account
is exceeded, i.e., if the attempts fail, the user account is deactivated. It can then only
be reactivated by the administrator.

= Minimum length of the user name and the password
m  Required characters in the password

® \Warning prior to the password expiring
The password expiring is set in the user profiles
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®  |ogoutin case of inactivity: After the specified time has expired without mouse or
keyboard activity, the program interface will be locked and the login window is
displayed. The user first has to enter the password before the interface can be used
again. If [Cancel] is selected in the login window, the program is closed. It is not
possible to change the user at this point. Automatic logout does not occur if a gPCR
run is active.

F - B
Settings of the user management - — M

Mumber of log in attempts allowed: B =
Minimurn length of the user name: 2 =
Minimurn lenath of the password: 3 =

[ The password must contain letters, numbers and special characters
User name and password must be different

[ Display warning prior to expiration of the password 4 £ Days in advance
Idle log out after 1 2 Minutes
[ Default settings [ Ok ] ’ Cancel
b —

General settings in user management

9.2 Managing user profiles / user groups

To access user management, select the Extras » Options menu command. On the User
management tab click on [Edit].

M — - b
User profils - - u
Mame Group Changed
ﬂ Administrator Administrator 13.03.2018 11:17:26
ﬂ Arthur Operator 13.03.2018 11:03:44
ﬂ Lisa Supervisor 25,05,2018 11:43:53
ﬂ Ronny Supervisor 13.03,2018 11:08:08
add || Edt || Delete | | ok || cancel
h — |

User management with the overview of the created user profiles

The following functions are available in the extended user management:

Function  Description

[Add] Create a new user profile
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Add / edit user profile

[Edit]

[Delete]

User management

Edit a selected user profile

Delete a selected user profile

By default, these functions are only available to users belonging to the Administrator
group. However, they can also be assigned to a Supervisor by editing the user rights.

®  To create a new user profile, click on [Add].

®  To edit an existing user profile, mark the user profile in the list and click on [Edit].

v" The window for editing the user profile appears.

®  Enter the following data:

Option
General tab
User name
Full name
Description

User group

Password tab
Password

Confirm the
password

User must change
password with new
login

User may change
password

No password
timeout

User is deactivated

User is locked

User can sign
electronically

Description

Login name at program start
Actual name (optional)
Further description (optional)

Assign a user group

The rights of each individual user can be individually adjusted within
the user group (see below).

Enter the password

Repeat the password

If activated, users must change their password at first login.

Users are allowed to change their own password.

The password is valid without a time limit.
If deactivated, the expiry date must be specified.

The user profile was automatically locked after multiple failed login
attempts or by an authorized user. Enter the number of possible login
attempts in the settings (— section "Basic settings for password, login
and logout" p. 136). The time when the user was locked is displayed.

The user profile has been locked by an authorized user. The user name
no longer appears in the login dialog, however, the user remains
created. The time when the user was deactivated is displayed.

The user is allowed to sign a project electronically (— section "Digital
signatures'p. 146).

This optionis only available, if the optional module 21 CFR Part 11 is
enabled.
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User groups

-

User profile k g

General | Password

User name: |Arthur

Full name:  Arthur Angel

Description;  Technidan

User group:  Operator v

User has access to simple programm functions.

Edit user group access ]

Settings for the user name and the assigned user group

,

Password: [TI10]

Confirm password: sesss

[Tl User must change password with new login
[¥] User may change password

[¥]No password timeout

[T user is deactivated

[TJuser is locked

[TJuser can sign electronically

Settings for the password and the validity of the user profile

The following user groups are available:

Administrator:

This user group has unlimited rights to all program functions
Administrators can create, delete, lock and unlock users and assign rights to them
They are allowed to change their own password and that of other users

They can deactivate user management in Extras » Options » User management
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Supervisor:

®  This user group has the same rights as the administrator, but administrators can
block certain rights for each user logged in as a supervisor

Operator:

The following rights cannot be assigned to an operator:
= (Create and manage users

®  (reate and save templates

®  Save projects

= (Changes in the Options window on the General, Thermal cycler, Scan, and Layout
tabs

With this selection you automatically assign a certain user role to the user and thus
preset rights which you can additionally supplement or reduce using the Edit user
access function. This allows individual rights to be defined for each user. It is also
possible to set up several administrators with different rights.

= |n the User profile / General window, click on [Edit user group access].

v" The window of the same name containing the rights of the selected user
appears.

® |f a checkbox is activated by a checkmark, this right is granted to the user and the
user can use the function.

®  (Checkboxes with a lock symbol cannot be changed.

= The number of these locked rights is determined by the selected Administrator,
Supervisor or Operator user role and increases in this order. This means that an
operator has fewer rights than a supervisor or administrator from the outset and can
never be assigned all rights.

= An administrator has all rights in the program and these rights can only be restricted
by removing the checkmarks. The right of an administrator to manage and create
users cannot be locked, otherwise user management would no longer be possible.
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-
Benutzergruppenzugriff bearbeiten g u

Benutzergruppenzugriff:

[ [ Benutzer anlegen und verwalten

[ SFarbmoduIE anmelden und verandern
G'u'orlage SpErTen

Vorlage neu erstellen

Vorlage speichern

Prajekt speichern

Anderungen auf Karte Allgemein
Anderungen auf Karte Thermocyder
Anderungen auf Karte Scan
Anderungen auf Karte Layout
SqPCR—Lauf starten

GCt— und Tm-Berechnung im Monitoring
] G.ﬁ.nalysen anlegen und editieren
GMIQE-DokumenEtinn bearbeiten

O GProben aktivieren f deaktivieren

= SAuditTraiI anzeigen [ filtern

] GDrudcfunktion

OOoooEOEO

| ok || abbrucn

Configuring an individual user profile within a user group

9.3  Edit password

If the user may change his password, he can open his user profile in the user
management and change the password. Supervisors and operators can only do this in
the usermanagement. They have not access to over functions in the usermangement.

1. Open with the menu point Extras » Options the window Options / User
management.

Open with [Edit] the window User profiles.
Select your user profile and click on [Edit].

Change and confirm the password in the window User profile / password.

voR W N

Confirm the settings and exit all windows with [OK].

141



Optional 21 CFR Part 11 module

10 Optional 21 CFR Part 11 module

10.1 Activation

Automatic activation

142

Starting with version 4.1, the gPCRsoft software contains functions that make the
program compatible with the requirements of 21 CFR Part 11. After fee-based
activation, the following functions are available:

Audit Trail in templates and projects, i.e., changes made to the project settings are
continuously recorded.

Login Monitoring during which attempts to log in to the program and also changes
to the user settings are stored

Editors for the evaluation of audit trails and log files using search functions,
including a print function

Creation and display of Digital Signatures in templates and projects with monitoring
of their validity

Automatic Logout in case of inactivity with the option of adjusting the time

To activate the functions, you need an activation code that can be ordered from your
contact person or dealer. This fee-based activation code entitles you to use the software
on a single computer (single-user license). If it is planned to use this optional module on
several computers, an activation code is required for each computer.

The module is activated in two steps:

Send an order file (*.RTO) to Analytik Jena

Import an activation file (*.RTL) sent by Analytik Jena

Select the Help » Additional modules » Order "21 CFR Part 11" module menu
command.

v" A window containing information on how to continue appears.
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Order "21 CFR Part 11" - Module (]

With the help of this dialogue you can order a licence for using the software functions reguired by 21CFR Part 11,

Using this dialogue you can order a licence key (with costs) which makes the software compatible with the requirements of 21 CFR
Part11, Functions like Audit Trail, Log In list and Digital Signature are then available. In order to generate this licence key we need
identifying information of your computer which you can transmit to us by dicking “Save” and sending the file generated to your
dealer.

You will be sent a file the help of which you can activate this part of the software. For more information see the manual.

If you are not allowed to copy files from or to your system, please contact your dealer.

Save l [ Close

Creating the RTO file for ordering the activation code
= (Click on [Save].
v This creates a file for generating the activation code.

= Save the file with the extension "*.rto" under any name on your computer and send
this file by e-mail to your dealer or contact person.

®  Assoon as Analytik Jena has processed your order, you will receive a file for
activating the 21 CFR Part 11 functions (license file). Copy the file to the hard drive
on your computer.

= Start qPCRsoft and select the Help » Additional modules » Activate "21CFR Part11"
module menu command.

® |n the Activate "21 CFR Part 11" module window, enter the storage location for the
license file and click on [Activate].

Activate *21 CFR Part 11" - Module e
Activation file:
Ci'\ProgramData‘\Analytik JenagPCRsoft\d. 0\activation.rt E]
Activate l [ Close l

Importing the RTL file for activation
v" A notice field indicates whether activation was successful.

= After completing activation, restart the software and check whether the new
functions appear in the Compliance menu.
Note: The functions are only active if user management is activated.

v If the functions are displayed, activation has been successfully completed. If
activation is not successful, contact your contact person or dealer.
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Note on data protection

Manual activation

10.2 Audit trail

Display and evaluate audit
trail

144
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File Edit View Cumpliam:e Extras Window
|_| £ - Show audit trail ‘

Window 0 - Unnan -2, Show signatures

Compliance menu for the "21 CFR Part 11" module

d

<= |

Show log file

| B

The created RTO-file contains the name of the computer on which activation should
take place and the MAC address of the network card in encrypted form. Analytik Jena
uses this data in order to automatically generate the activation code for your computer.
The data is processed in encrypted form. It is not used for other purposes or passed on
to third parties.

If you are not allowed to copy or send files on your computer, a manual activation
method is available. In this case, contact your contact person or dealer.

The audit trail records changes to metadata in templates and projects. Metadata
determines how the results are calculated and displayed from the raw data of a gPCR
run, and thus influences the result of the experiment. The raw data, on the other hand,
always remains unchanged, meaning it is not part of the audit trail. If settings are
changed in the project or the template, the new metadata is appended as a block to the
original data when the file is saved. This process takes place automatically in the
background. If a project is frequently opened and edited, the scope of the audit trail can
increase considerably. It is not possible to delete contents in the audit trail.

Search functions are available for evaluating the (in some cases extensive) audit trail of
a project or a template. These functions allow you to systematically search for and
identify changes to metadata.

®  Select the Compliance P Show audit trail menu command.
®  To start the search, click on [Search].

= To print out the content that is displayed in the text field (the complete audit trail or
reduced content as a result of a search), click on [Print].

The following search options are available:
= The Find info and Find text input fields are empty: The entire audit trail is displayed.

®  Thereis an entry in the Find info field: Search in the block headers, i.e., in the text in
the square brackets. This makes it possible to track when the file was created, by
whom, and how often it was edited.

® Thereis an entry in the Find text field: Search in the audit trail. A search can be
carried out for terms that characterize certain settings for the qPCR run, the display
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of results, the evaluations, the layout and general information. An overview of the
terms and their meaning can be found in Annex D.

The input fields save search terms that have been previously used and make them
available for reuse via the drop-down menu

Show audit trail ===

Find info:

Find text:

comment -
Find results:

[Administrator - 06.06.2013 11:04:41 - AT_DATA_CREATECLASS] -

General.Comments -=
Samples[A1].Comment -=
Samples[AZ].Comment -=
Samples[A3].Comment -=
Samples[A4].Comment ->
Samples[A5].Comment ->
Samples[AG].Comment ->
Samples[A7].Comment ->
Samples[A8].Comment ->
Samples[AS].Comment -=
Samples[A10]. Comment -
Samples[A11].Comment -
Samples[A12]. Comment -
Samples[B1]. Comment -
Samples[B2]. Comment -
Samples[B3]. Comment -
Samples[B4]. Comment -
Samples[B5]. Comment -
Samples[B&]. Comment -
Samples[B7]. Comment -
Samples[B&]. Comment -
Samples[B3]. Comment - -

=) [ o=

Audit trail for a project with a search

m

10.3 Login monitoring

All login processes in the gqPCRsoft software are monitored and stored in encrypted form
in a log file that is protected against manipulation by a checksum. This file also contains
information about newly created users and digital signatures. The program records
whether logins and signatures were successful or failed. In case of failed operations, the
cause is also indicated (wrong password, wrong user name).

m  Select the Compliance » show log file menu command.

®  Limit the display by activating the checkboxes and the selection in the corresponding
lists.

®  To print the displayed results, click on [Print].
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Log Datei anzeigen @

Typ:
LOG_TYPE_ADDUSEROK -

[|Benutzer:

[] Zeitspanne:
05.06.2018 E+ - 06.06.2018 B

Resultate:

LOG_TYPE_ADDUSEROK
23.01,2018 13:33:54
Marion

LOG_TYPE_ADDUSEROK
23.01,2018 15:358:59
Arthur

LOG_TYPE_ADDUSEROK
13.03.2018 11:03:44
Arthur

LOG_TYPE_ADDIUSEROK
13.03.2018 11:05:15
Lisa

LOG_TYPE_ADDIJSEROK
13.03.2013 11:08:08
Ronny

Drucken Suchen H Schiiefien

Log file with filter

10.4 Digital signatures

10.4.1 Signing a document

Registered users who also have the relevant authorization can digitally sign a template
or a project (— section "Managing user profiles / user groups" p. 137). The signature is
equivalent to a handwritten signature because it can be clearly traced back to its creator.

Sign an active document ®  Select the Compliance P Sign digitally menu command.
v The Signature window appears.

= Make the following settings:

Parameter  Description

User name  Select the registered users who are authorized to sign

The user logged in to the program is preset in the selection
Password Enter the user's password
Status Select the signing status: Created, Edited and Released

Comment Additional explanation of the signature (optional)
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= Confirm your entries with [OK].

v The digital signature is saved in the project or the template. Digital signatures
are valid as long as no changes are made to the project or the template.

-
Signature @
Properties
[ User name:  Administrater -
Password: s s|
Status:
[Created -
Comment:
Experiment & -
4 2
Ck ] ’ Cancel
L

Window for signing a template or a project

10.4.2 Displaying signatures

You can view and print out the signatures assigned to a project or a template.
m  Select the Compliance » Show signatures menu command.

v" The Show signatures window appears. You can check the validity of the date
and the creator of the signature.

= To print the displayed data, click on [Print].

-

Show signatures @
Signatures
Signatur 1
Created by: Administrator
Signed on: 06.06.2018 11:29:51
Status: invalid
Importance: Created
Comment: Experiment A
Signatur 2
Created by: Administrator
Signed on: 06.06.2018 11:31:30
Status: valid
Importance: Created
Comment: Experiment A, ROX added

Overview of the signatures of a template or a project
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11 Appendix A - Short instruction

The gPCRsoft main
window

Project window - Settings

148

EFi gPCRsoft 2.0 1ol
1) Edt View Extras Window Help

N LI
Bl

W General =

{8 Thermal Cycler

Scan

E1 Samples

EE Absolute quantification

%= Relative quantification

 ddCt quantification
[ Melting curve
H Genotyping

1] |

Keine Verbindung mit "TOptical" |Admm|stramr &

The main window is arranged in different areas: Menu bar (1), Toolbar (2), Project
explorer (3), Project interface (4).

To create a new project select the menu command File » New or press the buttonD
in the toolbar.
Use the commands File »Open project or File »Open template to load saved files.

=

N

Open the Settings tab.



Appendix A - Short instruction

) Settings |~ {x Monitoring 24 Analysis [F] Documentation Tab 1st order
—

—
= . . Y =
{] General | [[f] Thermal Cycler & Scan Samples ]\QDN
Title:
= Tab 2nd order

|Salmonella |

Operator:
|User |

Start: End:

Comment:

optional notes about the experiment]

Variable display
range

3. Enter general information for the project under tab General.

4. Enter PCR program under tab Thermal Cycler.

Table ( ¥ sStep: 4 of 5)

Lid temp. °C: 100 /2 [¥|Preheatlid Device:|T-Optical 96 -

4 steps | scan °C m:s goto | loops [ AT(°C) [ &At(s) | 7(°C/s)

1 95,0 02:00 | -- - 5,0

2 95,0 00:05 | - - 5,0
413{[ 3 58,0 00:05 - - i 5,0

4 * 72,0 00:15 | 2 40 5.0

5 # | Melt. curve 60 to 95 °C, 6 5 with AT 1 2C

i

7

8

9

10

Table | Graph | Melting curve

m Set lid temperature and activate or deactivate preheat mode.

= Settemperature and time for each step. If desired define gradient (only for
devices with gradient function).

®  Forloops set the step number in column goto the program jumps back to and in
the column loops define the number of measurement repeats.

®  |f necessary define temperature or time increments or adjust the ramping rates.
®  [f necessary activate the melting step and edit parameters.
= |n the column scan define at which step the fluorescence is measured.

5. Define the fluorescence measurement settings on the tab Scan:
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Real time per project - ddCt_WithStandards.rtpx =N E=R (=
Q‘; Settings l/& Monitoring ]/E Analysis ]/D Documentation ] 4 b
[ General ]/ﬁ Thermal Cyder J/Q Scan Samples ] 4 b
Pos. Channel Dye Gain Measurement  Pass. Ref,
1 Blue FAM 5 *
2 Green JOE 5
3 Yellow TAMRA 5
4 Qrange RO 5
5 Red Cy5 5
] MNIR1 Cy5.5 5
Meas. repeats: 3 ~ Color compensation: off ~
Scan region according layout
Define scan region manually

®  Set hash key in the column Measurement for each channel to measure
®  Select dye to measure in column Dye and set LED intensity in column Gain.
®  For passive reference check mark in column Pass. Ref.
®  Set number of measurement repeats and define region to scan.
= |f necessary activate color compensation.
6. Define plate layout under the tab Samples (can be done during the run):
m  Set sample name and sample type.
= Enter name for the gene to be measured in column Gene.
®  Forstandards enter concentration in column Conc. and set unit

®  Select position or region in the plate layout.

®  Assign settings to the selected wells using Toolbar button @

7. If the plate contains samples from different experiments that have to be analyzed
separately create groups:

Real tirme per project - Unnamed El@
E‘J Settings l/'k;'} Manitoring VE Analysis I 4 F
) General Vﬁ Thermal Cyder }/@ Scan /V Sampls] 1 I

Edit layout ”Fgroups
e[ [a[s[s[7[o]s [o[ua]om  Goma_
000000000000 -~
000000000000
000000000000
000000000000
3111111100000
000000060 -1-.1-1-]
31:1:1:1:1:1510 0000
313131 1:1:1-100000

m  Select group and set group name.

m  Select position or region in the plate layout.

®  Assign settings to the selected wells using Toolbar button =%
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8. The layout preview functions provide a comprehensive overview for the plate layout.

To activate the layout preview use button .

Project window - = Press button ® to start the run
Monitoring o . . . . .
® |n the Monitoring window the results of the run are displayed in real-time
Real time pcr project - gTOWER2_Demo_AbsQuantl_1.rtp E’@
iy Settings  Monitoring B4 Analysis [£] Documentation q b
Measurement =
View: ’Ampllﬁcahon v] ¥ [ Calculate Ct ]
20000
—_ 15000
‘:;‘ Amplification
'E 10000 4 curves
E
5000+
a
T T T T T T T T
5 10 15 20 25 30 35 40
Cycles [n]
All colors [ FaM |} Dye
: tabs
Table
Lid: 25,0 °C 4 steps | scan oC m:s
1 95,0 02:00
2 95,0 00:05
41x[ 3 58,0 00:05
4 * 72,0 00:15
5
o,
25,0 °C 6 PCR protocol
7
8
a
10
( Table | Graph | T-Profile ) tF;rkC));OCd display

®  For the results either the PCR accumulation curves or the melting curves can be
displayed. Use selective list View to display the different results.

®  Use dye tabs to select between the different dyes.
®m  The PCR protocol can be displayed tabular, graphical or as temperature profile.

®  After the PCR run, Ct values and melting temperatures can be calculated for all
samples without applying an evaluation. Click the [Calculate Ct] button in the
amplification curve display or [Calculate Tm] in the melting curve display.

Project window - Analysis ~ For analysis different analysis methods for absolute quantification, relative
quantification, AACt-method, genotyping and melting curve analysis are available.

= To start an analysis select corresponding tab and press button [Add analysis] in the
toolbar. This button is labeled with a + -symbol (for example ).

= |n the window that opens enter a name for the analysis:

151



Appendix A - Short instruction
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Description of the analysis:

The analysis window is separated in a header for general settings, a graphical chart to
display amplification curves and an area to display standard- or validation curves or the

result table:
(53] Real time per project - 3Toptical_Demo_RelQuantl_1.rtp (=% EoR =%
{y Settings | @ Monitoring % Analysis 4 b
&5 Abs. Quant. | #4 Rel Quant. | *{' DeltaDeltaCt |~ 5 Melt. curve | 4 b
Gene of Interest (GOI): Group: Threshold: —————— Header
Indude passive reference Group 1 - 1,189 [E]
Reference genes:
FAM-GAPDH ~|(38)
100
75 : ;
Amplification
curves
=
§ 07
25
0-
T T T T T T T T
5 10 15 20 25 30 35 40
Cycle
GGO' M [Ref.geneFAM | ) GOl/References
/ genes
FAM-c-myc FAM-GAI
R2 0,99989 0,99943
25 Slope -3,59 3,7
5 . :
20 4 \'\‘\. ST T 7T Standard curves
15 - r Y - PCR Efficency |0,9 0,86
1 2 3 4
Log Std. Conc. «| »
( Table |Standard curve ) Table/curves tabs

In the header various settings can be made that differ by the analysis methods:

Select gene of interest (GOI).

If applicable set passive reference (e.g. ROX) for normalization.

Select between different experiments (groups).

Select at least one reference gene to calculate a standard or validation curve.
Set baseline correction.

Set threshold (manually or automatically).

Switch between linear and logarithmic display of the fluorescence intensities.
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Method Analysis name Show/hide header
Dye Gene of Gene of Interest (GOI): Group: Threshold: B line/
Interest AM-c-myc hé Indude passive reference roupl v 1,189 ngﬁ r1lge
Reference genes: -
FAM-GAPDH =~ T ]
Dye reference Include pass. Group Remove Threshold
gene reference reference gene settings

In the amplification curves area the fluorescence intensity curves are shown:
® |n the linear mode the base line correction can be checked.

®  |n the logarithmic mode the threshold line can be set manually. Move the threshold
line up or down by using the mouse.

®  Switch by the tabs between the different dyes.

If the cursor is moved on a curve some short information for the sample is displayed.

In the lower part of the analysis window the standard or validation curves are displayed:

®  Forthe curves calculated values are displayed in a table.
®  Use tabs to switch between the display of curves and of the result table.
Standard-/Validation curves Results table
FAl-cmyc | VIC-GAPD) wel | [sample name [Sample type  [Group [Gene Jet [Mea+
R™2 0.999%68 AL 671d cDNA Unknown Group 1 43 31,79 30,
o e o Slape 2.72 -3.48 a2 .sm NA  Unknown Group 1 pds 29,2 30,4
= B S e B 21.28 2743 a6 671dcONA  Unknown Group 1 49 31,23 30,4
v . . — PCR Efficiency | 1.33 0.94 A10 .smmm Unknown Group 1 4 30,43 30,4
2 -1 ('] 1 A1l .671d DNA Unknown Group 1 P49 29,81 30,4
Log Std. Conc. iJ_J ﬂ illz_l 671d cDNA Unknown Group 1 49 30,7 3EI;4 b
\Table ) Stardard curve | Table /Standard curve

= Define columns to be displayed in the result table after right mouse click on a column
header.

®  Export data from the result table as *.csv files after right mouse click in the table.
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154

With problems with your device you can record the communication data of the device
and send it to the service. This makes easier the distant diagnosis. For this purpose the
recording must be activated and a file name to the memory of the data be agreed.

Note
To the activation of the recording of the data traffic you must be announced as an
administrator.

1. Run gPCRsoft.
2. Choose the menu command Extras » Options and open the Device tab.
3. Activate the checkbox Save data traffic.
4. Click the button [...], the Open dialog appears.
5. Typein a file name to which the communication data shall be sent. The extension of
the traffic file is "*.dtf".
6. Confirm the dialog by clicking [Open].
Options X
General Dataformat Language Measurement Analysis Device  File User management Colors

Connection data file:
|C: Wsersli10111039\Downloads\DataTraffic. dtf

Save data traffic

Select device:
GTOWER /G w

During the next PCR run the communication data between instrument and PC are
recorded in the file denoted. Send this file to Analytik Jena upon request.
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13 Appendix C - Creating a project template from the
transfer file (LIMS)

The gPCRsoft software can be configured by another program (e.g. a Laboratory
Information Management System" (LIMS)). In order to do this, the LIMS has to create a
file that is imported by qPCRsoft via the File » Import LIMS function. The so-called
transfer file has a specific structure that can be provided by Analytik Jena if requir
gPCRsoft soft creates a template with the transfer file, with which a PCR run can be
started immediately.

The different export functions of gPCRsoft can be used to transfer the results of the PCR
run to the LIMS, depending on which data the LIMS expects.

155



Appendix D - Entries in the Audit Trail

14 Appendix D - Entries in the Audit Trail

Audit-Trail print out

Description

[Administrator - 25.06.2018 08:47:00 - AT_DATA_CREATECLASS]

Who created this project and when? Default
Audit Trail data set is following.

[Administrator - 04.07.2018 11:10:17 - AT_DATA_SAVEPROJECT]

Who saved this project and when? Altered
Audit Trail data set is following.

General
DEVICETYPE device type: 3=qTOWER?
APPVERSION version of qPCRsoft used

FIRMWAREVERSION

firmware version of the connected device

DataUser.Name -> Administrator

logged in user

DataUser.Level

general user role (Administrator, Supervisor,
Operator)

DataUser.LevelBits

granted rights of this user, coded in bits

DataUser.Password

password of the logged in user (not displayed
here)

DataUser.Userdependent

not used

General.Title

titel entered on the card General

General.Operator

operator

General.DateTime

date and time of project creation

General.Comments

comments entered on the card General

General.DevicelD

device identification data read from EEPROM

Thermal Cycler
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CyclerProgram ->
ProgData.BlockType=14;ProgData.LidTemp=100;ProgData.HotStart=Tru
€;
ProgData.Control=10;ProgData.Standby=False;ProgData.BlockTemp=12;
ProgData.MeasTime=10;MeltData.StartTemp=60;
MeltData.EndTemp=95;MeltData.Gradient=1;MeltData.Time=16.128;M
eltData.Ramp=5;
MeltData.Equilibration=6;MeltData.Active=False;StepCount=4;Head.Prog
ramNumber=1;
Head.Gradient=False;Head.ProgramPath=TOP;Head.ProgramName=PCR;
Head.ProgramDate.Day=11;
Head.ProgramDate.Month=7;Head.ProgramDate.Year=12;Step1.ScanFal
se;Stepl.Temp=95;
Stepl.Time=02:00;Stepl.Goto=-;Stepl.Loops=-;Stepl.Templnc=-
;Stepl.Timelnc=-;Step1.Ramp=>5;Step2.ScanFalse;
Step2.Temp=95;Step2.Time=00:05;Step2.Goto=-;Step2.Loops=-
;Step2.Templnc=-;Step2.Timelnc=-;
Step2.Ramp=5;Step3.ScanFalse;Step3.Temp=58;Step3.Time=00:05;Step
3.Goto=-;Step3.Loops=-;

Step3.Templnc=-;Step3.Timelnc=-
;Step3.Ramp=5;Step4.ScanTrue;Step4.Temp=72;Step4.Time=00:15;
Step4.Goto=2;Step4.Loops=40;Step4. Templnc=-;Step4.Timelnc=-
;Step4.Ramp=5;

program of the thermal cycler used fo this
experiment

Fluorescence Measurement

ColorModule.Position -> 1

color module position 1

ColorModule.Code -> Blue.470.520.11.3

type of the color module used

ColorModule.Color -> FAM

dye selected

ColorModule.Gain -> 5

set gain

ColorModule.Meas -> -1

activated for measurement (-1) or not (0)

ColorModule.Refr -> 0

used as passive reference, Yes (-1), No (0)

ColorModule.Position -> 2

color module position 2

ColorModule.Code -> Green.515.545.11.2

type of the color module used

ColorModule.Color -> JOE

dye selected

ColorModule.Gain -> 5

set gain

ColorModule.Meas -> 0

activated for measurement (-1) or not (0)

ColorModule.Refr -> 0

used as passive reference, Yes (-1), No (0)

ColorModule.Position -> 3

color module position 3

ColorModule.Code -> Yellow.535.580.11.2

type of the color module used

ColorModule.Color -> TAMRA

dye selected

ColorModule.Gain -> 5

set gain

ColorModule.Meas -> 0

activated for measurement (-1) or not (0)

ColorModule.Refr -> 0

used as passive reference, Yes (-1), No (0)

ColorModule.Position -> 4

color module position 4
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ColorModule.Code -> Orange.565.605.11.2

type of the color module used

ColorModule.Color -> ROX

dye selected

ColorModule.Gain -> 5

set gain

ColorModule.Meas -> 0

activated for measurement (-1) or not (0)

ColorModule.Refr -> 0

used as passive reference, Yes (-1), No (0)

ColorModule.Position -> 5

color module position 5

ColorModule.Code -> Red.630.670.11.1

type of the color module used

ColorModule.Color -> Cy5

dye selected

ColorModule.Gain -> 5

set gain

ColorModule.Meas -> 0

activated for measurement (-1) or not (0)

ColorModule.Refr -> 0

used as passive reference, Yes (-1), No (0)

ColorModule.Position -> 6

color module position 6

ColorModule.Code -> NIR1.660.705.11.1

type of the color module used

ColorModule.Color -> Cy5.5

dye selected

ColorModule.Gain -> 5

set gain

ColorModule.Meas -> 0

activated for measurement (-1) or not (0)

ColorModule.Refr -> 0

used as passive reference, Yes (-1), No (0)

Compensation.Name ->

name of the color compensation used

Compensation.Infos[0].Position through Compensation.Infos[5].Position

Compensation.Infos[0].Color through Compensation.Infos[5].Color

Compensation.Infos[0].Gain through Compensation.Infos[5].Gain

information about color modules, dyes and
gains used for this color compensation,
displayed for all 6 color module positions

Compensation.Matrix[0, 0] through Compensation.Matrix[5,5]

elements of the color compensation matrix

Scan.Repetitions -> 3

number of measurement repeats

Scan.SpectralCompensation -> 0

type of the color compensation (off, standard,
select)

Scan.FromCol -> 1

begin of the scanned area of the plate

Scan.ToCol -> 12

end of the scanned area of the plate

Scan.ColRangeType -> 1

select scanned area from layout (-1) or
manually (0)

Layout

Layout.Code -> Blue.470.520.11.3

color module the following gene is measured
with

Layout.Infos[A1].Gene through Layout.Infos[H12].Gene

gene name of each well of the plate

Layout.Infos[A1].Concentration through Layout.Infos[H12].Concentration

standard concentration of each well of the plate

Units -> ng

concentration unit

Samples[Al].Name through Samples[H12].Name

sample name for all wells

Samples[A1].Typ through Samples[H12].Typ

sample type for all wells

Samples[A1].SubTyp through Samples[H12].SubTyp

sample sub type for all wells

158



Appendix D - Entries in the Audit Trail

Samples[Al].Comment through Samples[H12].Comment

comments for each well

Samples[Al].Active through Samples[H12].Active

Is this well activated?

Samples[Al].Marked through Samples[H12].Marked

Is this well marked in the explorer?

Groups[A1] -> 0 through Groups[H12]

To which group does the well belong?

GroupNames -> Group 1 through GroupNames -> Group 12

names of the 12 groups possible

LOCK->0

template locked? Yes (-1), No (0)

Calculate Ct

CtAnalysis.Thresholds -> 0,794712458619839

threshold value the Ct values were calculated
with

CtAnalysis.Smooth -> -1

smoothing On(-1), Off(0)

CtAnalysis.SmoothMode -> 5

number of points used for smoothing

CtAnalysis.Log -> 0

logarithmic chart On(-1), Off(0)

CtAnalysis.BaseLineRange[0].Min -> 3

manually set lower boundary of the base line
(cycle number)

CtAnalysis.BaselLineRange[0].Max -> 15

manually set upper boundary of the base line
(cycle number)

CtAnalysis.BaseLineRange[1].Min -> 5

automatically set lower boundary of the base
line (cycle number)

CtAnalysis.BaselineRange[1].Max -> -1

calculate automatically upper boundary of the
base line range Yes (-1), No (0)

CtAnalysis.AutoBaseline -> -1

automatic base line determination On (-1) or
Off (0)

CtAnalysis.AutoThreshold -> 0

auto threshold On(-1), Off(0)

CtAnalysis.Filter -> -1

filter On(-1), Off(0)

CtAnalysis.FilterOptions -> 2

filter strength slight(0), medium(1) or
strong(2)

CtAnalysis.FilterSmooth -> 0

smooth the filter data, Yes (-1), No (0)

Calculate Tm

TmAnalysis.GOI.Color ->

melting curve GOI

TmAnalysis.GOl.Gene ->

melting curve of gene

TmAnalysis.Threshold -> 0

threshold value for determination of melting
temperature

TmAnalysis.Smooth -> -1

smooth melting curve , Yes (-1), No (0)

TmAnalysis.SmoothMode -> 3

number of points used for smoothing

TmAnalysis.Log -> 0

logarithmic chart On(-1), Off(0)

TmAnalysis.BaseLineRange.Min -> 1

manually set lower boundary of the base line
(cycle number)

TmAnalysis.BaseLineRange.Max -> 5

manually set upper boundary of the base line
(cycle number)

TmAnalysis.AutoThreshold -> 0

auto threshold for melting curve, Yes (-1), No
(0)
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TmAnalysis.FlipCurve -> 0

flip curve horizontally, On(-1), Off(Q)

TmAnalysis.Scaling -> 1

All curves start at 100%(0), Maximum initial
fluorescence = 100%(1)

Absolute Quantification

AbsQuantAnalyzes.Smooth -> -1

smoothing On(-1), Off(0)

AbsQuantAnalyzes.SmoothMode -> 5

number of points used for smoothing

AbsQuantAnalyzes.Log -> 0

logarithmic chart On(-1), Off(0)

AbsQuantAnalyzes.BaselLineRange[0].Min -> 3

manually set lower boundary of the base line
(cycle number)

AbsQuantAnalyzes.BaselLineRange[0].Max -> 15

manually set upper boundary of the base line
(cycle number)

AbsQuantAnalyzes.BaselLineRange[1].Min -> 5

automatically set lower boundary of the base
line (cycle number)

AbsQuantAnalyzes.BaseLineRange[1].Max -> -1

calculate automatically upper boundary of the
base line range Yes (-1), No (0)

AbsQuantAnalyzes.AutoBaseLine -> -1

automatic base line determination On (-1) or
Off (0)

AbsQuantAnalyzes.AutoThreshold -> 0

auto threshold On(-1), Off(0)

AbsQuantAnalyzes.Filter -> -1

filter On(-1), Off(0)

AbsQuantAnalyzes.FilterOptions -> 1

filter strength slight(0), medium(1) or
strong(2)

AbsQuantAnalyzes.FilterSmooth -> 0

smooth the filter data, Yes (-1), No (0)

AbsQuantAnalysis.Description -> Quantitation 1

title of this analysis

AbsQuantAnalysis.Group -> 0

valid for group

AbsQuantAnalysis.REF -> 0

passive reference used? Yes (-1), No (0)

AbsQuantAnalysis.GOl.Color -> FAM

dye of GOI

AbsQuantAnalysis.GOl.Gene ->

name of GOI

AbsQuantAnalysis.Threshold -> 1,13570592788773

threshold value the Ct values were calculated
with

AbsQuantAnalysis.FitData.Count -> 4

number of standards

AbsQuantAnalysis.FitData.M -> -3,67716352286466

slope of the standard curve

AbsQuantAnalysis.FitData.N -> 28,0638862770259

intercept of the standard curve

AbsQuantAnalysis.FitData.R2 ->0,999236478923372

correlation coefficient of the linear curve fit

AbsQuantAnalysis.FitData.Extern -> 0

Was the standard curve imported, Yes (-1), No
(0)

MIQE.Typelnfo -> 1

MIQE documentation for DNA(Q) or RNA(1)

LOCK->0

template or project locked? Yes (-1), No (0)

Relative Quantification

RelQuantAnalyzes.GOISmooth -> -1

smoothing GOI, On(-1), Off(0)

RelQuantAnalyzes.GOISmoothMode -> 5

number of points used for smoothing, GOI
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RelQuantAnalyzes.GOlLog -> 0

logarithmic chart GOI On(-1), Off(0)

RelQuantAnalyzes.GOIBaseLineRange[0].Min -> 3

manually set lower boundary of the base line
(cycle number GOI)

RelQuantAnalyzes.GOIBaseLineRange[0].Max -> 15

manually set upper boundary of the base line
(cycle number GOI)

RelQuantAnalyzes.GOIBaseLineRange[1].Min -> 5

automatically set lower boundary of the base
line (cycle number GOI)

RelQuantAnalyzes.GOIBaseLineRange[1].Max -> -1

calculate automatically upper boundary of the
base line range Yes (-1), No (0)

RelQuantAnalyzes.GOlAutoBaseLine -> -1

automatic base line determination On (-1) or
Off (0)

RelQuantAnalyzes.GORSmooth -> -1

smoothing reference gene, On(-1), Off(0)

RelQuantAnalyzes.GORSmoothMode -> 5

number of points used for smoothing of
reference gene

RelQuantAnalyzes.GORLog -> 0

logarithmic chart GOI On(-1), Off(0), reference
gene

RelQuantAnalyzes.GORBaseLineRange[0].Min -> 3

manually set lower boundary of the base line
(cycle number reference gene)

RelQuantAnalyzes.GORBaseLineRange[0].Max -> 15

manually set upper boundary of the base line
(cycle number reference gene)

RelQuantAnalyzes.GORBaseLineRange[1].Min -> 5

automatically set lower boundary of the base
line (cycle number reference gene)

RelQuantAnalyzes.GORBaselLineRange[1].Max -> -1

automatically set upper boundary of the base
line (cycle number reference gene)

RelQuantAnalyzes.GORAutoBaseline -> -1

automatic base line determination On (-1) or
Off (0), reference gene

RelQuantAnalyzes.GOlAutoThreshold -> 0

auto threshold On(-1), Off(0), GOI

RelQuantAnalyzes.GORAutoThreshold -> 0

auto threshold On(-1), Off(0), Referenzgen

RelQuantAnalyzes.GOlIFilter -> -1

filter On(-1), Off(0), GOI

RelQuantAnalyzes.GOIFilterOptions -> 1

filter strength GOI, slight(0), medium(1) or
strong(2)

RelQuantAnalyzes.GOIFilterSmooth -> 0

smooth the filter data GOI, Yes (-1), No (0)

RelQuantAnalyzes.GORFilter -> -1

filter On(-1), Off(0), reference gene

RelQuantAnalyzes.GORFilterOptions -> 1

filter strength reference gene, slight(0),
medium(1) or strong(2)

RelQuantAnalyzes.GORFilterSmooth -> 0

smooth the filter data of reference gene, Yes (-
1), No (0)

RelQuantAnalysis.Description -> RelQ

title of this analysis

RelQuantAnalysis.Group -> 0

valid for group

RelQuantAnalysis.REF -> 0

passive reference used? Yes (-1), No (0)

RelQuantAnalysis.GOl.Color -> FAM

dye of GOI

RelQuantAnalysis.GOl.Gene ->

name of GOI
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RelQuantAnalysis.GOIThreshold -> 0,794712458619839

threshold value the Ct values of the GOl were
calculated with

RelQuantAnalysis.GOR.Color ->

dye of reference gene

RelQuantAnalysis.GOR.Gene ->

name of the reference gene

RelQuantAnalysis.GORThreshold -> 50

threshold value the Ct values of the reference
gene were calculated with

RelQuantAnalysis.GOIFitData.Count -> 4

number of standards, GOI

RelQuantAnalysis.GOIFitData.M -> -3,62354563433653

slope of the standard curve, GOI

RelQuantAnalysis.GOIFitData.N -> 27,5354442047509

intercept of the standard curve, GOI

RelQuantAnalysis.GOIFitData.R2 -> 0,999100282770293

correlation coefficient of the linear curve fit,
GOI

RelQuantAnalysis.GOIFitData.Extern -> 0

Was the standard curve for GOl imported, Yes (-
1), No (0)

RelQuantAnalysis.GORFitData.Count -> 0

number of standards, reference gene

RelQuantAnalysis.GORFitData.M -> 1

slope of the standard curve, reference gene

RelQuantAnalysis.GORFitData.N -> 0

intercept of the standard curve, reference gene

RelQuantAnalysis.GORFitData.R2 -> 0

correlation coefficient of the linear curve fit,
reference gene

RelQuantAnalysis.GORFitData.Extern -> 0

Was the standard curve for reference gene
imported, Yes (-1), No (0)

DeltaDeltaCt Analysis

DeltaDeltaCtAnalyzes.GOISmooth -> -1

smoothing GOI, On(-1), Off(0)

DeltaDeltaCtAnalyzes.GOISmoothMode -> 5

number of points used for smoothing, GOI

DeltaDeltaCtAnalyzes.GOlLog -> O

logarithmic chart GOI On(-1), Off(Q)

DeltaDeltaCtAnalyzes.GOIBaseLineRange[0].Min -> 3

manually set lower boundary of the base line
(cycle number GOI)

DeltaDeltaCtAnalyzes.GOIBaselLineRange[0].Max -> 15

manually set upper boundary of the base line
(cycle number GOI)

DeltaDeltaCtAnalyzes.GOIBaselLineRange[1].Min -> 5

automatically set lower boundary of the base
line (cycle number GOI)

DeltaDeltaCtAnalyzes.GOIBaselLineRange[1].Max -> -1

calculate automatically upper boundary of the
base line range Yes (-1), No (0)

DeltaDeltaCtAnalyzes.GOlAutoBaseLine -> -1

automatic base line determination On (-1) or
Off (0)

DeltaDeltaCtAnalyzes.GORSmooth -> -1

smoothing reference gene, On(-1), Off(0)

DeltaDeltaCtAnalyzes.GORSmoothMode -> 5

number of points used for smoothing of
reference gene

DeltaDeltaCtAnalyzes.GORLog -> 0

logarithmic chart GOI On(-1), Off(0), reference
gene

DeltaDeltaCtAnalyzes.GORBaseLineRange[0].Min -> 3

manually set lower boundary of the base line
(cycle number reference gene)

162



Appendix D - Entries in the Audit Trail

DeltaDeltaCtAnalyzes.GORBaseLineRange[0].Max -> 15

manually set upper boundary of the base line
(cycle number reference gene)

DeltaDeltaCtAnalyzes.GORBaseLineRange[1].Min -> 5

automatically set lower boundary of the base
line (cycle number reference gene)

DeltaDeltaCtAnalyzes.GORBaseLineRange[1].Max -> -1

automatically set upper boundary of the base
line (cycle number reference gene)

DeltaDeltaCtAnalyzes.GORAutoBaseLine -> -1

automatic base line determination On (-1) or
Off (0), reference gene

DeltaDeltaCtAnalyzes.GOlAutoThreshold -> 0

auto threshold On(-1), Off(0), GOI

DeltaDeltaCtAnalyzes.GORAutoThreshold -> 0

auto threshold On(-1), Off(0), Referenzgen

DeltaDeltaCtAnalyzes.GOIFilter -> -1

filter On(-1), Off(0), GOI

DeltaDeltaCtAnalyzes.GOIFilterOptions -> 1

filter strength GOI, slight(0), medium(-1) or
strong(2)

DeltaDeltaCtAnalyzes.GOIFilterSmooth -> 0

smooth the filter data GOI, Yes (-1), No (0)

DeltaDeltaCtAnalyzes.GORFilter -> -1

filter On(-1), Off(Q), reference gene

DeltaDeltaCtAnalyzes.GORFilterOptions -> 1

filter strength reference gene, slight(0),
medium(1) or strong(2)

DeltaDeltaCtAnalyzes.GORFilterSmooth -> 0

smooth the filter data of reference gene, Yes (-
1), No (0)

DeltaDeltaCtAnalysis.Description -> ddCt

title of this analysis

DeltaDeltaCtAnalysis.Group -> 0

valid for group

DeltaDeltaCtAnalysis.GOl.Color -> FAM

dye of GOI

DeltaDeltaCtAnalysis.GOl.Gene ->

name of GOI

DeltaDeltaCtAnalysis.GOIThreshold -> 0,794712458619839

threshold value the Ct values of the GOl were
calculated with

DeltaDeltaCtAnalysis.GOR.Color ->

dye of reference gene

DeltaDeltaCtAnalysis.GOR.Gene ->

name of the reference gene

DeltaDeltaCtAnalysis.GORThreshold -> 50

threshold value the Ct values of the reference
gene were calculated with

DeltaDeltaCtAnalysis.EfficiencyCalc -> 0

PCR efficiency calculation according to Livak (0)
or Pfaffl (1)

DeltaDeltaCtAnalysis.EfficiencyType -> 0

if Pfaffl: calculate efficiency from standards (0)
or entered values (1)

DeltaDeltaCtAnalysis.GOIEfficiency -> 1

PCR efficiency of the GOI

DeltaDeltaCtAnalysis.GOREfficiency -> 1

PCR efficiency of the reference gene

DeltaDeltaCtAnalysis.GOIFitData.Count -> 4

number of standards, GOI

DeltaDeltaCtAnalysis.GOIFitData.M -> -3,62354563433653

slope of the standard curve, GOI

DeltaDeltaCtAnalysis.GOIFitData.N -> 27,5354442047509

intercept of the standard curve, GOI

DeltaDeltaCtAnalysis.GOIFitData.R2 ->0,999100282770293

correlation coefficient of the linear curve fit,
GOI

DeltaDeltaCtAnalysis.GORFitData.Count -> 0

number of standards, reference gene
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DeltaDeltaCtAnalysis.GORFitData.M -> 1

slope of the standard curve, reference gene

DeltaDeltaCtAnalysis.GORFitData.N -> 0

intercept of the standard curve, reference gene

DeltaDeltaCtAnalysis.GORFitData.R2 -> 0

correlation coefficient of the linear curve fit,
reference gene

DeltaDeltaCtAnalysis.ValFitData.Count -> 0

number of standards used for validation

DeltaDeltaCtAnalysis.ValFitData.M -> 1

slope of the validation curve

DeltaDeltaCtAnalysis.ValFitData.N -> 0

intercept of the validation curve

DeltaDeltaCtAnalysis.ValFitData.R2 -> 0

correlation coefficient of the linear curve fit,
validation

Melt Curve Analysis

MeltCurveAnalyzes.Smooth -> -1

smoothing GOI, On(-1), Off(0)

MeltCurveAnalyzes.SmoothMode -> 3

number of points used for smoothing

MeltCurveAnalyzes.Log -> 0

logarithmic chart On(-1), Off(0)

MeltCurveAnalyzes.BaseLineRange.Min -> 1

manually set lower boundary of the base line

MeltCurveAnalyzes.BaselLineRange.Max -> 5

manually set upper boundary of the base line

MeltCurveAnalyzes.AutoThreshold -> 0

auto threshold On(-1), Off(0), GOI

MeltCurveAnalyzes.FlipCurve -> -1

flip curve horizontally, On(-1), Off(0)

MeltCurveAnalyzes.Scaling -> 0

All curves start at 100%(0), Maximum initial
fluorescence = 100%(1)

MeltCurveAnalysis.Description -> melt

title of this analysis

MeltCurveAnalysis.Group -> 0

valid for group

MeltCurveAnalysis.GOl.Color -> FAM

dye of GOI

MeltCurveAnalysis.GOl.Gene ->

name of GOI

MeltCurveAnalysis.Threshold -> 0

threshold value above which the melt
temperatures are determined

Genotyping

GenoTypingAnalyzes.GOISmooth -> -1

smoothing GOI, On(-1), Off(0)

GenoTypingAnalyzes.GOISmoothMode -> 5

number of points used for smoothing, GOI

GenoTypingAnalyzes.GOlLog -> 0

logarithmic chart GOI On(-1), Off(Q)

GenoTypingAnalyzes.GOIBaseLineRange[0].Min -> 3

manually set lower boundary of the base line
(cycle number GOI)

GenoTypingAnalyzes.GOIBaseLineRange[0].Max -> 15

manually set upper boundary of the base line
(cycle number GOI)

GenoTypingAnalyzes.GOIBaseLineRange[1].Min -> 5

automatically set lower boundary of the base
line (cycle number GOI)

GenoTypingAnalyzes.GOIBaseLineRange[1].Max -> -1

automatically set upper boundary of the base
line (cycle number GOI)

GenoTypingAnalyzes.GOlAutoBaseLine -> -1

automatic base line determination On (-1) or
Off (0)

GenoTypingAnalyzes.GORSmooth -> -1

smoothing reference gene, On(-1), Off(0)
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GenoTypingAnalyzes.GORSmoothMode -> 5

number of points used for smoothing of
reference gene

GenoTypingAnalyzes.GORLog -> 0

logarithmic chart GOI On(-1), Off(0), reference
gene

GenoTypingAnalyzes.GORBaseLineRange[0].Min -> 3

manually set lower boundary of the base line
(cycle number reference gene)

GenoTypingAnalyzes.GORBaselLineRange[0].Max -> 15

manually set upper boundary of the base line
(cycle number reference gene)

GenoTypingAnalyzes.GORBaseLineRange[1].Min -> 5

automatically set lower boundary of the base
line (cycle number reference gene)

GenoTypingAnalyzes.GORBaselLineRange[1].Max -> -1

calculate automatically upper boundary of the
base line range Yes (-1), No (0)

GenoTypingAnalyzes.GORAutoBaselLine -> -1

automatic base line determination On (-1) or
Off (0), reference gene

GenoTypingAnalyzes.GOIAutoThreshold -> 0

auto threshold On(-1), Off(0), GOI

GenoTypingAnalyzes.GORAutoThreshold -> 0

auto threshold On(-1), Off(0), Referenzgen

GenoTypingAnalyzes.GOIFilter -> -1

filter On(-1), Off(0), GOI

GenoTypingAnalyzes.GOIFilterOptions -> 1

filter strength GOI, slight(0), medium(1) or
strong(2)

GenoTypingAnalyzes.GOIFilterSmooth -> 0

smooth the filter data GOI, Yes (-1), No (0)

GenoTypingAnalyzes.GORFilter -> -1

filter On(-1), Off(0), reference gene

GenoTypingAnalyzes.GORFilterOptions -> 1

filter strength reference gene, slight(0),
medium(1) or strong(2)

GenoTypingAnalyzes.GORFilterSmooth -> 0

smooth the filter data of reference gene, Yes (-
1), No (0)

GenoTypingAnalyzes.SPType -> 1

genotyping based on Ct (1) or dRn (0)

GenoTypingAnalyzes.EPLast -> -1

end point is the last cycle (1) or enter cycle
manually

GenoTypingAnalyzes.EPCycle -> -1

manually entered end point cycle

GenoTypingAnalyzes.InfoText -> wild type text 1
GenoTypingAnalyzes.InfoText -> mutant text 2
GenoTypingAnalyzes.InfoText -> heterozygote text 3
GenoTypingAnalyzes.InfoText -> error text 4

GenoTypingAnalysis.Description -> Geno

title of this analysis

GenoTypingAnalysis.Group -> 0

valid for group

GenoTypingAnalysis.REF -> 0

passive reference used? Yes (-1), No (0)

GenoTypingAnalysis.GOl.Color -> FAM

dye of GOI

GenoTypingAnalysis.GOl.Gene ->

name of GOI

GenoTypingAnalysis.GOIThreshold -> 0,794712458619839

threshold value the Ct values of the GOl were
calculated with

GenoTypingAnalysis.GOR.Color ->

dye of reference gene
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GenoTypingAnalysis.GOR.Gene ->

name of the reference gene

GenoTypingAnalysis.GORThreshold -> 50

threshold value the Ct values of the reference
gene were calculated with

GenoTypingAnalysis.SPCutOff0 -> 0

cut off value 1, Ct

GenoTypingAnalysis.SPCutOffl -> 0,794712458619839

cut off value 2, Ct

GenoTypingAnalysis.EPCutOff0 -> 49

cut off value 1, Cycle

GenoTypingAnalysis.EPCutOffl -> 51

cut off value 2, cycle

End Point Analysis

EndPointAnalyzes.Smooth -> -1

smoothing GOI, On(-1), Off(0)

EndPointAnalyzes.SmoothMode -> 5

number of points used for smoothing, GOI

EndPointAnalyzes.Log -> 0

logarithmic chart GOI On(-1), Off(0)

EndPointAnalyzes.BaseLineRange[0].Min -> 3

manually set lower boundary of the base line
(cycle number GOI)

EndPointAnalyzes.BaseLineRange[0].Max -> 15

manually set upper boundary of the base line
(cycle number GOI)

EndPointAnalyzes.BaseLineRange[1].Min -> 5

automatically set lower boundary of the base
line (cycle number GOI)

EndPointAnalyzes.BaselLineRange[1].Max -> 25

automatically set upper boundary of the base
line (cycle number GOI)

EndPointAnalyzes.AutoBaseLine -> -1

automatic base line determination On (-1) or
Off (0)

EndPointAnalysis.Description -> Endp

title of this analysis

EndPointAnalysis.Group -> 0

valid for group

EndPointAnalysis.GOl.Color -> FAM

dye of GOI

EndPointAnalysis.GOl.Gene ->

name of GOI

EndPointAnalysis.GOICutOff -> 2040,83542831301

cut off value of GOI

EndPointAnalysis.IPC.Color ->

Dye of the internal positive control (IPC)

EndPointAnalysis.IPC.Gene ->

gene name of the internal positive control

EndPointAnalysis.IPCCutOff -> 0

cut off value of the internal positive control

EndPointAnalysis.OptionCycles -> -1

end point analysis based on end point
intensities, Yes (-1), No (0)

EndPointAnalysis.OptionLastCycles -> 2

number of last cycles used for calculation

EndPointAnalysis.OptionFromCycle -> 38

start cycle end point range

EndPointAnalysis.OptionToCycle -> 40

end cycle end point range

EndPointAnalysis.OptionCutOff -> -1

end point analysis based on NTC intensities, Yes
(-1), No (0)

EndPointAnalysis.OptionCutOffNTC -> 10

factor applied to the NTC intensities for
threshold calculation

EndPointAnalysis.OptionCutOffNTC_IPC -> 2

confidence intervals: (0)95%, (1)99%,
(2)99.5%, (3)99.7%, (4)99.9%
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EndPointAnalysis.OptionCutOffinput -> 0 use cut off values from table Yes(-1), No (0)
MIQE.Typelnfo -> 1 MIQE documentation for DNA(Q) or RNA(1)
LOCK->0 template or project locked? Yes (-1), No (0)
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detected

Following color modules are available:

Description / order number

Color module 1, order number: 844-00520-0
Color module 2, order number: 844-00521-0
Color module 3, order number: 844-00522-0
Color module 4, order number: 844-00523-0
Color module 5, order number: 844-00524-0
Color module 6, order number: 844-00525-0
FRET module 1, order number: 844-00526-0
FRET module 2, order number: 844-00527-0
FRET module 3, order number: 844-00528-0
FRET module 4, order number: 844-00529-0
FRET module 5, order number: 844-00531-0

Color module Protein 1, order number: 844-00530-0

Dyes (examples)

FAM, SYBR Green, Alexa488
JOE, HEX, VIC, YakimaYellow
TAMRA, DFO, Alexa546, NED
ROX, TexasRed, Cy3.5

Cy5, Alexa633, Quasar670
Cy5.5, LightCycler Red

FAM (Donor) / TAMRA (Akzeptor)
FAM (Donor) / Cy5 (Akzeptor)
FAM (Donor) / Cy5.5 (Akzeptor)
JOE (Donor) / Cy5 (Akzeptor)
FAM (Donor) / ROX (Akzeptor)
SYPRO Orange
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